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Ενότητα 1 – Βασικά βήματα κατά την έναρξη των 

εργασιών μας στο ArcGIS Pro 
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1.1 Λίγα λόγια για το ArcGIS Pro 

Τα Γεωγραφικά Συστήματα Πληροφοριών - ΓΣΠ (Geographic Information Systems 

– GIS) είναι λογισμικά που αξιοποιούν τις βασικές δυνατότητες των υπολογιστών για 

τη διαχείριση, την ανάλυση, την αποθήκευση και την παρουσίαση δεδομένων που 

συνδέονται άμεσα ή έμμεσα με τη γεωγραφική πληροφορία. Το ArcGIS Pro παρέχεται 

από την εταιρία Esri και είναι η νεότερη εξέλιξη των GIS λογισμικών τύπου ArcGIS. 

Χρησιμοποιώντας το ArcGIS Pro, μπορείτε να εξερευνήσετε, να οπτικοποιήσετε και 

να αναλύσετε δεδομένα προκειμένου να δημιουργήσετε τις σωστές βάσεις στη λήψη 

αποφάσεων. Επιπλέον, μπορείτε να δημιουργήστε 2D χάρτες αλλά και χάρτες/σκηνές 

3D. Επιπλέον, σας δίδεται η δυνατότητα να μοιραστείτε την εργασία σας στο ArcGIS 

Online. 

Αυτός ο οδηγός εργαστηρίου δημιουργήθηκε με σκοπό να βοηθήσει τους φοιτητές 

μας να εξοικειωθούν και να εξασκηθούν και μόνοι τους ακόμη στο ArcGIS Pro. Ο 

οδηγός αυτός προσφέρεται σε συνδυασμό με τα δεδομένα GIS που συζητούνται στις 

ακόλουθες ενότητες. 
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1.2 Ενεργοποίηση Λογισμικού 

Το λογισμικό κατά την αρχική του ενεργοποίηση θα σας ζητήσει να ορίσετε το 

username και τον κωδικό (password) σας (Εικ. 1.1). 

 

Εικ. 1.1: Για τη σύνδεσή μας στο ArcGIS Pro θα χρειαστεί να εισάγουμε το προσωπικό μας username και τον κωδικό 
(password).  

 

Κατά την ενεργοποίηση του λογισμικού, μπορείτε να επιλέξετε το πρότυπο που 

χρησιμοποιήσετε για το νέο σας Project. Οι πιθανές επιλογές είναι (Εικ. 1.2): Map για 

τη δημιουργία δισδιάστατου Project, Global Scene για τη δημιουργία τρισδιάστατου 

Project σε παγκόσμια κλίμακα, Local Scene για τη δημιουργία τρισδιάστατου Project 

σε τοπική κλίμακα, Catalog για την εκκίνηση Project και αυτόματη ενεργοποίηση του 

εργαλείου Catalog View και Start without a template για τη δημιουργία Project χωρίς 

πρότυπο. Κάθε ένα από τα παραπάνω πρότυπα Project δίνει διαφορετικές δυνατότητες 

στο χρήστη. 
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Εικ. 1.2: Η οθόνη που εμφανίζεται κατά την ενεργοποίηση του λογισμικού. Αν δεν έχουμε ακόμη συνδεθεί με τους 
προσωπικούς μας κωδικούς, είναι η σωστή στιγμή για να γίνει αυτό. Στο συγκεκριμένο παράδειγμα δεν έχουμε συνδεθεί 
ακόμη (Not signed in -πάνω δεξιά παράθυρο). Πατήστε στο Link που δίνεται και θα ενεργοποιηθεί το παράθυρο της 
εικόνας 1.1. 

 

Για τις ανάγκες της άσκησης, στο New Project θα επιλέξουμε το Map και θα 

αναδυθεί το παράθυρο Create a New Project. Project είναι στην ουσία το σύνολο των 

αρχείων που θα δημιουργηθούν για την κάθε εργασία. Εδώ θα πρέπει να καθορίσετε το 

όνομα (Name) και τη θέση (Location) στην οποία θα αποθηκευτεί η νέα εργασία που 

θα κάνετε στο ArcGIS Pro (Εικ. 1.3). Στα πλαίσια της εκπαίδευσής σας, σας 

προτείνουμε να δώσετε ένα μοναδικό αναγνωριστικό όνομα, όπως για παράδειγμα το 

Lab_1_Επώνυμο, και να το αποθηκεύσετε στο φάκελο που δημιουργήσατε κατά τον 

ορισμό του νέου Project. Βάλτε ✓ στην εντολή Create a new folder for this project και 

πατήστε ΟΚ για να δημιουργηθεί ένας φάκελος στον ηλεκτρονικό υπολογιστή που θα 

περιέχει το Project. Τα αρχεία Project έχουν επέκταση .aprx. Καθώς δημιουργείται το 

Project, με βάση τις προδιαγραφές που καθορίσατε στα προηγούμενα βήματα, 

μεταφέρεστε στον κύριο χώρο εργασίας του λογισμικού ArcGIS Pro (Εικ. 1.4). 
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Εικ. 1.3: Για να δημιουργηθεί το Project, θα πρέπει να καθορίσετε το όνομά του (file name) και το path του φακέλου 
στον οποίον θα αποθηκευτεί. Πατήστε το εικονίδιο του φακέλου (δεξιά από το πλαίσιο Location) ώστε να επιλέξετε το 
path.  

 

Σημειώστε ότι τα projects είναι αρχεία τύπου .aprx και η αποθήκευσή τους γίνεται 

αυτόματα κατά τη δημιουργία τους. Να έχετε υπόψη σας ότι ένα project το οποίο 

δημιουργήθηκε σε προηγούμενη έκδοση του ArcGIS Pro μπορεί να ενεργοποιηθεί σε 

μεταγενέστερη, αλλά όχι σε παλαιότερη.  

 

 

Εικ. 1.4: Κύριος χώρος εργασίας του ArcGIS Pro, ο οποίος εμφανίζεται αμέσως μετά τη δημιουργία του Project. 
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1.3 Χώρος εργασίας του ArcGIS Pro 

Ο βασικός χώρος εργασίας του λογισμικού ArcGIS Pro χωρίζεται σε πέντε κυρίως 

τμήματα, το μενού (Α), το παράθυρο του χάρτη (Β), το διαχειριστή επιπέδων 

πληροφορίας (Γ), το χώρο εύρεσης και διαχείρισης δεδομένων (Δ) και τη γραμμή 

εργαλείων γρήγορης πρόσβασης (Quick Access toolbar) (Εικ. 1.4). 

 

 

Εικ. 1.4: Ο χώρος εργασίας του ArcGIS Pro, που αποτελείται από 5 τμήματα: (Α) μενού, (Β) παράθυρο χάρτη, (Γ) 
διαχειριστής επιπέδων πληροφορίας, (Δ), χώρος εύρεσης και διαχείρισης δεδομένων και (Ε) γραμμή εργαλείων 

γρήγορης πρόσβασης. 

 

1.3.1 Μενού 

Το μενού βρίσκεται στο επάνω μέρος του λογισμικού και χωρίζεται σε μια σειρά 

από καρτέλες, οι οποίες εμπεριέχουν εργαλεία οργανωμένα σε ομάδες. Παρακάτω 

γίνεται αναφορά στις κυριότερες καρτέλες, τις οποίες θα προσεγγίσουμε κατά τη 

διάρκεια των εργαστηριακών ασκήσεων.  

▪ Καρτέλα Map: Αποτελείται από τις ομάδες εργαλείων Clipboard, Navigate, 

Layer, Selection, Inquiry, Labeling και Offline. 

▪ Καρτέλα Insert: Αποτελείται από τις ομάδες εργαλείων Project, Layer 

Templates, Link Analysis, Measurements, Styles και Favorites. 

▪ Καρτέλα Analysis: Αποτελείται από τις ομάδες εργαλείων Geoprocessing, 

Tools, Portal, Workflows και Raster. 
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▪ Καρτέλα View: Αποτελείται από τις ομάδες εργαλείων View, Link, Windows, 

Thumbnail, Accessibility, Animation, Device Location, Scene, View Clipping 

και Navigation. 

▪ Καρτέλα Edit: Αποτελείται από τις ομάδες εργαλείων Clipboard, Manage 

Edits, Snapping, Features, Selection, Tools, Elevation, Corrections και Data 

Reviewer. 

▪ Καρτέλα Imagery: Αποτελείται από τις ομάδες εργαλείων Ortho Mapping, 

Alignment, Analysis, Image Classification, Mensuration, Tools, Share και 

Motion Imagery.  

▪ Καρτέλα Share: Αποτελείται από τις ομάδες εργαλείων Package, Share As, 

Status, Manage, Save As και Output. 

 

1.3.2 Παράθυρο του χάρτη (Map) 

Το παράθυρο του χάρτη αποτελεί τον κύριο χώρο διαχείρισης, ανάλυσης και 

επεξεργασίας της γεωγραφικής και περιγραφικής πληροφορίας. Στο κάτω τμήμα του 

παραθύρου του χάρτη θα δείτε συντεταγμένες, οι οποίες τροποποιούνται καθώς 

μετακινείτε το δείκτη του ποντικιού. 

 

1.3.3 Διαχειριστής επιπέδων πληροφορίας (Contents) 

Ο διαχειριστής επιπέδων πληροφορίας (Contents) είναι κομβικός χώρος μέσα από 

τον οποίον μπορείτε να διαχειριστείτε τα επίπεδα πληροφορίας καθορίζοντας τη θέση 

τους, π.χ. ποιο θα είναι πάνω από το άλλο, ποιο θα είναι ορατό, τον τρόπο με τον οποίον 

θα φαίνεται κ.ά. Ο χώρος διαχείρισης των επιπέδων πληροφορίας μπορεί να 

τοποθετηθεί σε όποια θέση σάς εξυπηρετεί καλύτερα, αλλά προτείνεται για τις ανάγκες 

της άσκησης να τον τοποθετήσετε αριστερά, όπως φαίνεται στην Εικ. 1.5.  
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Εικ. 1.5: Ο διαχειριστής επιπέδων πληροφορίας (Contents) αποτελείται από πολλές επιλογές, ανάλογα με τη διαχείριση 
των δεδομένων σας. Μερικές από αυτές είναι οι List By Drawing Order (Α), List By Selection (Β) και List By Labeling 

(Γ). 

 

Στο πάνω μέρος του χώρου διαχείρισης επιπέδων πληροφορίας, θα βρείτε διάφορες 

επιλογές, με σημαντικότερη την ταξινόμηση κατά σειρά σχεδίασης (List By Drawing 

Order) . Αυτή αποτελεί την προεπιλεγμένη από το λογισμικό ταξινόμηση 

παρουσίασης των επιπέδων πληροφορίας (Εικ. 1.5 - A) και αυτή που θα 

χρησιμοποιήσουμε κατά τη διάρκεια των εργαστηριακών ασκήσεων. Σε αυτόν τον 

τύπο ταξινόμησης φαίνεται η σειρά των επιπέδων πληροφορίας και έχετε τη 

δυνατότητα να μετακινήσετε το ένα πάνω από το άλλο. Επίσης, φαίνεται το είδος του 

επιπέδου πληροφορίας, π.χ. αν είναι γραμμικό, πολυγωνικό ή σημειακό, και δίνεται 

εύκολα η δυνατότητα τροποποίησης του τρόπου παρουσίασής του στο χάρτη. 

Μπορείτε να καθορίσετε αν κάποιο επίπεδο πληροφορίας δε θα είναι ορατό, χωρίς 

απαραίτητα να το απενεργοποιήσετε από το Project.  
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Ενεργοποιήστε τα δεδομένα της Ενότητας 1 και δοκιμάστε να αλλάξετε τη σειρά 

των επιπέδων πληροφορίας. Παρατηρήστε τι θα συμβεί. Δοκιμάστε να τροποποιήσετε 

τον τρόπο με τον οποίον εμφανίζονται τα δεδομένα του εκάστοτε επιπέδου 

πληροφορίας στο χάρτη. Παίξτε με τα χρώματα και τα σχέδια. Δοκιμάστε να κάνετε 

κάποιο επίπεδο μη ορατό. Παρατηρήστε τι θα συμβεί στο χάρτη. 

 

  

Εικ. 1.6: Είναι ορατό το σύνολο των ενεργοποιημένων επιπέδων πληροφορίας, δηλαδή το επίπεδο πληροφορίας της 
λιθολογίας (Lithology), του υδρογραφικού δικτύου (Drainage) και των ισοϋψών των 50 m (Contous_50). Ωστόσο, ο 
τρόπος εμφάνισής τους δε βοηθά την κατανόηση των γεωγραφικών δεδομένων. Σε παρακάτω ενότητα θα συζητηθεί η 
διαχείριση και ανάλυση των χωρικών δεδομένων για τη βέλτιστη οπτική παρουσίασή τους. 

 

 

Εικ. 1.7: Παρατηρήστε το επίπεδο πληροφορίας «Drainage», που αφορά στο υδρογραφικό δίκτυο, στο διαχειριστή 
επιπέδων πληροφορίας (Contents). Ορίστηκε ως μη ορατό με αποτέλεσμα να μη φαίνεται στο χάρτη, παρ’ όλο που δεν 
έχει απενεργοποιηθεί από το Project. 
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Εικ. 1.8: Πατώντας πάνω στο σύμβολο απεικόνισης ενός επιπέδου πληροφορίας μπορείτε να αλλάξετε τον τρόπο 
παρουσίασής του στο χάρτη. Παρατηρήστε ότι επιλέγοντας το σύμβολο του επιπέδου πληροφορίας «Drainage», 
ενεργοποιήθηκε η καρτέλα Symbology, από όπου μπορείτε να επιλέξετε το είδος και χρώμα της γραμμής που θα 
αναπαριστά το υδρογραφικό δίκτυο στο χάρτη. Το ίδιο το λογισμικό σάς δίνει κάποιες επιλογές, αλλά μπορείτε να 
τροποποιήσετε το σύμβολο ανάλογα με το σκοπό της εργασίας σας. 

 

 

Εικ. 1.9: Αλλάξτε τη σειρά των επιπέδων πληροφορίας μέσω του διαχειριστή επιπέδων πληροφορίας (Contents). 

Τοποθετήστε το επίπεδο πληροφορίας Lithology (πολυγωνικό) πάνω από τα υπόλοιπα επίπεδα πληροφορίας 
(γραμμικά). Παρατηρήστε ότι οι ισοϋψείς καμπύλες και το υδρογραφικό δίκτυο δεν είναι πλέον ορατά, καθώς 
«κρύβονται» από τη λιθολογία.  
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1.3.4 Πρόσβαση στα αρχεία μου  

Δεδομένου ότι το path που πρέπει να ακολουθήσετε στον υπολογιστή σας για να 

αποκτήσετε πρόσβαση στα αρχεία σας μπορεί να είναι μεγάλο, καλό θα ήταν πριν 

ξεκινήσετε την όποια διαδικασία στο GIS να συνδέσετε το φάκελο με τα δεδομένα σας 

στο Project σας. Για να γίνει αυτό, μεταβείτε στην ομάδα εργαλείων Project και 

συγκεκριμένα στο μενού Insert και χρησιμοποιήστε το εργαλείο Add Folder  

(Εικ. 1.10).  

 

 
Εικ. 1.10: Για την εύκολη πρόσβαση στο φάκελο των δεδομένων μας, χωρίς να ακολουθούμε κάθε φορά το path, 

μπορούμε να συνδέσουμε το φάκελο με το Project μέσω του εργαλείου Add Folder (Project → Insert → Add Folder). 

 

Με την επιλογή του εργαλείου Add Folder, θα ενεργοποιηθεί το παράθυρο Add 

Folder Connection (Εικ. 1.11), μέσω του οποίου μπορείτε να αναζητήσετε το φάκελο 

με τα δεδομένα σας. 
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Εικ. 1.11: Το αναδυόμενο παράθυρο Add Folder Connection, από όπου μπορείτε να επιλέξετε το φάκελο που θα 
διασυνδεθεί με το Project σας.  

 

1.3.4.1. Πιθανά προβλήματα και αιτίες 

▪ Το κόκκινο θαυμαστικό ! 

Το κόκκινο θαυμαστικό δίπλα σε ένα επίπεδο πληροφορίας δείχνει ότι ο φάκελος 

που το περιέχει δεν είναι πλέον συνδεδεμένο με το Project.  

Ένας φάκελος μπορεί να μην είναι προσβάσιμος μέσω του Project γιατί μπορεί να 

τον μετακινήσατε σε διαφορετική θέση ή να αλλάξατε το όνομά του. Ο φάκελος θα 

είναι ξανά διαθέσιμος στο Project όταν αποκαταστήσετε τη διασύνδεσή του (βλ. 

υποκεφάλαιο 1.3.4).  

Μια σύνδεση μπορεί να διακοπεί προσωρινά λόγω προβλημάτων του τοπικού 

δίσκου ή του δικτύου σύνδεσης. Σε αυτήν την περίπτωση, η επαναφορά της πρόσβασης 

στο φάκελο απαιτεί απλά ανανέωση του περιεχομένου του, μέσω της εντολής Refresh 

(δεξί κλικ πάνω στο φάκελο και επιλογή της εντολής Refresh). Σε διαφορετικές 

εκδόσεις Windows, η εντολή βρίσκεται στο δεξί μέρος της γραμμής διαχείρισης 

φακέλων στο πάνω μέρος.  
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1.3.5 Διαχείριση των αρχείων μου 

Τώρα τα αρχεία σας είναι εύκολα και γρήγορα προσβάσιμα μέσω του Catalog. Αλλά 

τι είναι ο Catalog; Και πώς ενεργοποιείται; 

Ας ξεκινήσουμε από το πώς μπορούμε να ενεργοποιήσουμε το εργαλείο αυτό. 

Πηγαίνετε στο μενού View και συγκεκριμένα στην ομάδα εργαλείων Windows (Εικ. 

1.12). Θα βρείτε τα εργαλεία Catalog Pane  ή Catalog View  . Τα παράθυρα 

των δύο εργαλείων μπορούν να ενεργοποιηθούν ταυτόχρονα, ωστόσο λειτουργούν 

ανεξάρτητα. 

 

 

Εικ. 1.122: Μέσα από το μενού View και συγκεκριμένα την ομάδα εργαλείων Windows μπορείτε να βρείτε τα εργαλεία 

Catalog Pane και Catalog View, μέσα από τα οποία θα ενεργοποιήσετε τον Catalog. Μπορείτε να χρησιμοποιήσετε 
όποιο από τα δύο σας εξυπηρετεί καλύτερα, ή να τα χρησιμοποιήσετε ταυτόχρονα, καθώς λειτουργούν ανεξάρτητα. 

 

Το παράθυρο του Catalog μπορεί να τοποθετηθεί σε όποια θέση σάς εξυπηρετεί, 

αλλά για τις ανάγκες της άσκησης, καλό θα ήταν να το τοποθετήσετε στο δεξί μέρος 

της οθόνης. Μέσω του Catalog λαμβάνουν χώρα όλες οι εργασίες διαχείρισης, όπως 

μετονομασία αρχείου, αντιγραφή, επικόλληση, διαγραφή, δημιουργία νέου αρχείου 

κ.ά.  

Στον Catalog, κυρίως θα μάθουμε να εργαζόμαστε στην καρτέλα Project, που 

παρέχει πρόσβαση στη συλλογή δεδομένων που έχει συνδεθεί στη χαρτοσύνθεση. 

Επιλέγοντας το εργαλείο Catalog View θα έχετε πρόσβαση στο σύνολο των 

δεδομένων και των πληροφοριών που συνοδεύουν τα δεδομένα αυτά (π.χ. όνομα, 

τύπος, ημερομηνία τροποποίησης, κάτοχος αρχείου, μεταδεδομένα). Συγκεκριμένα, 

επιλέγοντας το εργαλείο Catalog View, μπορείτε να πλοηγηθείτε μέσα από τις καρτέλες 

Metadata (όπου εμφανίζονται τα μεταδεδομένα του επιλεγμένου επιπέδου 

πληροφορίας) (Εικ. 1.13), Geography (προεπισκόπηση της γεωγραφικής πληροφορίας 

του επιλεγμένου επιπέδου πληροφορίας) (Εικ. 1.13) και Table (προεπισκόπηση του 

πίνακα περιγραφικών χαρακτηριστικών του επιλεγμένου επιπέδου πληροφορίας) (Εικ. 

1.13). 
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Εικ. 1.13: Μέσω του Catalog Pane, μπορείτε να πλοηγηθείτε και να ενεργοποιήσετε την προεπισκόπηση των 
μεταδεδομένων, της γεωγραφικής πληροφορίας και του πίνακα περιγραφικών χαρακτηριστικών ενός επιπέδου 
πληροφορίας. 

 

1.3.5.1. Μεταδεδομένα 

Αναφερθήκαμε προηγουμένως στα μεταδεδομένα (metadata). Αλλά τι είναι αυτά; 

Είναι η πληροφορία πίσω από την πληροφορία. Δηλαδή είναι η δομημένη πληροφορία 

που περιγράφει τις πληροφορίες που αφορούν στα δεδομένα των επιπέδων 

πληροφορίας. Τα μεταδεδομένα είναι πολύ σημαντικά, γιατί ενημερώνουν το χρήστη 

με πληροφορίες που δεν προκύπτουν από τα δεδομένα αυτά καθ’ αυτά.  

Τα μεταδεδομένα ορίζονται ως «δεδομένα για τα δεδομένα» ή «δεδομένα τα οποία 

περιγράφουν άλλα δεδομένα». Ωστόσο, δεν είναι αυτοτελή ή ενδιαφέροντα από μόνα 

τους καθώς αναφέρονται σε άλλα δεδομένα. Τα μεταδεδομένα μπορεί να αναφέρουν 

την ημερομηνία δημιουργίας των δεδομένων στα οποία αναφέρονται, το δημιουργό 

τους, τη μέθοδο συλλογής τους, την ακρίβειά τους κ.ά. Μια εργασία σε GIS μπορεί να 

περιλαμβάνει πολλά στάδια ανάλυσης και να καταλήγει σε ένα συμπέρασμα, σε ένα 

αποτέλεσμα στο οποίο θα βασιστεί η λήψη αποφάσεων. Είναι σαφές ότι όλα αυτά 

βασίζονται στα αρχικά δεδομένα που αναλύθηκαν προκειμένου να φτάσουμε στο 

τελευταίο στάδιο. Αν τα αρχικά δεδομένα δεν είναι έγκυρα, τότε όλη η υπόλοιπη 

ανάλυση και έρευνα δεν έχει κανένα απολύτως νόημα. Καταλαβαίνετε λοιπόν την αξία 

των μεταδεδομένων, καθώς σε αυτά βασίζεται η εγκυρότητα των αποτελεσμάτων της 

όποιας διαδικασίας κάνουμε στο GIS.  
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1.3.6 Γιατί να διαχειρίζομαι τα δεδομένα μου μέσα από τον Catalog; 

Στα περισσότερα λογισμικά, διαχειριζόμαστε τα αρχεία μας μέσα από τον Explorer 

των Windows. Δοκιμάστε να ανοίξετε το φάκελο που δημιουργήσατε για το νέο project 

σας. Παρατηρήστε ότι υπάρχουν πολλά αρχεία στο φάκελο αυτό, τα οποία δεν 

δημιουργήσατε εσείς. Ποιος τα δημιούργησε και πότε; Μα το ίδιο το λογισμικό, όταν 

δημιουργήσατε το νέο Project.  

Στο φάκελο αυτό, εκτός από το αρχείο του Project (.aprx), δημιουργήθηκαν 

αυτόματα από το λογισμικό υποφάκελοι που περιέχουν διάφορα αρχεία. Αυτά αφορούν 

σε μία προεπιλεγμένη βάση δεδομένων (default geodatabase - .gdb), σε μία 

προεπιλεγμένη εργαλειοθήκη (default toolbox - .tbx), σε ένα ευρετήριο (index) και σε 

ένα αρχείο καταγραφής (import log) (Εικ. 1.14). 

 

 

Εικ. 1.19: Παράδειγμα αρχείων που δημιουργήθηκαν αυτόματα στο φάκελο του project, όταν το δημιουργήσατε. 

 

Παρατηρήστε τώρα ότι για κάθε επίπεδο πληροφορίας (π.χ. lithology) υπάρχουν 

παραπάνω από ένα αρχεία. Τι είναι όλα αυτά τα αρχεία; Τα χρειαζόμαστε όλα; Κάθε 

ένα από τα αρχεία αυτά είναι απαραίτητο για να λειτουργήσει το επίπεδο πληροφορίας. 

Συνολικά υπάρχουν 8 αρχεία (συνήθως) για κάθε διανυσματικό επίπεδο πληροφορίας, 

τα οποία είναι απαραίτητα για τη λειτουργία του αρχείου εντός του GIS. Συχνά, όταν 

θέλουμε να μοιραστούμε με άλλους τα δεδομένα μας, κάνουμε το λάθος να τα 

επιλέξουμε από το φάκελο αυτό. Στατιστικά, πάντα ξεχνάμε κάποιο από όλα τα αρχεία, 

με αποτέλεσμα το επίπεδο πληροφορίας να μην είναι δυνατόν να ενεργοποιηθεί. Για το 

λόγο αυτό, ο καλύτερος τρόπος είναι να διαχειριζόμαστε τα αρχεία μας, 

συμπεριλαμβανομένης και της αποστολής τους σε τρίτο, μέσω του Catalog. Στον 

Catalog βλέπουμε το επίπεδο πληροφορίας ως μια και μοναδική αναγραφή και κάθε 
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κίνηση/εντολή που δίνουμε συμπεριλαμβάνει και συμπαρασύρει αυτόματα το σύνολο 

των αρχείων που απαιτούνται για την ορθή λειτουργία του επιπέδου πληροφορίας. 

Έτσι, δεν υπάρχει κίνδυνος να ξεχάσουμε κάποιο από τα συνοδευτικά αρχεία. 

Στην προεπιλεγμένη βάση δεδομένων (Database) (.gdb) βρίσκονται όλες οι 

εργασίες μας, τα γραφικά και τα επίπεδα πληροφορίας που εισάγουμε ή εξάγουμε στο 

Project που εργαζόμαστε. Η προεπιλεγμένη βάση δεδομένων έχει το ίδιο όνομα με το 

Prοject.  

 

1.4 Πώς διαμοιράζομαι τα αρχεία ενός project; 

Υπάρχουν πολλοί τρόποι για να μοιραστούμε τα αρχεία μας με τρίτους, ωστόσο 

ένας είναι ο προτεινόμενος, καθώς είναι ο πιο αποδοτικός και οργανωμένος. 

Προτείνεται η δημιουργία ενός πακέτου δεδομένων που συγκεντρώνει το σύνολο των 

αρχείων του project (project package - .ppkx. Το πακέτο αυτό είναι ουσιαστικά ένα 

αρχείο που εμπεριέχει όλους τους χάρτες, τα γραφικά και τα δεδομένα που 

αναφέρονται εντός της χαρτοσύνθεσης, από τα επίπεδα πληροφορίας, τις συνδέσεις 

φακέλων, τις εργαλειοθήκες και το ιστορικό επεξεργασίας έως και συνημμένα αρχεία 

εντός της χαρτοσύνθεσης. Η δημιουργία του αρχείου .ppkx είναι πολύ απλή και 

περιγράφεται στα ακόλουθα βήματα: 

 

▪ Βήμα 1: Αποθήκευση του Project 

Πριν από την έναρξη δημιουργίας του πακέτου της χαρτοσύνθεσης, είναι 

απαραίτητη η αποθήκευση των τελευταίων ενεργειών που έλαβαν χώρα στο λογισμικό. 

Η αποθήκευση επιτυγχάνεται επιλέγοντας το εικονίδιο Save  πάνω αριστερά στη 

γραμμή εργαλείων γρήγορης πρόσβασης (Εικ. 1.4 -Ε) ή πατώντας από το πληκτρολόγιο 

το Ctrl+S. 

▪ Βήμα 2: Μετάβαση στο μενού Share: 

Αφού έχει γίνει αποθήκευση της χαρτοσύνθεσης, μεταβείτε στο μενού Share. 
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▪ Βήμα 3: Επιλογή του εργαλείου Project 

Από το μενού Share και συγκεκριμένα από την ομάδα εργαλείων Package, επιλέξτε 

το εργαλείο Project . 

▪ Βήμα 4: Παράθυρο διαλόγου Package Project  

Με την επιλογή του εργαλείου Project ενεργοποιείται το παράθυρο διαλόγου 

Package Project. Στην καρτέλα Package και συγκεκριμένα στην ενότητα Start 

Packing, επιλέξτε την εντολή Save package to file. Στη συνέχεια, δώστε το όνομα του 

αρχείου (Name) και ορίστε το φάκελο που θα αποθηκευτεί το Project. Μετά το πεδίο 

των ετικετών υπάρχουν σαν επιλογή οι ενέργειες: (1) Share outside of organization, (2) 

Include Toolboxes και (3) Include History Items. Στα πλαίσια της εκπαίδευσής σας, μην 

επιλέξετε τα Include Toolboxes και Include History Items. Μεταβαίνοντας στην 

ενότητα Finish Packing, επιλέξτε την εντολή Analyze , ώστε να βεβαιωθείτε ότι η 

δημιουργία του πακέτου θα πραγματοποιηθεί με ορθό τρόπο. Εμφανίζεται το μήνυμα 

No errors or warnings found. Αφού έχετε βεβαιωθεί ότι όλα βαίνουν καλώς, επιλέγετε 

την εντολή Package , ώστε να δημιουργηθεί το πακέτο του Project 

σας. Τέλος, στο αναδυόμενο παράθυρο Save Project επιλέγεται η εντολή Yes ώστε να 

δημιουργηθεί το πακέτο του Project σας. 
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Ενότητα 2 – Βασικές επιλογές διαχείρισης γεωγραφικών 

δεδομένων   
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2.1 Εξερευνήστε τη γεωγραφική πληροφορία 

Μπορείτε να μετακινηθείτε, να μεγεθύνετε, να σμικρύνετε το χάρτη σας ή να 

μεταβείτε σε κάποια συγκεκριμένη θέση σε αυτόν μέσω των εργαλείων της ομάδας 

Navigate που θα βρείτε στο μενού Map (Εικ. 2.1). Παρακάτω αναφέρονται τα 

κυριότερα εργαλεία της ομάδας αυτής: 

 

 

Εικ. 2.1: Εντός του κόκκινου πλαισίου μπορείτε να δείτε τα κυριότερα εργαλεία της ομάδας Navigate του μενού Map, 

που μπορείτε να χρησιμοποιήσετε κατά την εξερεύνηση του χάρτη σας. Μπορείτε για παράδειγμα να τον μεγεθύνετε, 
να τον σμικρύνετε ή να μεταβείτε σε συγκεκριμένη θέση. 

 

2.1.1 Εργαλείο εξερεύνησης (Explore)  

Χρησιμοποιήστε το εργαλείο εξερεύνησης  (Εικ. 2.1) για την ελεύθερη 

μετακίνηση του χάρτη. Έτσι, σας δίνεται η ελευθερία να κινηθείτε με το ποντίκι σας 

(pan) και αναλόγως το ποντίκι, σας δίνεται η δυνατότητα για zoom in και zoom out με 

τη χρήση της ροδέλας. Το εργαλείο του Explore μπορεί να ενεργοποιηθεί και μέσω των 

γρήγορης πρόσβασης εργαλείων (quick access tools). 

 

2.1.2 Zoom To Selection  

Το εργαλείο Zoom To Selection  ενεργοποιείται μόνο αν έχετε 

προηγουμένως επιλέξει κάποια γεωγραφική οντότητα. Τροποποιεί την κλίμακα του 

χάρτη και τον μετακινεί έτσι ώστε η επιλεγμένη οντότητα να βρεθεί στο κέντρο του 

χάρτη και να καλύψει όλη την έκτασή του. 
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2.1.3 Full Extent  

Επιλέξτε το εργαλείο Full Extent για να δείτε το σύνολο των 

ενεργοποιημένων επιπέδων πληροφορίας. Το εργαλείο αυτό θα το χρησιμοποιείτε 

συχνά κατά τη γεωαναφορά (εισαγωγή raster δεδομένων) για την οποία θα 

συζητήσουμε παρακάτω. 

 

2.1.4 Previous Extent & Next Extent  

Χρησιμοποιήστε τα εργαλεία Previous Extent και Next Extent  για να 

μεταβείτε στην προηγούμενη ή στην επόμενη προβολή του χάρτη αντίστοιχα.  

 

2.1.5 Fixed Zoom In & Fixed Zoom Out  

Χρησιμοποιήστε τα εργαλεία Fixed Zoom In  και Fixed Zoom Out  για 

προκαθορισμένη μεγέθυνση ή σμίκρυνση του χάρτη από το κέντρο του. 

 

2.1.6 Μετάβαση σε XY (Go To XY)  

Χρησιμοποιήστε την επιλογή Μετάβαση σε XY (Go To XY) αυτή για να 

μεταβείτε σε ένα συγκεκριμένο σημείο του χάρτη μέσω των συντεταγμένων του.  

 

2.1.7 Rectangle Zoom In  

Το Rectangle Zoom In είναι ένα από τα πιο συχνά χρησιμοποιούμενα 

εργαλεία πλοήγησης στο χάρτη. Καθορίζετε την περιοχή η οποία θα μεγεθυνθεί, 

γεμίζοντας το χώρο του χάρτη. Το συγκεκριμένο εργαλείο εντοπίζεται στη γραμμή 

εργαλείων Quick Access toolbar (βλ. Ενότητα 1), ωστόσο αποτελεί εργαλείο 

πλοήγησης. 
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2.1.8 Rectangle Zoom Out  

Το Rectangle Zoom Out  είναι ένα από τα πιο συχνά χρησιμοποιούμενα 

εργαλεία πλοήγησης στο χάρτη. Καθορίζεται η περιοχή η οποία θα σμικρυνθεί, 

γεμίζοντας το χώρο του χάρτη. Το συγκεκριμένο εργαλείο εντοπίζεται στη γραμμή 

εργαλείων Quick Access toolbar (βλ. Ενότητα 1), ωστόσο αποτελεί εργαλείο 

πλοήγησης. 

 

2.1.9 Πρόσθετα εργαλεία πλοήγησης 

Εκτός από τα παραπάνω εργαλεία, υπάρχουν και άλλες μέθοδοι πλοήγησης, 

κουμπιά, εργαλεία και εντολές, όπως: 

▪ Zoom to the extent of a layer: Πιέζοντας παρατεταμένα το πλήκτρο Alt και 

επιλέγοντας ένα επίπεδο πληροφορίας από το διαχειριστή επιπέδων 

πληροφορίας, γίνεται πλήρης μεγέθυνση ώστε στο παράθυρο του χάρτη να είναι 

εμφανής όλη η έκταση του περιεχομένου του συγκεκριμένου επιπέδου 

πληροφορίας.  

▪ Zoom to layer: Επιλέξτε από το διαχειριστή επιπέδων πληροφορίας το επίπεδο 

πληροφορίας το οποίο θέλετε να μεγεθύνετε στο παράθυρο του χάρτη σας. Με 

δεξί κλικ θα εμφανιστεί μια λίστα επιλογών. Επιλέξτε την εντολή Zoom To 

Layer για να καταλάβει το συγκεκριμένο επίπεδο πληροφορίας όλη την έκταση 

του χάρτη σας.  
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2.2 Κλίμακα χάρτη 

Σε ένα γεωγραφικό σύστημα πληροφοριών η έννοια της κλίμακας ενός χάρτη δεν 

είναι η ίδια με αυτή που έχουμε συνηθίσει έως τώρα. Ουσιαστικά η κλίμακα 

παρατήρησης δεν έχει άνω ή κάτω φράγμα. Περιορίζεται μόνο από την κλίμακα των 

πρωτογενών δεδομένων. Για παράδειγμα, αν εισάγουμε στο GIS ένα χάρτη κλίμακας 

1:50.000, το GIS μπορεί να εμφανίσει τα δεδομένα που έχουν προέλθει από τη 

ψηφιοποίησή του ακόμη και σε κλίμακα 1:1, ωστόσο η λεπτομέρεια των πληροφοριών 

δε θα αυξηθεί πέρα της 1:50.000.  

Εξοικειωθείτε με τη διαχείριση της κλίμακας του χάρτη σας. Για να αλλάξετε την 

κλίμακα του χάρτη έχετε πολλές δυνατότητες. Η κλίμακα τροποποιείται μέσω 

μεγέθυνσης ή σμίκρυνσης, αλλά μπορεί να καθοριστεί και ελεύθερα από εσάς από το 

κάτω αριστερό περιθώριο του χάρτη  (Εικ. 2.2), σημειώνοντας στο 

πεδίο χειροκίνητα την επιθυμητή κλίμακα, είτε επιλέγοντας από το combo box μια από 

τις ήδη προτεινόμενες από το λογισμικό κλίμακες (Εικ. 2.2). Μπορείτε να εμπλουτίσετε 

τη λίστα με τις προτεινόμενες κλίμακες ανάλογα με τις ανάγκες της εργασίας σας.  
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Εικ. 2.2: Επιλέξτε την κλίμακα που ικανοποιεί καλύτερα τους στόχους της εργασίας σας μέσα από μια σειρά 
προκαθορισμένων επιλογών ή συμπληρώνοντας ελεύθερα την επιθυμητή κλίμακα (π.χ. 1:12.500). Μπορείτε μέσω του 
Customize να φτιάξετε δικές σας επιλογές και να εμπλουτίσετε τη λίστα αυτή.  

 

2.3 Διαχείριση Χωρικής / Περιγραφικής Πληροφορίας 

2.3.1 Προσθήκη δεδομένων στο παράθυρο του χάρτη (Add Data) 

Προσθέστε στο παράθυρο του χάρτη ήδη υπάρχοντα επίπεδα πληροφορίας. Αν 

θυμάστε από τη θεωρία, οι κύριες κατηγορίες επιπέδων πληροφορίας είναι δύο: τα 

διανυσματικά (vector) και τα ψηφιδωτά (raster). Σε παρακάτω ενότητα θα δούμε άλλη 

μια κατηγορία, τα raster-grid δεδομένα που προκύπτουν από προσομοίωση.  

Χρησιμοποιήστε το εργαλείο Add Data , που θα το βρείτε στο μενού Map 

και συγκεκριμένα στην ομάδα εργαλείων Layer, αφού έχει προηγηθεί (ή όχι) η σύνδεση 

με το φάκελο που τα εμπεριέχει (Εικ. 2.3). Εναλλακτικά, τα δεδομένα μπορούν να 

προστεθούν στη χαρτοσύνθεση με μεταφορά και απόθεση (drag and drop) από τον 

Catalog, αλλά πρέπει υποχρεωτικά να έχει προηγηθεί η σύνδεση με το φάκελο που τα 

εμπεριέχει (βλ. υποκεφ. 1.3.4). Ωστόσο, στις νεότερες εκδώσεις του λογισμικού, τα 
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δεδομένα μπορεί να εισαχθούν στο λογισμικό με μεταφορά και απόθεση (drag and 

drop) κατ’ ευθείαν από το φάκελο του τοπικού υπολογιστή που τα εμπεριέχει. 

 

 

Εικ. 2.3: Χρησιμοποιήστε το εργαλείο Add Data (Map → Layer → Add Data) για να προσθέσετε στο παράθυρο του 
χάρτη τα επίπεδα πληροφορίας που θα επιλέξετε. Προαιρετικά, και για μεγαλύτερη ευκολία, προτείνεται να έχετε κάνει 
πρώτα σύνδεση του φακέλου στο Project (βλ. υποκεφ. 1.3.4). 

 

2.3.2 Τι διαφορά έχει ένας χάρτης GIS από οποιοδήποτε άλλο χάρτη; 

Οι διαφορές είναι πολλές! Αλλά τώρα θα μιλήσουμε για την περιγραφική 

πληροφορία. Δηλαδή, κάθε γεωγραφική οντότητα δεν είναι απλά μια αναπαράσταση 

σε έναν χάρτη. Υπάρχει πίσω από αυτή μια βάση δεδομένων με πληροφορίες για αυτή. 

H γεωγραφική πληροφορία, η πληροφορία που είναι ορατή στο παράθυρο του χάρτη, 

είναι άρρηκτα συνδεδεμένη με τον πίνακα περιγραφικών χαρακτηριστικών (ή βάση 

δεδομένων). Για παράδειγμα, στο επίπεδο πληροφορίας του υδρογραφικού δικτύου, 

στη βάση δεδομένων θα μπορούσε να υπάρχει η πληροφορία του ονόματος ή και του 

μήκους κάθε κλάδου, της ετήσιας παροχής του, κάποιων μορφομετρικών 

χαρακτηριστικών κ.ά. 

Και πώς μπορούμε να δούμε την πληροφορία αυτή;  
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Ένας απλός τρόπος είναι να πιέσουμε το ποντίκι μας πάνω σε μια γεωγραφική 

οντότητα. Θα αναδυθεί ένα παράθυρο το οποίο παρουσιάζει την περιγραφική 

πληροφορία που εμπεριέχει ο πίνακας περιγραφικών χαρακτηριστικών για τη 

συγκεκριμένη οντότητα. Οι πληροφορίες θα εμφανίζονται σε μορφή λίστας (Εικ. 2.4). 

Αν όμως θέλετε να δείτε την περιγραφική πληροφορία για το σύνολο του επιπέδου 

πληροφορίας, μπορείτε να ενεργοποιήσετε τον πίνακα περιγραφικών χαρακτηριστικών 

(Attribute Table) μέσω του διαχειριστή επιπέδων πληροφορίας με δεξί κλικ στο 

επίπεδο πληροφορίας που σας ενδιαφέρει και στη συνέχεια επιλογή της εντολής 

Attribute Table (Εικ. 2.5). 

 

 

Εικ. 2.4: Επιλέξτε μια οντότητα από το παράθυρο του χάρτη και θα εμφανιστεί σε μορφή λίστας η περιγραφική 
πληροφορία που αφορά στη συγκεκριμένη οντότητα. Π.χ., για το επίπεδο πληροφορίας της λιθολογίας, εμφανίζονται 
για τη συγκεκριμένη οντότητα η ίδια η λιθολογία (μάρμαρα-σχιστόλιθοι), η λιθολογία στα αγγλικά, η περίμετρος 
(Shape_Length), η έκτασή της (Shape_Area) κ.ά. 
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2.3.3 Τι είναι ο πίνακας περιγραφικής πληροφορίας; 

Κάθε διανυσματικό επίπεδο πληροφορίας χωρίζεται σε δύο τμήματα, στη χωρική 

πληροφορία, δηλαδή ό,τι φαίνεται σε ένα χάρτη, και στην περιγραφική πληροφορία, 

που αποθηκεύεται στον πίνακα περιγραφικών χαρακτηριστικών. Και τα δύο τμήματα 

είναι άρρηκτα συνδεδεμένα μεταξύ τους.  

Ωστόσο, τι είναι αυτός ο πίνακας; Είναι μια βάση δεδομένων. Η πιο απλή βάση 

δεδομένων που όλοι έχετε δει είναι το παρουσιολόγιο. Για σκεφτείτε το! Είναι ένας 

πίνακας που αποτελείται από γραμμές και στήλες. Στο παράδειγμά μας, κάθε φοιτητής 

αντιστοιχεί σε μια γραμμή στον πίνακα αυτό. Όλες οι γραμμές έχουν τις ίδιες στήλες. 

Οι στήλες μπορεί να είναι οι ημερομηνίες που έγιναν τα μαθήματα προκειμένου να 

σημειώσει ο διδάσκοντας την παρουσία ή απουσία του φοιτητή.  

Σκεφτείτε τώρα ότι αντί για παρουσιολόγιο έχετε στα χέρια σας έναν κατάλογο με 

τους νομούς της Ελλάδας. Η κάθε σειρά θα αναφέρεται σε κάθε νομό, ενώ η κάθε 

στήλη περιέχει κάποια πληροφορία για κάθε νομό, που μπορεί να είναι το όνομά του, 

η πρωτεύουσά του, η έκτασή του, ο πληθυσμός του, ο αριθμός των δήμων που τον 

αποτελούν κ.ά. 

Σε μια βάση δεδομένων, οι σειρές ονομάζονται εγγραφές και αντιστοιχούν σε 

διαφορετικές γεωγραφικές οντότητες στο GIS, ενώ οι στήλες ονομάζονται πεδία. Κάθε 

πεδίο περιλαμβάνει μια διαφορετική πληροφορία για κάθε μία από τις εγγραφές.  

Κάθε πεδίο μπορεί να αποθηκεύσει έναν συγκεκριμένο τύπο δεδομένων, όπως έναν 

αριθμό, μία ημερομηνία ή τμήμα κειμένου. 

Ο πίνακας περιγραφικών χαρακτηριστικών σχεδιάζεται από την αρχή, όταν 

δημιουργείται το επίπεδο πληροφορίας (θα το δούμε αναλυτικά στην ενότητα 3 που 

αφορά στην εισαγωγή δεδομένων σε ένα GIS). Ωστόσο, κατά τη διάρκεια της εργασίας 

μπορεί να γίνει τροποποίηση της αρχικής σχεδίασης, όπως για παράδειγμα προσθήκη 

ή αφαίρεση πεδίων ανάλογα με τις ανάγκες που προκύπτουν.  

Η πρόσβαση στον πίνακα περιγραφικών χαρακτηριστικών επιτυγχάνεται μέσω του 

διαχειριστή επιπέδων πληροφορίας, με δεξί κλικ στο επιθυμητό επίπεδο πληροφορίας 

και επιλογή της εντολής Attribute Table  (Εικ. 2.5). Το πάνω τμήμα του πίνακα 

περιγραφικών χαρακτηριστικών περιέχει τα ονόματα των πεδίων του επιπέδου 

πληροφορίας. Παρατηρήστε το κάτω τμήμα του πίνακα περιγραφικών 
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χαρακτηριστικών, στο οποίο αναγράφεται ο αριθμός των εγγραφών που εμπεριέχονται 

στον πίνακα και κατ’ επέκταση στο επίπεδο πληροφορίας (Εικ. 2.6). 

 

 

Εικ. 2.5: Επιλέξτε από το διαχειριστή επιπέδων πληροφορίας (Contents) το επίπεδο πληροφορίας του οποίου τον 
πίνακα περιγραφικών χαρακτηριστικών επιθυμείτε να δείτε. Με δεξί κλικ πάνω στο επίπεδο πληροφορίας θα 
εμφανιστεί ένα παράθυρο με εντολές. Επιλέξτε Attribute Table. 

 

 

Εικ. 2.6: Παράδειγμα πίνακα περιγραφικών χαρακτηριστικών ενός επιπέδου πληροφορίας, το οποίο έχει συνολικά 3 
εγγραφές, που αντιστοιχούν σε τρεις γεωγραφικές οντότητες (εν προκειμένω, τρία πολύγωνα, εφόσον το επίπεδο είναι 
η λιθολογία). Παρατηρήστε ότι για κάθε εγγραφή μπορείτε να πάρετε κάποια πληροφορία από ένα από τα πεδία του 
πίνακα περιγραφικών χαρακτηριστικών. Π.χ. για την εγγραφή 2, μπορείτε να καταλάβετε ότι το αντίστοιχο πολύγωνο 
του χάρτη αποτελείται από γρανοδιορίτη (από το πεδίο «Name»), ενώ μπορείτε να δείτε και την περίμετρο και την 
έκτασή του (πεδία «Shape_Length» και «Shape_Area» αντίστοιχα). 
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Παρατηρήστε στο πάνω τμήμα του Attribute Table το μενού, μέσω του οποίου 

μπορείτε να διαχειριστείτε τον πίνακα περιγραφικών χαρακτηριστικών. Δίνονται 

πολλές δυνατότητες διαχείρισης και επεξεργασίας, όπως (Εικ. 2.7): 

▪ Add Field : Προσθήκη νέου πεδίου στον πίνακα περιγραφικών 

χαρακτηριστικών. 

▪ Delete Selection : Διαγραφή μιας εγγραφής από τον πίνακα περιγραφικών 

χαρακτηριστικών. Προσοχή: Αν αφαιρέσετε μία εγγραφή από τον πίνακα 

περιγραφικών χαρακτηριστικών, θα αφαιρεθεί η αντίστοιχη γεωγραφική 

οντότητα από το χάρτη. Αντίστοιχα, αν αφαιρέσετε μία γεωγραφική οντότητα, 

θα διαγραφεί αυτόματα και η αντίστοιχη εγγραφή από τον πίνακα 

περιγραφικών χαρακτηριστικών. 

▪ Copy Selection : Αντιγραφή μιας εγγραφής του πίνακα περιγραφικών 

χαρακτηριστικών. 

▪ Switch Selection : Αντιστροφή μεταξύ των επιλεγμένων και μή εγγραφών 

του πίνακα περιγραφικών χαρακτηριστικών. Για παράδειγμα, αν ένα επίπεδο 

πληροφορίας περιέχει 5 εγγραφές και έχετε επιλέξει τις 3, επιλέγοντας αυτήν 

την εντολή, το λογισμικό θα αποεπιλέξει αυτές τις 3 και θα επιλέξει τις άλλες 

2. 

▪ Calculate Field : Συμπλήρωση ενός πεδίου για τις επιλεγμένες εγγραφές. 

Για παράδειγμα, στην περίπτωση της λιθολογίας, μέσω του εργαλείου 

Calculate Field μπορείτε να ορίσετε για συγκεκριμένες επιλεγμένες οντότητες 

το νομό στον οποίον ανήκουν. Αν πάλι είχατε ένα επίπεδο πληροφορίας που 

αφορά στους νομούς της Ελλάδας και τρία από τα πεδία του πίνακα 

περιγραφικών χαρακτηριστικών ήταν η έκταση, ο πληθυσμός και η 

πληθυσμιακή πυκνότητα, θα μπορούσατε μέσω του εργαλείου Calculate Field 

να υπολογίσετε την πληθυσμιακή πυκνότητα συγκεκριμένων επιλεγμένων 

νομών (ή και όλων), ορίζοντας στο λογισμικό την εξής πράξη: πληθυσμιακή 

πυκνότητα = πληθυσμός / έκταση. 

▪ Selet By Attributes : Επιλογή οντοτήτων με βάση την περιγραφική τους 

πληροφορία. Για παράδειγμα, μπορείτε να ορίσετε στο λογισμικό να σας 
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επιλέξει όλες τις γεωγραφικές οντότητες οι οποίες αφορούν στο υδρογραφικό 

δίκτυο και των οποίων το μήκος υπερβαίνει τα 3 km. 

▪ Zoom To Selection : Μεγέθυνση του χάρτη στις οντότητες που έχουν 

επιλεγεί. 

▪ Export : Εξαγωγή του πίνακα περιγραφικών χαρακτηριστικών για χρήση 

σε άλλο λογισμικό (π.χ. Excel). 

 

 

Εικ. 2.7: Μενού επιλογών για τη διαχείριση της βάσης δεδομένων, το οποίο θα βρείτε ανοίγοντας τον πίνακα 
περιγραφικών χαρακτηριστικών. 

 

2.3.4 Επιλογή γεωγραφικών οντοτήτων 

Οι γεωγραφικές οντότητες στο GIS είναι επιλέξιμες και υπάρχουν πολλοί τρόποι για 

την επιλογή τους. Ο τρόπος που θα διαλέξουμε εξαρτάται από τα δεδομένα μας και από 

την εργασία μας.  

Η επιλογή των γεωγραφικών οντοτήτων μπορεί να γίνει είτε μέσω της χωρικής, είτε 

μέσω της περιγραφικής πληροφορίας. Για το σκοπό αυτό χρησιμοποιούνται τα 

εργαλεία του μενού Map, και συγκεκριμένα της ομάδας Selection. Χρησιμοποιήστε το 

εργαλείο Select  για να επιλέξετε κάποιο αντικείμενο από το χάρτη χειροκίνητα, 

το εργαλείο Select By Attributes  για να γίνει η επιλογή με βάση την περιγραφική 

πληροφορία, ή το εργαλείο Select By Location  με βάση μία συγκεκριμένη θέση 

(Εικ. 2.8). 
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Εικ. 2.8: Τα εργαλεία της ομάδας Selection χρησιμοποιούνται για την επιλογή γεωγραφικών οντοτήτων από το χάρτη. 

 

Μέσω του εργαλείου Select, μπορείτε να σχεδιάσετε ένα γεωμετρικό σχήμα για να 

ορίσετε χειροκίνητα την περιοχή μέσα στην οποία θα γίνει η επιλογή των γεωγραφικών 

οντοτήτων (Εικ. 2.9). Μπορείτε να σχεδιάσετε ένα τετράγωνο (Select By Rectangle) 

, ένα πολύγωνο (Select By Polygon) , να σχεδιάσετε έναν κύκλο (Select By 

Circle) , να επιλέξετε κατά μήκος μιας γραμμής (Select By Line) , να 

επιλέξετε βάσει ίχνους (Select By Trace)  ή να κάνετε ελεύθερη επιλογή, δηλαδή 

ορίζοντας την περιοχή χωρίς να υπάρχει κάποια συγκεκριμένη γεωμετρία (Select By 

Lasso) . 

 

Εικ. 2.9: Εργαλεία επιλογής γεωγραφικών οντοτήτων. 
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Υπάρχουν και πιο εξειδικευμένες δυνατότητες, που είναι όμως διαθέσιμες για 

τρισδιάστατα δεδομένα. 

Αν θέλετε να επιλέξετε οντότητες από το χάρτη με βάση κάποιο συγκεκριμένο 

χαρακτηριστικό από την περιγραφική τους πληροφορία, χρησιμοποιήστε το εργαλείο 

Select By Attributes (Εικ. 2.8). Μερικοί από τους πιο συχνά χρησιμοποιούμενους 

τελεστές είναι: είναι ίσο με (is equal to), δεν είναι ίσο με (is not equal to), εμπεριέχει 

την οντότητα/τις οντότητες (includes the value(s)). 

Για παράδειγμα, ας υποθέσουμε ότι στην περίπτωση του επιπέδου πληροφορίας του 

υδρογραφικού δικτύου, ο πίνακας περιγραφικών χαρακτηριστικών περιέχει ένα πεδίο 

που αναφέρεται στο μήκος των κλάδων (π.χ. Length_m). Μέσω του εργαλείου Select 

By Attributes, μπορείτε να επιλέξετε όλους τους κλάδους των οποίων το μήκος 

υπερβαίνει τα 3 km. Τότε, θα χρησιμοποιήσετε τον τελεστή «is greater than». Ομοίως, 

μπορείτε να επιλέξετε τους κλάδους των οποίων το μήκος είναι ακριβώς 3 km, οπότε 

θα χρησιμοποιήσετε τον τελεστή «is equal to». 

Τέλος, στην περίπτωση που θέλετε να επιλέξετε οντότητες με βάση τη θέση τους, 

επιλέξτε το πόσοι κλάδοι υδρογραφικού δικτύου υπάρχουν εντός μίας περιοχής 

μελέτης σας, μπορείτε να επιλέξετε όλους τους κλάδους που περιέχονται εντός των 

ορίων του επιπέδου πληροφορίας της περιοχής μελέτης. 

 

2.4 Γεωγραφικές μετρήσεις 

Δεδομένου ότι στα GIS κάθε γεωγραφική οντότητα βρίσκεται στην πραγματική της 

θέση στο χώρο, κάτι που επιτυγχάνεται μέσω των συντεταγμένων, υπάρχει η 

δυνατότητα για γρήγορες και ακριβείς γεωγραφικές μετρήσεις. 

Για παράδειγμα, τα γεωγραφικά χαρακτηριστικά μιας οντότητας, όπως το μήκος, η 

περίμετρος, η έκταση κ.ά., ακόμη και αν δεν είναι γνωστά, μπορούν να ανακτηθούν 

από το GIS και ταυτόχρονα να ενημερωθεί με αυτά ο πίνακας περιγραφικών 

χαρακτηριστικών. Τα γεωγραφικά χαρακτηριστικά, όπως για παράδειγμα, το μήκος, το 

εμβαδόν, η περίμετρος κ.ά., μετριούνται με ποικίλους τρόπους, όπως μέσω του χάρακα 

μέτρησης (εργαλείο Measure) ή μέσω της εντολής Calculate Geometry του πίνακα 

περιγραφικών χαρακτηριστικών. Το εργαλείο Measure  θα το βρείτε στο μενού 
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Map και συγκεκριμένα στην ομάδα εργαλείων Inquiry (Εικ. 2.10) και δίνει μια σειρά 

από δυνατότητες με πιο συχνά χρησιμοποιούμενες τις ακόλουθες: 

 

 

Εικ. 2.10: Το εργαλείο Measure βρίσκεται στο μενού Map, στην ομάδα εργαλείων Inquiry και αποτελείται από 
πληθώρα επιλογών. 

▪ Μέτρηση αποστάσεων (Measure Distance) : Είναι το πιο συχνά 

χρησιμοποιούμενο εργαλείο για γρήγορες και απλές γεωγραφικές μετρήσεις. 

Μπορείτε να μετρήσετε την απόσταση ανάμεσα δύο ή περισσότερα σημεία του 

χάρτη κάνοντας απλά κλικ σε αυτά (Εικ. 2.11).  

▪ Μέτρηση επιφανειών (Measure Area) : Χρησιμοποιείται για τη 

μέτρηση της περιμέτρου και του εμβαδού μίας περιοχής σε ένα σύστημα 

γεωγραφικών συντεταγμένων (Εικ. 2.12). Για να το χρησιμοποιήσετε, 

δημιουργείτε το πολύγωνο που επιθυμείτε κάνοντας απλά κλικ στις γωνίες του. 

▪ Μέτρηση γωνιών (Measure Angle) : Στην περίπτωση αυτή θα χρειαστεί 

να σχεδιάσετε δύο ή περισσότερες γραμμές για να μετρήσετε τις γωνίες μεταξύ 

τους.  

▪ Μέτρηση κατευθύνσεων (Measure Direction Distance) : Στην 

περίπτωση αυτή θα χρειαστεί να σχεδιάσετε μία γραμμή στο χάρτη για να 

μετρήσετε την ευθεία γραμμή και την απόσταση μεταξύ δύο ή περισσότερων 

σημείων.   
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▪ Μέτρηση αντισταθμίσεων (Measure Offset) : Χρησιμοποιείται για τη 

μέτρηση της κάθετης απόστασης ενός σημείου που επιλέγετε από μία γραμμή 

που θα σχεδιάσετε. 

▪ Μέτρηση οντοτήτων (Measure Features) : χρησιμοποιείται για την 

μέτρηση του μήκους μίας οντότητας (σε γραμμή), της περιμέτρου και της 

έκτασης (σε πολύγωνα) ή της θέσης με συντεταγμένες (x,y,z) (σε σημείο). 

 

 

Εικ. 2.11: Χρησιμοποιήστε το εργαλείο Measure Distance για να μετρήσετε την απόσταση ανάμεσα σε δύο σημεία, 

κάνοντας απλά κλικ σε αυτά. Επιλέξτε τις μονάδες μέτρησης που επιθυμείτε. 
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Εικ. 2.12: Χρησιμοποιήστε το εργαλείο Measure Area για να μετρήσετε το εμβαδόν και την περίμετρο ενός πολυγώνου 

που επιθυμείτε, το οποίο δημιουργείται κάνοντας απλά κλικ στις γωνίες του. Καθορίστε τις μονάδες μέτρησης που 
επιθυμείτε. 
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Ενότητα 3 - Εισαγωγή δεδομένων  
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3.1 Εισαγωγή Ψηφιδωτών (Raster) δεδομένων 

Τα ψηφιδωτά ή εικονοκυτταρικά δεδομένα είναι ουσιαστικά αρχεία εικόνας που 

έχουν γεωαναφερθεί. Συνήθως πρόκειται για σαρωμένους χάρτες, δορυφορικές εικόνες 

ή ακόμη και ορθοφωτομωσαϊκό αεροφωτογραφιών. Η γεωαναφορά ενός αρχείου 

εικόνας περιλαμβάνει ουσιαστικά 4 διακριτά βήματα: 

 

▪ Βήμα 1: Επιλογή προβολικού συστήματος 

Πριν τη γεωαναφορά ενός χάρτη, πρέπει να επιλεγεί το προβολικό σύστημα στο 

οποίο θα γίνει η γεωαναφορά. Αφού έχετε συνδέσει το φάκελο των δεδομένων σας με 

το Project σας (βλ. υποκεφ. 1.3.4), μεταβείτε στον Catalog. Με δεξί κλικ στο raster 

αρχείο Thessaloniki.jpg, μέσω της επιλογής Properties (Εικ. 3.1), εμφανίζεται το 

παράθυρο διαλόγου Raster Dataset Properties: Thessaloniki.jpg (Εικ. 3.2). Στην 

καρτέλα General και συγκεκριμένα στην ενότητα Spatial Reference (Γεωαναφορά), 

επιλέγοντας το σύμβολο , εμφανίζεται το παράθυρο διαλόγου Spatial Reference 

(Εικ. 3.3). Ακολουθώντας το μονοπάτι Projected Coordinate Systems → UTM → WGS 

1984 → Northern Hemisphere → WGS 1984 UTM Zone 34N (Εικ. 3.4) και πιέζοντας 

OK καθορίζεται το προβολικό σύστημα στο οποίο αντιστοιχούν οι συντεταγμένες που 

δίνονται στο συγκεκριμένο χάρτη. 
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Εικ. 3.1: Από τον Catalog, με δεξί κλικ στο αρχείο Thessaloniki.jpg και επιλέγοντας Properties, ενεργοποιείται το 
παράθυρο διαλόγου Raster Dataset Properties, από όπου ορίζεται το προβολικό σύστημα. 

 

 

Εικ. 3.2: Παράθυρο διαλόγου Raster Dataset Properties: Thessaloniki.jpg. 
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Εικ. 3.2: Παράθυρο διαλόγου Raster Dataset Properties: Thessaloniki.jpg (συνέχεια). 

 

 

Εικ. 3.3: Παράθυρο διαλόγου Spatial Reference. 
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Εικ. 3.4: Εντοπισμός του προβολικού συστήματος WGS 1984 UTM Zone 34N, ακολουθώντας το μονοπάτι Projected 

Coordinate Systems → UTM → WGS 1984 → Northern Hemisphere → WGS 1984 UTM Zone 34N. 

 

▪ Βήμα 2: Δημιουργία πυραμίδων 

Με τη δημιουργία πυραμίδων γίνεται καταμερισμός του ψηφιδωτού αρχείου σε 

πολλά μικρά τμήματα. Το GIS έχει τη δυνατότητα να απομονώνει το τμήμα του raster 

αρχείου που δεν εμφανίζεται στο παράθυρο του χάρτη και να διαβάζει μόνο το ορατό 

τμήμα αυτού, με αποτέλεσμα το σύστημα να κινείται ταχύτερα. Η ύπαρξη των 

πυραμίδων δεν είναι ορατή τη στιγμή που εμφανίζεται το ψηφιδωτό αρχείο (raster). 

Απαιτείται η δημιουργία πυραμίδων; Η γεωαναφορά μπορεί να γίνει και χωρίς να 

δημιουργήσετε πυραμίδες. Ωστόσο προτείνεται να μην προσπεράσετε αυτό το βήμα 

γιατί τα αρχεία raster συχνά είναι ιδιαίτερα βαριά με αποτέλεσμα να δημιουργούν 

μεγάλες καθυστερήσεις στο σύστημα.  

Για να δημιουργήσετε πυραμίδες, μεταβείτε στο μενού View, στην ομάδα εργαλείων 

Windows και χρησιμοποιήστε το εργαλείο Geoprocessing  (Εικ. 3.5). Από το 

αναδυόμενο παράθυρο (Εικ. 3.6) θα αναζητηθεί το εργαλείο Build Pyramids (Data 

Management Tools > Raster > Raster Properties > Build Pyramids) (Εικ. 3.7).  
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Εικ. 3.5: Το εργαλείο Geoprocessing βρίσκεται στο μενού View, στην ομάδα εργαλείων Windows. 

 

 

Εικ. 3.6: Επιλέγοντας το εργαλείο Geoprocessing (View → Windows → Geoprocessing), αναδύεται το παράθυρο που 
περιέχει όλες τις διαθέσιμες εργαλειοθήκες που εμπεριέχει το λογισμικό ανά κατηγορίες. 
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Εικ. 3.7: Το εργαλείο Build Pyramids βρίσκεται στην εργαλειοθήκη Data Management Tools. Με την επιλογή του 
ενεργοποιείται το παράθυρο διαλόγου Build Pyramids. 

 

Ως Input Raster Dataset ορίστε το αρχείο που θέλετε να εισαγάγετε στο λογισμικό 

(για την άσκησή σας, θα είναι η εικόνα Τhessaloniki.jpg). Επιλέγοντας την εντολή Run 

θα ξεκινήσει η δημιουργία των πυραμίδων (Εικ. 3.8).  

Ένας πιο άμεσος και απλός τρόπος είναι μέσω του Catalog, όπου με δεξί κλικ στο 

αρχείο Thessaloniki.jpg επιλέγετε την εντολή Build Pyramids (Εικ. 3.9). Μετά την 

εκτέλεση της εντολής με οποιονδήποτε από τους δύο παραπάνω τρόπους, το αρχείο 

Thessaloniki.jpg φαίνεται πλέον στο παράθυρο του χάρτη (Εικ. 3.10). 
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Εικ. 3.8: Αφού έχει οριστεί το επιθυμητό αρχείο raster στο πεδίο Input Raster Dataset, μέσω της εντολής Run 

δημιουργούνται οι πυραμίδες. 
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Εικ. 3.9: Δημιουργία πυραμίδων μέσα από τον Catalog (δεξί κλικ στο αρχείο εικόνας που θέλουμε να εισαγάγουμε – 

στη συγκεκριμένη άσκηση το Thessaloniki.jpg). 
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Εικ. 3.10: Αφού δημιουργήσουμε πυραμίδες στο αρχείο εικόνας που θέλουμε να εισαγάγουμε στο λογισμικό (εδώ: το 
Thessaloniki.jpg), ακολουθώντας έναν από τους τρόπους που περιγράφηκαν πριν (Εικ. 3.7 ή 3.9), έχει τοποθετηθεί 
πλέον το αρχείο εικόνας στο παράθυρο του χάρτη. Παρατηρήστε πού βρίσκεται. Είναι στη σωστή του θέση; 

 

▪ Βήμα 3: Γεωαναφορά 

Προκειμένου να γίνει η σύνδεση των ψηφιδωτών δεδομένων με την πραγματική 

τους θέση στο χώρο, απαιτούνται τουλάχιστον τρία ζεύγη συντεταγμένων (Χ,Υ), τα 

οποία συνήθως αντιστοιχούν στις άκρες της εικόνας.  

Για τις ανάγκες της άσκησης θα γεωαναφέρουμε το χάρτη της Θεσσαλονίκης, έτσι 

ώστε να τοποθετηθεί στην πραγματική του θέση στο χώρο, χρησιμοποιώντας τέσσερα 

ζεύγη συντεταγμένων, και συγκεκριμένα τις τέσσερις άκρες του, όπου θα 

παρατηρήσετε ότι αναγράφονται οι συντεταγμένες τους. 

Η γεωαναφορά γίνεται μέσω του εργαλείου Georeference  (Εικ. 3.11), που θα 

το βρείτε στο μενού Imagery και συγκεκριμένα στην ομάδα εργαλείων Alignment. 

Κατά την επιλογή του εργαλείου ενεργοποιείται το μενού Georeference (Εικ. 3.12). 

Από το μενού Georeference, στην ομάδα εργαλείων Adjust, μέσω του εργαλείου Add 
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Control Points  (Εικ. 3.12), θα προσθέσετε τα σημεία αγκίστρωσης (ή σημεία 

ελέγχου) του χάρτη στα οποία θα αντιστοιχηθούν οι συντεταγμένες που αναγράφονται.  

Εδώ θα πρέπει να είστε πολύ προσεκτικοί. Αφότου ενεργοποιηθεί το εργαλείο Add 

Control Points, θα χρειαστεί να κάνετε αργά δύο κλικ στην κάθε γωνία του χάρτη, όπου 

οι συντεταγμένες είναι γνωστές. Με τον τρόπο αυτό εισάγονται σημεία ελέγχου 

(Control Point). Μέσω του εργαλείου Control Point Table , που βρίσκεται στο 

μενού Georeference και συγκεκριμένα στην ομάδα εργαλείων Review (Εικ. 3.12), 

γίνεται ο έλεγχος των σημείων αγκίστρωσης. Κατά την ενεργοποίηση του εργαλείου, 

αναδύεται το παράθυρο διαλόγου Control Point Table Map: Thessaloniki.jpg (Εικ. 

3.13).  

Από το συγκεκριμένο παράθυρο μπορείτε να βρείτε διάφορες χρήσιμες λειτουργίες, 

μερικές από τις οποίες είναι οι εξής: να προσθέσετε ένα νέο σημείο ελέγχου μέσω του 

εργαλείου Add Control Points , να διαγράψετε ένα σημείο ελέγχου που εισάχθηκε 

εσφαλμένα μέσω του εργαλείου Delete Control Points , να μεγεθύνετε το χάρτη σε 

επιλεγμένα σημεία μέσω του εργαλείου Zoom To Selected , να διαγράψετε το 

σύνολο των σημείων που έχουν εισαχθεί μέσω του εργαλείου Delete All , να 

εξαγάγετε τα σημεία ελέγχου μέσω του εργαλείου Export Control Points  για χρήση 

τους σε άλλο λογισμικό ή να εισαγάγετε σημεία μέσω του εργαλείου Import Control 

Points  (Εικ. 3.13). 

 

 

Εικ. 3.11: Το εργαλείο Georeference που θα το βρείτε στο μενού Imagery και συγκεκριμένα στην ομάδα εργαλείων 
Alignment. 

 

 

Εικ. 3.12: Με την επιλογή του εργαλείου Georeference ενεργοποιείται το μενού Georeference που θα το 
χρησιμοποιήσετε για το 3ο κατά σειρά βήμα που θα ακολουθήσετε για την γεωαναφορά. 
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Εικ. 3.13: Aναδυόμενο παράθυρο (Control Point Table Map: Thessaloniki.jpg) έπειτα από την επιλογή του εργαλείου 
Control Point Table. Στο παρόν παράθυρο υπάρχουν και τα επιμέρους εργαλεία επεξεργασίας. Εδώ, θα εισαγάγετε για 
κάθε σημείο ελέγχου (που αντιστοιχεί σε κάθε μία από τις στήλες που βλέπετε), τα αντίστοιχα Χ και Y με βάση τις 
συντεταγμένες που αναγράφονται στις άκρες του αρχείου εικόνας Thessaloniki.jpg. 

 

Στα πεδία X Map και Y Map εμφανίζονται τυχαίες συντεταγμένες, που αντιστοιχούν 

στις καρτεσιανές συντεταγμένες της οθόνης (Εικ. 3.13). Θα χρειαστεί να 

τροποποιηθούν οι καρτεσιανές συντεταγμένες που αναγράφονται στα πεδία X Map και 

Y Map με τις πραγματικές συντεταγμένες που αντιστοιχούν σε κάθε σημείο (όπως 

εμφανίζονται στις άκρες του χάρτη). Ένας άλλος τρόπος εισαγωγής των 

συντεταγμένων Χ και Υ είναι με δεξί κλικ σε κάθε σημείο ελέγχου (άρα ένα αριστερό 

κλικ και αμέσως μετά ένα δεξί κλικ) και να συμπληρώνοντας τις συντεταγμένες στα 

αντίστοιχα πεδία, όπως εμφανίζονται στο παράθυρο της εικόνας 3.14.  

Ορισμένες φορές, κατά την εισαγωγή ενός ζεύγους συντεταγμένων, ο χάρτης μπορεί 

να εξαφανιστεί από το παράθυρο του χάρτη. Η επαναφορά του γίνεται με από το 

διαχειριστή επιπέδων πληροφορίας, με δεξί κλικ στο αρχείο εικόνας Thessaloniki.jpg 

και επιλέγοντας το εργαλείο Zoom Τo Layer  (Εικ. 3.15). Η ίδια διαδικασία που 

περιγράφηκε προηγουμένως θα χρειαστεί να επαναληφθεί τουλάχιστον για τρία, μη 

συνευθειακά σημεία, προκειμένου να γεωαναφερθεί ο χάρτης. Στη συγκεκριμένη 

άσκηση, θα χρησιμοποιήσουμε 4 σημεία και, συγκεκριμένα, τις 4 άκρες της εικόνας 

Thessaloniki.jpg. Όταν ολοκληρώσουμε αυτήν τη διαδικασία με επιτυχία, το αρχείο 

εικόνας θα τοποθετηθεί στην πραγματική του θέση στο χώρο (Εικ. 3.16). 
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Εικ. 3.14: Στο παράθυρο Target Coordinates, που εμφανίζεται αν κάνετε αριστερό κλικ και αμέσως μετά δεξί κλικ σε 
ένα σημείο ελέγχου, συμπληρώνετε στα πεδία X και Y τις συντεταγμένες που αναγράφονται στο αρχείο εικόνας 
Thessaloniki.jpg (Χ: γεωγραφικό μήκος, Υ: γεωγραφικό πλάτος). Προσοχή: Ακολουθήστε το πρότυπο της εικόνας, 
δηλαδή χρησιμοποιήστε τελεία για να διαχωρίσετε τα δεκαδικά από τους ακεραίους και μην χρησιμοποιήσετε τελεία ή 
κόμμα για να διαχωρίσετε τις χιλιάδες. 
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Εικ. 3.15: Το εργαλείο Zoom Τo Layer χρησιμοποιείται για να εμφανιστεί το σύνολο της γεωγραφικής πληροφορίας 
του επιλεγμένου επιπέδου πληροφορίας στο παράθυρο του χάρτη. Για να το χρησιμοποιήσετε, μεταβείτε στο διαχειριστή 
επιπέδων πληροφορίας και κάντε δεξί κλικ στο αρχείο εικόνας Thessaloniki.jpg. 
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Εικ. 3.16: Μετά τον καθορισμό των σημείων στις τέσσερεις γωνίες του ψηφιδωτού αρχείου (Thessaloniki.jpg), ο 
χάρτης τοποθετείται στη σωστή θέση του στο χώρο. 

 

▪ Βήμα 4: Αποθήκευση γεωαναφοράς 

Αφού έχουν οριστεί τουλάχιστον τρία μη συνευθειακά σημεία ως σημεία ελέγχου, 

μέσω του εργαλείου Save as New  που θα το βρείτε στο μενού Georeference και 

στην ομάδα εργαλείων Save, θα αποθηκευτεί το raster επίπεδο πληροφορίας που 

γεωαναφέρθηκε. Στο αναδυόμενο παράθυρο διαλόγου Export Raster, μέσω της 

καρτέλας General και του πεδίου Output Raster Dataset, θα καθοριστεί ο φάκελος και 

το όνομα του γεωαναφερμένου επιπέδου πληροφορίας, και μέσω του πεδίου Output 

Format, θα καθορίσετε τον τύπο του γεωαναφερμένου αρχείου, που στη συγκεκριμένη 

περίπτωση θα είναι TIFF (Εικ. 3.17). Στη συνέχεια, μέσω της καρτέλας Settings και 

του πεδίου Resample επιλέγεται η μέθοδος Nearest Neighbor και μέσω της εντολής 

Export ολοκληρώνεται η αποθήκευση του γεωαναφερμένου επιπέδου πληροφορίας 

(Εικ. 3.18). Σε αυτό το σημείο, μπορεί να αφαιρεθεί από το διαχειριστή επιπέδων 

πληροφορίας το μη γεωαναφερμένο αρχείο εικόνας (Thessaloniki.jpg). Για να γίνει 

αυτό, επιλέξτε το αρχείο Thessaloniki.jpg από το διαχειριστή επιπέδων πληροφορίας 

και με δεξί κλικ θα εμφανιστεί ένα μενού εντολών, από όπου θα επιλέξετε την εντολή 

Remove. 
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Εικ. 3.17: Το αναδυόμενο παράθυρο διαλόγου Export Raster, που εμφανίζεται αν στο μενού Georeference και στην 

ομάδα εργαλείων Save επιλέξετε το εργαλείο Save as New . Εδώ βλέπετε την καρτέλα General, όπου ορίζετε τη θέση 
που θα αποθηκευτεί το αρχείο raster (Output Raster Dataset), το προβολικό σύστημα που θα έχει (Coordinate 

System), ο τύπος του αρχείου που θα δημιουργηθεί (Output Format – εδώ θα επιλέξετε τον τύπο TIFF) και άλλες 
παράμετροι. 
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Εικ. 3.18: Το αναδυόμενο παράθυρο διαλόγου Export Raster (βλ. Εικ. 3.17). Εδώ βλέπετε την καρτέλα Settings. 
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3.1.1 Μπορώ να αλλάξω προβολικό σύστημα; 

Έχετε τη δυνατότητα να παρουσιάσετε τα δεδομένα ενός χάρτη σε διαφορετικό 

προβολικό σύστημα από αυτό στο οποίο έχει γίνει η αρχική γεωαναφορά. Από τα 

δεδομένα που σας έχουν δοθεί, εμφανίστε το χάρτη argos50000_Greek_Grid.tiff ο 

οποίος έχει ήδη γεωαναφερθεί σε ΕΓΣΑ ’87 στο σύστημα GCS WGS 1984 (για την 

εισαγωγή του ακολουθήστε τα βήματα που περιγράφονται στο υποκεφ. 2.3.1).  

Για να το κάνετε αυτό, θα χρειαστεί να ενεργοποιήσετε την καρτέλα Properties, 

μέσω του διαχειριστή επιπέδων πληροφορίας, με δεξί κλικ στο Map Properties. Στο 

αναδυόμενο παράθυρο Map Properties: Map, στην καρτέλα Coordinate Systems, 

ορίστε το προβολικό σύστημα από Greek Grid (Εικ. 3.19) σε GCS WGS 1984, 

ακολουθώντας το path: Geographic Coordinate System → World → WGS 1984) (Εικ. 

3.20). 

 

 

Εικ. 3.19: Στο αναδυόμενο παράθυρο διαλόγου Map Properties: Map και στην καρτέλα Coordinate System ορίζεται 
το προβολικό σύστημα της χαρτοσύνθεσης. Το προβολικό σύστημα που εμφανίζεται με την εμφάνιση του παραθύρου 
είναι αυτό στο οποίο είναι ήδη γεωαναφερμένο το αρχείο, δηλαδή το Greek Grid, το οποίο ωστόσο μπορείτε να 
τροποποιήσετε (βλ. Εικ. 3.20). 
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Εικ. 3.20: Στο αναδυόμενο παράθυρο διαλόγου Map Properties: Map και στην καρτέλα Coordinate System υπάρχει 
δυνατότητα αλλαγής του προβολικού συστήματος της χαρτοσύνθεσης. 

 

Είναι όμως αυτή η αλλαγή μόνιμη; Όχι, δεν είναι, γεγονός που σημαίνει ότι όταν 

απενεργοποιήσετε το επίπεδο πληροφορίας, η αλλαγή αυτή θα χαθεί. Την επόμενη 

φορά που θα ενεργοποιήσετε και πάλι το επίπεδο πληροφορίας 

argos50000_Greek_Grid.tiff, θα είναι πάλι στο προβολικό σύστημα ΕΓΣΑ ’87 (Εικ. 

3.21). 
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Εικ. 3.21: Ο χάρτης είναι γεωαναφερμένος στο προβολικό σύστημα Greek Grid, παρόλο που στην παρούσα εικόνα 

εμφανίζεται σε GCS WGS 1984. Η αλλαγή αυτή όμως δεν είναι μόνιμη. Την επόμενη φορά που θα ενεργοποιήσετε και 
πάλι το επίπεδο πληροφορίας argos50000_Greek_Grid.tiff, θα είναι πάλι στο προβολικό σύστημα ΕΓΣΑ ’87. 

 

3.1.2 Πώς θα μπορούσα να αλλάξω μόνιμα το προβολικό σύστημα σε ένα raster 

επίπεδο πληροφορίας; 

Το προβολικό σύστημα ενός ήδη γεωαναφερμένου χάρτη τροποποιείται μόνιμα, αν 

μεταβείτε στο μενού Analysis και συγκεκριμένα στην ομάδα εργαλείων Geoprocessing 

και δημιουργήσετε ένα νέο αρχείο με τη βοήθεια του εργαλείου Tools .  

Έχοντας ενεργό το raster επίπεδο πληροφορίας argos50000_Greek_Grid.tiff, 

χρησιμοποιήστε το εργαλείο Project το οποίο θα βρείτε στην καρτέλα Toolboxes, 

ακολουθώντας τη διαδρομή Data Management Tools → Projections and 

Transformations → Project. Στο αναδυόμενο παράθυρο διαλόγου (Εικ. 3.22), 

συμπληρώστε το πεδίο Input Dataset or Feature Class με το raster επίπεδο 

πληροφορίας argos50000_Greek_Grid.tiff, το πεδίο Output Dataset or Feature Class 
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με το φάκελο στον οποίον θα αποθηκευτεί το νέο αρχείο και το πεδίο Output 

Coordinate System με το νέο προβολικό σύστημα που επιθυμείτε. 

 

 

Εικ. 3.22: Μόνιμη αλλαγή προβολικού συστήματος μέσω του εργαλείου Project (Data Management Tools → 

Projections and Transformations → Project). Συμπληρώστε το πεδίο Input Dataset or Feature Class με το raster 

επίπεδο πληροφορίας argos50000_Greek_Grid.tiff, το πεδίο Output Dataset or Feature Class με το φάκελο στον 

οποίον θα αποθηκευτεί το νέο αρχείο και το πεδίο Output Coordinate System με το νέο προβολικό σύστημα που 

επιθυμείτε. 

 

3.2 Εισαγωγή διανυσματικών δεδομένων  
3.2.1 Τί είναι τα διανυσματικά δεδομένα; 

Τα διανυσματικά ή vector δεδομένα αναπαριστούν γεωγραφικές οντότητες ως 

σημεία, γραμμές ή πολύγωνα. Η εισαγωγή τους στο GIS γίνεται συνήθως, αλλά όχι 

αποκλειστικά, με ψηφιοποίηση. Σε όλα τα διανυσματικά δεδομένα, η πληροφορία 

χωρίζεται σε δύο μέρη: στη γεωγραφική και στην περιγραφική. Όπως έχει αναφερθεί 

και σε προηγούμενη ενότητα, η γεωγραφική πληροφορία αφορά σε αυτό που 

απεικονίζεται στο χάρτη, ενώ η περιγραφική πληροφορία στη βάση δεδομένων που 

βρίσκουμε στον πίνακα περιγραφικών χαρακτηριστικών. Τα δύο αυτά μέρη είναι 

άρρηκτα συνδεδεμένα μεταξύ τους.  

 

 



Γ. Σ. Π. – ArcGIS Pro – ΣΗΜΕΙΩΣΕΙΣ ΕΡΓΑΣΤΗΡΙΟΥ 

60 

 

Τα διανυσματικά δεδομένα μπορεί να είναι σημεία, γραμμές ή πολύγωνα: 

▪ Σημεία (points): Τα σημεία είναι ο απλούστερος τρόπος απεικόνισης 

αντικειμένων στο χώρο. Η διάστασή τους είναι μηδενική και η θέση τους στο 

χώρο προσδιορίζεται με συντεταγμένων σε σχέση με κάποιο σύστημα 

αναφοράς. 

▪ Γραμμές (polylines): Οι γραμμές χρησιμοποιούνται για την απεικόνιση 

πολλών γραμμικών μορφών, όπως ρήγματα, ισοϋψείς καμπύλες, υδρογραφικό 

δίκτυο, ισοβαθείς καμπύλες, όρια μεταβολής μορφολογικών κλίσεων, όρια 

νομών ή δήμων, οδικό δίκτυο κ.ά. Οι γραμμές που εισάγονται σε ένα 

γεωγραφικό σύστημα πληροφοριών ενώνονται μεταξύ τους μέσω των κόμβων 

(nodes), που δεν είναι τίποτα άλλο από τα σημεία όπου αλλάζει η διεύθυνση 

της γραμμής. 

▪ Πολύγωνα (polygons): Αναπαριστούν επιφάνειες στο χάρτη. Τα διανυσματικά 

δεδομένα που απεικονίζονται ως πολύγωνα συνήθως βρίσκονται σε γειτνίαση. 

Αυτό σημαίνει ότι τα γειτονικά πολύγωνα μοιράζονται τουλάχιστον μία κοινή 

πλευρά η οποία αποτελείται από κόμβους (nodes). Υπάρχουν εργαλεία 

αυτόματης συμπλήρωσης (π.χ. Auto-Complete Polygon) τα οποία 

αναγνωρίζουν τις περιπτώσεις γειτνίασης δύο πολυγωνικών επιπέδων και έτσι 

συμπληρώνουν τα γεωμετρικά χαρακτηριστικά του ενός πολυγώνου σύμφωνα 

με αυτά ενός άλλου (βλ. υποκεφ. 3.4.3).  

 

3.2.2 Πώς δημιουργούνται διανυσματικά δεδομένα; 

Η διαδικασία ξεκινά από τη δημιουργία του επιπέδου πληροφορίας που θα περιέχει 

τα διανυσματικά δεδομένα. Ας δούμε λοιπόν αρχικά πώς θα δημιουργήσουμε ένα 

επίπεδο πληροφορίας.  

▪ Βήμα 1: Σύνδεση του φακέλου των δεδομένων με το Project  

Αυτή η διαδικασία λαμβάνει χώρα στον Catalog . Μέσω του εργαλείου Add 

Folder  θα οριστεί ο φάκελος στον οποίον θα γίνουν οι εργασίες, έτσι ώστε να 

επιτευχθεί μια άμεση σύνδεση με αυτόν (για τα βήματα αυτά αναλυτικότερα, βλ. 

υποκεφ. 2.3.4).  
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▪ Βήμα 2: Δημιουργία επιπέδου πληροφορίας 

Στον Catalog, με δεξί κλικ στο φάκελο όπου θέλουμε να αποθηκευτεί το επίπεδο 

πληροφορίας, χρησιμοποιούμε την εντολή New  (Εικ. 3.3.1) ώστε να 

δημιουργήσουμε το νέο επίπεδο πληροφορίας (shapefile). Επιλέγοντας Shapefile  

(Εικ. 3.23), θα εμφανιστεί το παράθυρο διαλόγου Create Feature Class (Εικ. 3.23). 

Στην καρτέλα Parameters, στο πεδίο Feature Class Name, καθορίζεται το όνομα του 

επιπέδου πληροφορίας. Στα πλαίσια της άσκησης ονομάστε το «Boreholes» 

(γεωτρήσεις) (Εικ. 3.25). Από το πεδίο Geometry Type, καθορίστε το είδος των 

οντοτήτων που θα περιλαμβάνονται στο επίπεδο πληροφορίας (δηλαδή σημεία, 

γραμμές ή πολύγωνα). Στην άσκησή σας, το αρχείο θα περιέχει γεωτρήσεις, οπότε 

επιλέξτε ως Geometry Type το Point (Εικ. 3.25) και από το πεδίο Coordinate System 

ορίστε το προβολικό σύστημα. Επιλέξτε το Greek Grid το οποίο θα το εντοπίσετε 

ακολουθώντας το μονοπάτι Projected Coordinate System → National Grids → Europe 

→ Greek Grid (Εικ. 3.25). Το πεδίο Feature Class Location είναι ήδη συμπληρωμένο 

και μέσω αυτού προσδιορίζεται η θέση στην οποία θα αποθηκευτεί το νέο επίπεδο 

πληροφορίας. Αυτήν δεν χρειάζεται να την συμπληρώσετε, καθώς την καθορίσατε 

έμμεσα, αφού δημιουργήσατε το επίπεδο πληροφορίας μέσω του Catalog. 
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Εικ. 3.23: Μέσω του Catalog, με δεξί κλικ στο φάκελο των δεδομένων μας και επιλέγοντας την εντολή New, μπορούμε 

να δημιουργήσουμε ένα νέο επίπεδο πληροφορίας. 
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Εικ. 3.24: Επιλέγοντας shapefile (βλ. Εικ. 3.23), εμφανίζεται νέο παράθυρο (βλ. Εικ. 3.25), μέσω του οποίου 
δημιουργούμε ένα νέο επίπεδο πληροφορίας. 
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Εικ. 3.25: Το παράθυρο του Create Feature Class. Συμπληρώνουμε τα αντίστοιχα πεδία πριν δημιουργήσουμε το 
επίπεδο πληροφορίας (βλ. Εικ. 3.26). 
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Εικ. 3.26: Συμπληρώνουμε τα πεδία Feature Class Name, Geometry Type, Coordinate System για τη δημιουργία του 
νέου επιπέδου πληροφορίας, εισάγοντας αντίστοιχα το όνομα του επιπέδου πληροφορίας που επιθυμούμε (για την 
άσκηση: Boreholes), τον τύπο του (σημεία, γραμμές ή πολύγωνα – για την άσκηση: point) και το προβολικό σύστημα 
(για την άσκηση: Greek Grid). Στη συνέχεια, επιλέγουμε την εντολή Run και έτσι δημιουργείται το επίπεδο 
πληροφορίας με τις παραμέτρους που ορίσαμε (βλ. Εικ. 3.27). 
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Για τη δημιουργία του σημειακού επιπέδου πληροφορίας επιλέγετε το Run (Εικ. 

3.26). Παρατηρήστε ότι το επίπεδο πληροφορίας εμφανίζεται στο διαχειριστή 

επιπέδων πληροφορίας (Εικ. 3.27).  

Παρατηρήστε επίσης το παράθυρο του χάρτη. Βλέπετε να απεικονίζεται κάποιο 

καινούργιο επίπεδο πληροφορίας; Όχι. Γιατί συμβαίνει αυτό, εφόσον το επίπεδο 

πληροφορίας έχει δημιουργηθεί και μάλιστα υπάρχει και στο διαχειριστή επιπέδων 

πληροφορίας; Η απάντηση είναι απλή: διότι δεν έχουμε προσθέσει ακόμα κάποια 

γεωγραφική οντότητα. Αυτό θα γίνει μέσω της ψηφιοποίησης, που περιγράφεται σε 

επόμενο υποκεφάλαιο. 

 

 

Εικ. 3.27: Παρατηρήστε το διαχειριστή επιπέδων πληροφορίας. Έχει εμφανιστεί ένα νέο επίπεδο πληροφορίας που 
δημιουργήσατε, δηλαδή το Boreholes. Ωστόσο στο χάρτη δεν παρατηρείται καμία αλλαγή, γιατί ακόμα δεν έχουμε 
εισαγάγει κάποια γεωγραφική οντότητα στο επίπεδο πληροφορίας. 
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3.3 Σχεδιασμός πίνακα περιγραφικών χαρακτηριστικών 

Όπως είπαμε, ένα διανυσματικό επίπεδο πληροφορίας περιλαμβάνει τόσο 

γεωγραφική όσο και περιγραφική πληροφορία. Κατά συνέπεια, θα πρέπει να 

σχεδιαστεί η βάση δεδομένων και έφτασε η στιγμή να το μάθουμε και αυτό. Στα 

πλαίσια της άσκησής σας, αυτό θα γίνει αρχικά για το επίπεδο πληροφορίας Boreholes. 

Ακολουθήστε τα εξής βήματα: 

▪ Βήμα 1: Ανοίξτε τον πίνακα περιγραφικών χαρακτηριστικών 

Ανοίξτε τον πίνακα περιγραφικών χαρακτηριστικών μέσω του Catalog, με δεξί κλικ 

στο αντίστοιχο επίπεδο πληροφορίας και επιλέγοντας Data Design, και στη συνέχεια 

Fields  (Εικ. 3.28). Ενεργοποιείται το ομώνυμο παράθυρο Fields (Εικ. 3.38), που 

εμφανίζει τη μορφή του πίνακα περιγραφικών χαρακτηριστικών. Τα πεδία (Field 

Name) FID και Shape δημιουργούνται αυτόματα από το λογισμικό και δε μπορούμε να 

τα τροποποιήσουμε. Το πεδίο FID αποτυπώνει τον αύξοντα αριθμό της εκάστοτε 

οντότητας που εισάγεται στο αρχείο. Το πεδίο Shape αφορά στη γεωμετρία των 

οντοτήτων, που δέχεται το επίπεδο πληροφορίας, η οποία στη συγκεκριμένη περίπτωση 

είναι σημειακή (point). Το πεδίο Id μπορεί να χρησιμοποιηθεί ως έχει ή ακόμα και να 

τροποποιηθεί ανάλογα με τα περιγραφικά δεδομένα που θα χρειαστεί να 

συμπληρωθούν και αποτελεί ένα πεδίο με μορφή μεγάλου ακέραιου αριθμού. Τα δύο 

πρώτα διαχειρίζονται από το σύστημα, ενώ το τρίτο δίδεται προς χρήση ανάλογα με τις 

ανάγκες του χρήστη. 
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Εικ. 3.28: Από τον Catalog, με δεξί κλικ στο επίπεδο πληροφορίας που μας ενδιαφέρει και επιλέγοντας Design και 
στη συνέχεια Fields, γίνεται η σχεδίαση ή/και η τροποποίηση της δομής του πίνακα περιγραφικών χαρακτηριστικών. 

 

 

Εικ. 3.29: Η δομή της βάσης δεδομένων του επιπέδου πληροφορίας Boreholes, όπως εμφανίστηκε μέσω της εντολής 
Fields. 
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▪ Βήμα 2: Δημιουργήστε τα δικά σας πεδία στη βάση δεδομένων 

Για την προσθήκη ενός πεδίου, για παράδειγμα το όνομα της κάθε γεωγραφικής 

οντότητα– του επιπέδου πληροφορίας - Name, πρέπει να επιλέξετε πάνω στο πεδίο  

 ή το εργαλείο Add Field . Από τη στήλη Data Type 

(Εικ. 3.30) μπορείτε να επιλέξετε τον τύπο της πληροφορίας που θα περιέχει το πεδίο 

της βάσης δεδομένων. Οι επιλογές που δίνονται είναι: αριθμητικό πεδίο για μικρούς 

ακέραιους αριθμούς (Short), αριθμητικό πεδίο για μεγάλους ακέραιους αριθμούς 

(Long), αριθμητικό πεδίο για στρογγυλοποιημένους ακεραίους αριθμούς (Float), 

αριθμητικό πεδίο για δεκαδικούς αριθμούς με απεριόριστα δεκαδικά ψηφία (Double), 

πεδίο μόνο για χαρακτήρες όπως γράμματα, αριθμούς, σύμβολα κ.ά. (Text) και πεδίο 

για την εισαγωγή ημερομηνίας ή ώρας (Date). 

Για την άσκησή σας θα πρέπει να δώσετε ονομαστική πληροφορία στην κάθε 

γεώτρηση. Άρα, το Data Type θα οριστεί ως Text (Εικ. 3.8). Από τη στήλη Length 

καθορίζετε τον αριθμό των χαρακτήρων που θα δέχεται το πεδίο που δημιουργήσατε.  

 

 

Εικ. 3.31: Μπορείτε να τροποποιήσετε τη δομή της περιγραφικής πληροφορίας και να εισαγάγετε νέα πεδία 
καθορίζοντας τα χαρακτηριστικά τους μέσω της εντολής Field. Ο τύπος του κάθε πεδίου είναι συγκεκριμένος και δεν 
μπορεί να τροποποιηθεί εάν αποθηκεύσετε τη βάση δεδομένων. Οι επιλογές που σας δίνονται είναι: Short και Long 

για μικρούς και μεγάλους ακεραίους αριθμούς αντίστοιχα, Float για στρογγυλοποιημένους ακεραίους αριθμούς, 
Double για δεκαδικούς, Text για ελεύθερο κείμενο με χαρακτήρες και Date για ημερομηνία ή ώρα. 
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▪ Βήμα 3: Αποθηκεύστε τη δομή της βάσης δεδομένων σας 

Η αποθήκευση της δομής της βάσης δεδομένων σηματοδοτεί και την ολοκλήρωση 

της διαδικασίας σχεδιασμού του πίνακα περιγραφικών χαρακτηριστικών του επιπέδου 

πληροφορίας. Αποθηκεύστε τις τροποποιήσεις που έχετε κάνει στη βάση δεδομένων 

επιλέγοντας το Save (Fields → Changes → Save). Εναλλακτικά, μπορείτε να επιλέξετε 

να κλείσετε της καρτέλα σχεδιασμού της βάσης δεδομένων, τότε θα σας ζητήσει το 

σύστημα εάν επιθυμείτε να αποθηκεύσετε τις αλλαγές σας. 

 

3.4 Ψηφιοποίηση δεδομένων 

Έχετε πλέον δημιουργήσει το επίπεδο πληροφορίας και έχετε σχεδιάσετε τη βάση 

δεδομένων του. Παρατηρήστε ότι ο χάρτης σας εξακολουθεί να μην περιέχει 

γεωγραφικά δεδομένα. Είναι άδειος, το ίδιο και η βάση δεδομένων του επιπέδου. 

Δηλαδή, και ο πίνακας περιγραφικών δεδομένων, ενώ του δημιουργήσατε πεδία, 

εξακολουθεί να μην έχει εγγραφές. Πώς εισάγονται όμως οι πληροφορίες;  

Ο συνηθέστερος τρόπος εισαγωγής διανυσματικών δεδομένων είναι η 

ψηφιοποίηση. Για όλα τα είδη πληροφορίας (σημεία, γραμμές ή πολύγωνα), η 

ψηφιοποίηση γίνεται μέσω της εργαλειοθήκης Editor, με τον τρόπο που περιγράφεται 

παρακάτω. 

 

3.4.1 Ψηφιοποίηση σημειακών δεδομένων (Point) 

Παρακάτω θα δούμε τα βήματα που πρέπει να ακολουθήσουμε προκειμένου να 

ψηφιοποιήσουμε σημειακά δεδομένα.  

▪ Βήμα 1: Γεωαναφορά Raster 

Για την άσκησή σας, θα εισαγάγετε στο Project σας το χάρτη test_map2.tif, 

δημιουργώντας πυραμίδες (βλ. υποκεφ. 3.1). Επίσης, θα γεωαναφέρετε το χάρτη αυτόν 

στο σύστημα Greek Grid (Projected Coordinate System → National Grids → Europe 

→ Greek Grid) και θα τον αποθηκεύσετε σε μορφή .tiff (βλ. υποκεφ. 3.1).  
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▪ Βήμα 2: Ενέργειες πριν την ψηφιοποίηση 

Για να αρχίσει η διαδικασία της ψηφιοποίησης των γεωτρήσεων Boreholes, πρέπει 

να είναι ενεργοποιημένα στο λογισμικό το επίπεδο πληροφορίας Boreholes και το 

ψηφιδωτό αρχείο raster test_map2.tif που γεωαναφέρθηκε προηγουμένως. Στην 

περίπτωση που δεν είναι ενεργοποιημένα, μπορούν να ενεργοποιηθούν μέσω του 

εργαλείου Add Data της ομάδας εργαλείων Layer, από το μενού Map (για την εισαγωγή 

δεδομένων, βλ. υποκεφ. 2.3.1).  

Στο μενού Edit και στην ομάδα εργαλείων Features, επιλέγετε το εργαλείο Create 

 (Εικ. 3.32). Θα ενεργοποιηθεί το παράθυρο Create Features, από όπου θα 

καθοριστούν οι επιμέρους λεπτομέρειες της ψηφιοποίησης που θα λάβει χώρα. Από 

την καρτέλα Templates θα επιλεγεί το επίπεδο πληροφορίας Boreholes που θα 

ψηφιοποιηθεί, δηλαδή το Boreholes (Εικ. 3.33). Τώρα, μπορείτε να δημιουργήσετε ένα 

σημείο μέσω του εργαλείου Point , ένα σημείο στο τέλος μίας γραμμής μέσω του 

εργαλείου Point At End of Line  ή ένα σημείο κατά μήκος μίας γραμμής μέσω του 

εργαλείου Create Points Along Line  (Εικ. 3.34). Πριν ξεκινήσει η ψηφιοποίηση, 

καλό θα ήταν να μεγεθύνετε το χάρτη στην περιοχή που θα ψηφιοποιήσετε. 

 

 

Εικ. 3.32: Το εργαλείο Create βρίσκεται στην ομάδα εργαλείων Features, στο μενού Edit. Μέσω αυτού, μπορείτε να 
εισαγάγετε στο λογισμικό τις γεωγραφικές οντότητες του επιπέδου πληροφορίας που ψηφιοποιείτε.  
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▪ Βήμα 3: Ψηφιοποίηση 

Επιλέξτε το εργαλείο Point για να ξεκινήσετε τη διαδικασία και την καταχώριση 

ενός σημείου με αριστερό κλικ στην αντίστοιχη θέση. Στο παράθυρο Create Features 

εμφανίζεται ένα μήνυμα που γνωστοποιεί ότι το σημείο δημιουργήθηκε με επιτυχία 

(Εικ. 3.35).  

 

 

Εικ. 3.33: Στο αναδυόμενο παράθυρο Create Features και στην καρτέλα Templates επιλέξτε το επίπεδο πληροφορίας 
«Boreholes», στο οποίο θα εισαχθεί νέα πληροφορία μέσω ψηφιοποίησης. 

 

 

Εικ. 3.34: Για την ψηφιοποίηση του επιπέδου πληροφορίας των γεωτρήσεων (Boreholes), επιλέξτε το κατάλληλο 
εργαλείο ανάμεσα στα Point, Point At End of Line και Create Points Along Line. 
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Εικ. 3.35: Κατά την ψηφιοποίηση ενός σημείου, το λογισμικό ενημερώνει το χρήστη για την επιτυχή εισαγωγή του 

μέσω του μηνύματος «Create Features completed». 

 

▪ Βήμα 4: Ενημέρωση βάσης δεδομένων 

Ενεργοποιώντας τον πίνακα περιγραφικών χαρακτηριστικών από το διαχειριστή 

επιπέδων πληροφορίας (βλ. υποκεφ. 3.3), μπορείτε να εισαγάγετε τις πληροφορίες που 

αφορούν στην εκάστοτε γεωγραφική οντότητα. Επιλέγοντας την εντολή Open the 

active template pane , θα ενεργοποιηθεί η καρτέλα Active Template, όπου θα 

συμπληρώσετε στο πεδίο Name το όνομα της γεώτρησης (Εικ. 3.36). Η αποθήκευση 

της εργασίας γίνεται μέσω της επιλογής Finish  και έπειτα Save. Καλό θα είναι 

ανά τακτά χρονικά διαστήματα να αποθηκεύ3ετε τις τροποποιήσεις που κάνετε. 
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Εικ. 3.36: Μετά την εισαγωγή του σημείου ενημερώνετε το πεδίο Name του πίνακα περιγραφικών χαρακτηριστικών 
με το όνομα της γεώτρησης. 

 

3.4.2 Ψηφιοποίηση γραμμικών δεδομένων (Polyline) 

Μέσω του εργαλείου Add Folder  γίνεται και πάλι η σύνδεση με το φάκελο 

στον οποίον θα γίνουν οι ακόλουθες εργασίες (για τη σύνδεση του φακέλου με το 

Project, βλ. υποκεφ. 1.3.4). Από τον Catalog, με δεξί στο φάκελο αυτό, κάνετε κλικ 

στην εντολή New  και επιλέγετε Shapefile , για να δημιουργηθεί ένα νέο 

επίπεδο πληροφορίας. Στο παράθυρο διαλόγου Create Feature Class, μέσω της 

καρτέλας Parameters, θα καθορίσετε το όνομα του επιπέδου πληροφορίας από το πεδίο 

Feature Class Name. Στη συγκεκριμένη περίπτωση, το όνομα θα είναι Contours (Εικ. 

3.37). Στο πεδίο Geometry Type, αφού θέλουμε να ψηφιοποιήσουμε ισοϋψείς 

καμπύλες, θα επιλέξουμε το Polyline (Εικ. 3.37). Τέλος, μέσω του πεδίου Coordinate 

System, θα ορίσουμε το προβολικό σύστημα, το οποίο στη συγκεκριμένη περίπτωση 

θα είναι το Greek Grid (Projected Coordinate System → National Grids → Europe → 

Greek Grid) (Εικ. 3.14). Ολοκληρώνετε τη δημιουργία του επιπέδου πληροφορίας 

επιλέγοντας Run. Όταν δημιουργηθεί το επίπεδο πληροφορίας θα εμφανιστεί στον 

διαχειριστή επιπέδων πληροφορίας.  

Στον πίνακα περιγραφικών χαρακτηριστικών, μέσω της εντολής Click here to add a 

new field  ή μέσω του εργαλείου New Field , μπορεί να 
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προστεθεί ένα νέο πεδίο (βλ. και υποκεφ. 3.3). Στη συγκεκριμένη περίπτωση, θα 

προσθέσουμε το πεδίο Altitude (υψόμετρο), στο οποίο θα καταχωρηθεί η πληροφορία 

του υψομέτρου για την κάθε ισοϋψή καμπύλη. Στη συνέχεια, θα καθορίσουμε το είδος 

της πληροφορίας που θα δέχεται το πεδίο που μόλις δημιουργήθηκε. Για αυτόν το 

σκοπό, μέσω του πεδίου Data Type επιλέγουμε μέσα από το combo box το κατάλληλο 

είδος που θα έχει το πεδίο Altitude (βλ. και υποκεφ. 3.3). Για τη συγκεκριμένη 

περίπτωση, εφόσον πρόκειται για υψόμετρο, το πεδίο θα δέχεται μικρούς ακεραίους, 

οπότε θα επιλέξουμε το Short. Η δημιουργία του επιπέδου πληροφορίας 

ολοκληρώνεται μετά τη σχεδίαση της βάσης δεδομένων επιλέγοντας από το μενού 

Fields και την ομάδα εργαλείων Changes το εργαλείο Save. 

 

 

Εικ. 3.371: Μέσω του παραθύρου διαλόγου Create Feature Class συμπληρώνονται τα πεδία Feature Class Name με 
το όνομα του επιπέδου πληροφορίας (εδώ: Contours), Geometry Type (εδώ: polyline) και Coordinate System (εδώ: 
Projected Coordinate System → National Grids → Europe → Greek Grid). Όταν έχετε εισαγάγει όλα τα παραπάνω, 
επιλέξτε την εντολή Run προκειμένου να δημιουργηθεί το νέο επίπεδο πληροφορίας. 
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Αφού έχει δημιουργηθεί το επίπεδο πληροφορίας και έχει σχεδιαστεί και ο πίνακας 

περιγραφικών χαρακτηριστικών, έφτασε η ώρα να εισαγάγουμε τη γεωγραφική 

πληροφορία. Η εισαγωγή της θα γίνει μέσω ψηφιοποίησης και για το σκοπό αυτό θα 

χρησιμοποιήσουμε το εργαλείο Create στο μενού Edit και στην ομάδα εργαλείων 

Features (Εικ. 3.32). Στο αναδυόμενο παράθυρο Create Features, μέσω της καρτέλας 

Templates, επιλέξτε το επίπεδο πληροφορίας Contours στο οποίο θα λάβει χώρα η 

ψηφιοποίηση (Εικ. 3.38).  

 

 

Εικ. 3.38: Στο αναδυόμενο παράθυρο Create Features στην καρτέλα Templates επιλέγετε το επίπεδο πληροφορίας στο 
οποίο θα λάβει χώρα η ψηφιοποίηση. 

 

Κατά την επιλογή του, μπορείτε να δημιουργήσετε (Εικ. 3.39) μια γραμμή μέσω του 

εργαλείου Line , μια γραμμή σε ορθή γωνία μέσω του εργαλείου Right Angle Line 

, γραμμές σε ακτινωτή διάταξη μέσω του εργαλείου Radial , μία γραμμή δύο 

σημείων μέσω του εργαλείου Two-Point Line , ένα γραμμικό στοιχείο σε κυκλικό 

σχήμα μέσω του εργαλείου Circle , ένα γραμμικό στοιχείο σε ορθογώνιο σχήμα 

μέσω του εργαλείου Rectangle , ένα γραμμικό στοιχείο σε ελλειπτικό σχήμα μέσω 

του εργαλείου Ellipse , ένα γραμμικό στοιχείο με ελεύθερη σχεδίαση με το χέρι 

μέσω του εργαλείου Freehand , ένα γραμμικό τμήμα που ακολουθεί ένα υπάρχον 
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χαρακτηριστικό μέσω του εργαλείου Trace  και μία κυματιστή γραμμή μέσω του 

εργαλείου Stream , ή ακόμα και να διαιρέσετε μια υπάρχουσα γραμμή μέσω του 

εργαλείου Split . 

 

 

Εικ. 3.39: Για την ψηφιοποίηση των γραμμικών στοιχείων του επιπέδου πληροφορίας Contours, μπορείτε να 
χρησιμοποιήσετε κάποιο από τα εργαλεία δημιουργίας γραμμικών στοιχείων, που, με τη σειρά που φαίνονται στην 
Εικόνα, είναι: Line, Right Angle Line, Split, Radial, Two-Point Line, Freehand και Trace.  

 

Σε αυτό το σημείο θα πρέπει να μεγεθύνετε το χάρτη στην περιοχή που θα 

ψηφιοποιηθεί και με τη χρήση του εργαλείου Line μπορείτε να ψηφιοποιήσετε τις 

ισοϋψείς καμπύλες (Εικ. 3.39). Κάθε γραμμή αρχίζει να καταχωρείται με αριστερό 

κλικ. Στην ουσία, κάνοντας αριστερό κλικ, δημιουργείτε έναν κόμβο (node). Αν 

δημιουργήσετε έναν δεύτερο σε κάποια άλλη θέση του χάρτη, θα παρατηρήσετε ότι 

μεταξύ των δύο κόμβων έχει δημιουργηθεί μία ευθεία γραμμή. Επαναλάβετε αυτήν την 

διαδικασία έως ότου σχεδιάσετε ολόκληρη τη γραμμή που επιθυμείτε να 

ψηφιοποιήσετε.  
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Η αποθήκευση της εισαγωγής διανυσματικών δεδομένων που έλαβε χώρα γίνεται 

μέσω της επιλογής Finish  Εναλλακτικά, όταν ολοκληρώσετε το σχεδιασμό, τον 

τελευταίο κόμβο θα τον εισαγάγετε κάνοντας δύο φορές αριστερό κλικ, ώστε να 

ολοκληρωθεί η ψηφιοποίηση. Στο παράθυρο Create Features εμφανίζεται ένα μήνυμα 

που γνωστοποιεί ότι το γραμμικό στοιχείο δημιουργήθηκε με επιτυχία. Στη συνέχεια, 

επιλέγετε την εντολή Save ώστε να αποθηκευτούν οι γεωγραφικές οντότητες που 

εισαγάγατε μέσω της ψηφιοποίησης. Καλό θα ήταν ανά τακτά χρονικά διαστήματα να 

αποθηκεύετε οι τροποποιήσεις που κάνετε.  

Για την εισαγωγή της περιγραφικής πληροφορίας για κάθε γεωγραφική οντότητα, 

θα χρειαστεί να ενεργοποιηθεί ο πίνακας περιγραφικών χαρακτηριστικών. Αυτό μπορεί 

να γίνει με διάφορους τρόπους, όπως μέσω της επιλογής Open the active template pane 

, οπότε ενεργοποιείται η ομώνυμη καρτέλα Active Template, όπου θα συμπληρωθεί 

στο πεδίο Altitude το υψόμετρο για κάθε ισοϋψή καμπύλη (βλ. και υποκεφ. 3.3 και 

3.4.1).  

 

3.4.3 Ψηφιοποίηση πολυγωνικών δεδομένων (Polygon) 

Μέσω του εργαλείου Add Folder  γίνεται και πάλι η διασύνδεση με το φάκελο 

στον οποίον θα γίνουν οι ακόλουθες εργασίες (βλ. υποκεφ. 1.3.4). Όντας στο φάκελο 

αυτό, στο Catalog, με δεξί κλικ και επιλογή της εντολής New , επιλέγετε Shapefile 

, για να δημιουργηθεί ένα νέο επίπεδο πληροφορίας. Στο παράθυρο διαλόγου 

Create Feature Class, μέσω της καρτέλας Parameters, καθορίζετε το όνομα του 

επιπέδου πληροφορίας μέσω του πεδίου Feature Class Name. Στη συγκεκριμένη 

περίπτωση, το όνομα θα είναι Geology (Εικ. 3.40). Αφού το επίπεδο πληροφορίας μας 

θα περιέχει γεωλογικούς σχηματισμούς, το Geometry Type θα είναι Polygon (Εικ. 

3.40). Τέλος, μέσω του πεδίου Coordinate System θα οριστεί το προβολικό σύστημα, 

το οποίο στη συγκεκριμένη περίπτωση θα είναι το Greek Grid (Projected Coordinate 

System → National Grids → Europe → Greek Grid) (Εικ. 3.40). Στη συνέχεια, μέσω 

της εντολής Run θα δημιουργηθεί το επίπεδο πληροφορίας  με τα χαρακτηριστικά 
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που καθορίστηκαν προηγουμένως. Για τα βήματα αυτά αναλυτικότερα, βλ. υποκεφ. 

3.3). 

 

 

Εικ. 3.40: Μέσω του παραθύρου διαλόγου Create Feature Class συμπληρώνονται τα πεδία Feature Class Name με 
το όνομα του επιπέδου πληροφορίας (εδώ: Name), Geometry Type (εδώ: polygon) και Coordinate System (εδώ: 
Projected Coordinate System → National Grids → Europe → Greek Grid). Όταν έχετε εισαγάγει όλα τα παραπάνω, 
επιλέξτε την εντολή Run προκειμένου να δημιουργηθεί το νέο επίπεδο πληροφορίας. 

 

Μέσω της εντολής Click here to add a new field  ή μέσω 

του εργαλείου New Field , μπορείτε να προσθέσετε ένα νέο πεδίο στον πίνακα 

περιγραφικών χαρακτηριστικών. Στη συγκεκριμένη περίπτωση, θα προστεθεί το πεδίο 

Name, στο οποίο θα καταχωρηθεί το είδος του γεωλογικού σχηματισμού για κάθε 

πολυγωνική γεωγραφική οντότητα. Στη συνέχεια, θα πρέπει να καθοριστεί το είδος της 

πληροφορίας που θα δέχεται το πεδίο που μόλις δημιουργήθηκε. Για αυτό το σκοπό, 

μέσω του πεδίου Data Type, επιλέγετε μέσα από το combo box το κατάλληλο είδος, 

που για τη συγκεκριμένη περίπτωση είναι το Text. Η δημιουργία του επιπέδου 
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πληροφορίας ολοκληρώνεται μετά τη σχεδίαση της βάσης δεδομένων, επιλέγοντας το 

εργαλείο Save της ομάδας εργαλείων Changes (μενού Fields). 

Αφού έχει δημιουργηθεί το επίπεδο πληροφορίας και έχει σχεδιαστεί και ο πίνακας 

περιγραφικών χαρακτηριστικών (βλ. υποκεφ. 3.3), έφτασε η ώρα να εισαχθεί η 

γεωγραφική πληροφορία. Η εισαγωγή των γεωγραφικών πληροφοριών θα γίνει μέσω 

ψηφιοποίησης και για το σκοπό αυτό θα χρησιμοποιηθεί από το μενού Edit και την 

ομάδα εργαλείων Features το εργαλείο Create (Εικ. 3.41). Στο αναδυόμενο παράθυρο 

Create Features, μέσω της καρτέλας Templates, επιλέγετε το επίπεδο πληροφορίας 

Geology στο οποίο θα λάβει χώρα η ψηφιοποίηση (Εικ. 3.41).  

 

 

Εικ. 3.412: Στο παράθυρο Create Features, μέσω της καρτέλας Templates, επιλέγετε το επίπεδο πληροφορίας 
Geology, όπου θα εισαχθούν νέες οντότητες μέσω ψηφιοποίησης. 

 

Κατά την επιλογή του Geology, μπορείτε να δημιουργήσετε ένα πολύγωνο 

εισάγοντας κόμβους μέσω του εργαλείου Polygon  ή ένα πολύγωνο που θα έχει 

κοινή πλευρά με ένα γειτονικό πολύγωνο (ώστε να μην είναι απαραίτητη η 

ψηφιοποίηση της κοινής πλευράς για δεύτερη φορά) μέσω του εργαλείου Autocomplete 

Polygon  (Εικ. 3.42). Μέσω του Autocomplete Polygon ψηφιοποιούνται οι μη 
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εφαπτόμενες πλευρές και ο πρώτος και ο τελευταίος κόμβος του πολυγώνου 

χρησιμοποιούνται για τον καθορισμό της εφαπτόμενης πλευράς. Επίσης, μπορείτε να 

δημιουργήσετε ένα πολύγωνο με ορθές γωνίες μέσω του εργαλείου Right Angle 

Polygon , ένα πολύγωνο με κυκλικό σχήμα μέσω του εργαλείου Circle , ένα 

πολύγωνο με ορθογώνιο σχήμα μέσω του εργαλείου Rectangle , ένα πολύγωνο με 

ελλειπτικό σχήμα μέσω του εργαλείου Ellipse , ένα πολύγωνο με ελεύθερη 

σχεδίαση με το χέρι μέσω του εργαλείου Freehand , ένα πολύγωνο με ελεύθερη 

σχεδίαση με το χέρι το οποίο έχει κοινή πλευρά με ένα γειτονικό πολύγωνο μέσω του 

εργαλείου Autocomplete Freehand Polygon , μία πολυγωνική οντότητα που 

ακολουθεί ένα υπάρχον χαρακτηριστικό μέσω του εργαλείου Trace , ένα 

πολύγωνο με κυματιστές πλευρές μέσω του εργαλείου Stream , μία δομή μέσω του 

εργαλείου Create Structures  και ένα διαφορικό πολύγωνο μέσω του εργαλείου 

Difference Polygon  (Εικ. 3.42).  

Σε αυτό το σημείο θα πρέπει να μεγεθύνετε το χάρτη στην περιοχή που θα 

ψηφιοποιηθεί και με τη χρήση του εργαλείου Polygon μπορείτε να ψηφιοποιήσετε τα 

πολύγωνα της γεωλογίας. Κάθε πολύγωνο αρχίζει να καταχωρείται με αριστερό κλικ.  

 

 

 



Γ. Σ. Π. – ArcGIS Pro – ΣΗΜΕΙΩΣΕΙΣ ΕΡΓΑΣΤΗΡΙΟΥ 

82 

 

 

Εικ. 3.42: Οι επιλογές ψηφιοποίησης για το επίπεδο πληροφορίας Geology (πολυγωνικό). Με τη σειρά που 

εμφανίζονται στην Εικόνα: Geology: Polygon, Autocomplete Polygon, Right Angle Polygon, Circle, Rectangle, 

Ellipse, Freehand, Autocomplete Freehand Polygon, Trace, Stream, Create Structures και Difference Polygon. 

 

Στο παράθυρο Create Features εμφανίζεται ένα μήνυμα που γνωστοποιεί ότι το 

πολυγωνικό στοιχείο δημιουργήθηκε με επιτυχία. 

Για την εισαγωγή της περιγραφικής πληροφορίας για κάθε γεωγραφική οντότητα 

που εισάγεται, θα χρειαστεί να ενεργοποιηθεί ο πίνακας περιγραφικών 

χαρακτηριστικών. Αυτό μπορεί να γίνει με διάφορους τρόπους, όπως μέσω της 

επιλογής Open the active template pane , οπότε ενεργοποιείται η ομώνυμη 

καρτέλα Active Template, όπου θα συμπληρωθεί στο πεδίο Name η λιθολογία για κάθε 

σχηματισμό. Η ολοκλήρωση της εισαγωγής διανυσματικών δεδομένων που έλαβε 

χώρα γίνεται μέσω της επιλογής Finish . Εναλλακτικά, όταν ολοκληρώσετε το 

σχεδιασμό, τον τελευταίο κόμβο θα τον εισαγάγετε κάνοντας δύο φορές αριστερό κλικ, 

ώστε να ολοκληρωθεί η ψηφιοποίηση. Στο παράθυρο Create Features εμφανίζεται ένα 

μήνυμα που γνωστοποιεί ότι το πολυγωνικό στοιχείο δημιουργήθηκε με επιτυχία. Στη 
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συνέχεια, επιλέγετε την εντολή Save ώστε να αποθηκευτούν οι γεωγραφικές οντότητες 

που εισαγάγατε μέσω της ψηφιοποίησης. Καλό θα ήταν ανά τακτά χρονικά διαστήματα 

να αποθηκεύετε οι τροποποιήσεις που κάνετε.  

 

3.4.4 Εντολή Clip Polygon  

Καθώς θα ψηφιοποιείτε τα πολύγωνα της γεωλογίας, θα παρατηρήσετε ότι κάποια 

πολύγωνα εμπεριέχονται εξ ολοκλήρου σε κάποια άλλα. Αν λοιπόν επιλέξετε μέσω του 

εργαλείου Select (Edit → Selection → Select) το εσωτερικό πολύγωνο, θα δείτε ότι το 

λογισμικό σάς δίνει τη δυνατότητα να επιλέξετε είτε το εσωτερικό είτε το εξωτερικό. 

Με άλλα λόγια, παρ’ όλο που το εσωτερικό πολύγωνο χαρακτηρίζει έναν διαφορετικό 

γεωλογικό σχηματισμό από ό,τι το εξωτερικό, το λογισμικό θεωρεί ότι το εσωτερικό 

πολύγωνο είναι τμήμα του εξωτερικού. 

Πρέπει λοιπόν να διαχωρίσουμε το εσωτερικό από το εξωτερικό πολύγωνο. Για να 

γίνει αυτό, στο μενού Edit και στην ομάδα εργαλείων Features, ενεργοποιούμε το 

εργαλείο Modify . Στο αναδυόμενο παράθυρο διαλόγου Modify Features (Εικ. 

3.43), στην καρτέλα All Tools, εντοπίζεται το εργαλείο Clip (All Tools → Divide → 

Clip) (Εικ. 3.44).  
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Εικ. 3.43: Στο παράθυρο διαλόγου Modify Features και στην καρτέλα All Tools υπάρχουν οι διαθέσιμες ομάδες 
εργαλείων. Για τη συγκεκριμένη άσκηση, θα μεταβούμε στην ομάδα εργαλείων Divide. 
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Εικ. 3.44: Το εργαλείο Clip, το οποίο εντοπίζεται στην ομάδα εργαλείων Divide, θα το χρησιμοποιήσουμε προκειμένου 
να διαχωρίσουμε δύο πολύγωνα εκ των οποίων το ένα εμπεριέχεται στο άλλο. 

 

Με την επιλογή του Clip, ενεργοποιείται το ομώνυμο παράθυρο διαλόγου Clip (Εικ. 

3.45), στο οποίο θα καθορίσετε το τμήμα του πολυγώνου που θα αποκοπεί. Έχετε την 

επιλογή να αφαιρέσετε την κοινή περιοχή μέσω της επιλογής Discard (Remainder) 

(Discard the area that intersects) (Εικ. 3.45), να διατηρήσετε μόνο την κοινή περιοχή 

μέσω της επιλογής Preserve (Preserve the area that intersects) (Εικ. 3.45), ή να 

διαχωρίσετε και να διατηρήσετε τις δύο περιοχές μέσω της επιλογής Split (Preserve 

both areas) (Εικ. 3.45).  

Σε κάθε περίπτωση, ορίζετε το Buffer Distance, δηλαδή τη ζώνη γύρω από το όριο 

που θα γίνει το Clip (Εικ. 3.45). Στα πλαίσια της άσκησης, το πολύγωνο των 

κροκαλοπαγών εμπεριέχει ένα πολύγωνο μικρής εμφάνισης ασβεστολίθων (εσωτερικό 

πολύγωνο). Με το εργαλείο Select (Edit → Selection → Select), επιλέγεται το 

πολύγωνο των ασβεστολίθων. Καθώς το πολύγωνο είναι επιλεγμένο, μέσω του 

εργαλείου Clip αφαιρείται η επιλεγμένη περιοχή. Στο παράθυρο διαλόγου, για τις 
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ανάγκες της άσκησης, επιλέγεται ως Buffer Distance η τιμή μηδέν και αφαιρείται η 

κοινή περιοχή με την επιλογή Discard (Remainder) (Εικ. 3.45). 

 

 

Εικ. 3.45: Στο παράθυρο διαλόγου Clip, δίνονται οι επιλογές Discard (Remainder), Preserve, Contain και Split. 

Μπορεί επίσης να οριστεί η ζώνη επιρροής του Clip (Buffer Distance). Για την άσκησή σας, θα επιλέξετε Discard 

(Remainder), ώστε να αφαιρέσετε από το εξωτερικό πολύγωνο την κοινή περιοχή. Στο Buffer Distance θα επιλέξετε 
την τιμή μηδέν. Τέλος, θα επιλέξετε την εντολή Clip ώστε να εκτελεστεί η διαδικασία. 
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3.5 Εισαγωγή δεδομένων από προϋπάρχουσα βάση δεδομένων 

Εκτός από το να ψηφιοποιήσουμε από την αρχή ένα επίπεδο πληροφορίας (βλ. 

υποκεφ. 3.4), μπορούμε να εισαγάγουμε ένα σημειακό επίπεδο πληροφορίας μέσω μιας 

ήδη υπάρχουσας βάσης δεδομένων, στην οποίαν ωστόσο θα πρέπει απαραίτητα να 

υπάρχουν γνωστές συντεταγμένες. Μία τέτοια βάση δεδομένων μπορεί να είναι ένα 

φύλλο από το γνωστό λογισμικό Excel. Ωστόσο, θα πρέπει υποχρεωτικά το φύλλο να 

έχει ένα πεδίο για το γεωγραφικό μήκος της κάθε οντότητας και άλλο ένα για το 

γεωγραφικό πλάτος της. Δεν είναι απαραίτητο να τοποθετηθούν με αυτήν την σειρά ή 

να έχουν συγκεκριμένη ονομασία ως πεδία. Αυτό που είναι απαραίτητο είναι όλες οι 

συνταγμένες να αναφέρονται στο ίδιο προβολικό σύστημα (και να γνωρίζουμε ποιο 

είναι αυτό το προβολικό σύστημα). 

Στην άσκησή σας, στο αρχείο Earthquakes_2019-2020  εμπεριέχονται τα κύρια 

χαρακτηριστικά των σεισμών που έλαβαν χώρα την περίοδο 2019-2020 στον ελλαδικό 

χώρο. Μπορούμε να εισαγάγουμε το αρχείο αυτό μέσω του εργαλείου Add Data (βλ. 

υποκεφ. 2.3.1). Το αρχείο θα εμφανιστεί στο διαχειριστή επιπέδων πληροφορίας στην 

υποενότητα Standalone Tables, και όχι στην υποενότητα Map που εμφανίζονται τα 

υπόλοιπα επίπεδα πληροφορίας. Γιατί; Μα γιατί δεν περιέχει καμία χωρική 

πληροφορία ακόμη.  

Με δεξί κλικ πάνω στο αρχείο Earthquakes_2019-2020 επιλέγουμε την εντολή 

Display XY Data  (Εικ. 3.46). Εναλλακτικά, μπορεί να γίνει η ίδια διαδικασία μέσω 

του εργαλείου XY Point Data  από το combo box του Add Data (Εικ. 3.47). 
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Εικ. 3.46: Η εντολή Display XY Data εντοπίζεται με δεξί κλικ στο αρχείο Earthquakes_2019-2020 από το διαχειριστή 
επιπέδων πληροφορίας. 

 

Θα αναδυθεί το ομώνυμο παράθυρο (Display XY Data) (Εικ. 3.48). Από την 

καρτέλα Parameters, μέσω του πεδίου Input Table θα καθορίσουμε το αρχείο που θα 

εισαγάγουμε, δηλαδή το Earthquakes_2019-2020  και συγκεκριμένα το φύλλο 2010-

2020$ (Εικ. 3.48). Στο πεδίο Output Feature Class καθορίζουμε τη θέση του επιπέδου 

πληροφορίας που θα δημιουργηθεί και το όνομά του. Στα πεδία X Field και Y Field, 

συμπληρώνουμε τα πεδία από τα οποία θα αντληθούν το γεωγραφικό μήκος και το 

γεωγραφικό πλάτος, δηλαδή τα LON και LAT αντίστοιχα Τέλος, μέσω του πεδίου 

Coordinate System ορίζουμε το προβολικό σύστημα στο οποίο αντιστοιχούν οι 

συντεταγμένες που περιλαμβάνονται στον πίνακα. Στην προκειμένη περίπτωση θα 

χρησιμοποιηθεί το GCS_WGS_1984 (Geographic Coordinate System → World → 

GCS_WGS_1984) (Εικ. 3.48). 



Γ. Σ. Π. – ArcGIS Pro – ΣΗΜΕΙΩΣΕΙΣ ΕΡΓΑΣΤΗΡΙΟΥ 

89 

 

 

Εικ. 3.47: Το combo box του εργαλείο Add Data έχει πληθώρα υποεργαλείων, όπως το XY Point Data που θα 
χρησιμοποιηθεί στα πλαίσια της άσκησης. 
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Εικ. 3.48: Το παράθυρο διαλόγου Display XY Data (βλ. Εικ. 3.46). Εδώ, θα καθορίσουμε τον πίνακα που θέλουμε να 
εισαγάγουμε (Input Table), ο οποίος έχει εισαχθεί αυτόματα από το λογισμικό, τη θέση στην οποίαν θα αποθηκευτεί 
το νέο επίπεδο πληροφορίας (Output Feature Class), καθώς και το προβολικό του σύστημα (Coordinate System), που 
για την άσκησή σας θα είναι το Geographic Coordinate System → World → GCS_WGS_1984. Στο πεδίο X Field θα 
επιλέξουμε τη στήλη του πίνακα Earthquakes_2019-2020 που περιέχει το γεωγραφικό μήκος και στο Y Field τη στήλη 
που περιέχει το γεωγραφικό πλάτος. Μετά από αυτά, πιέζουμε ΟΚ. 

 

Στο αναδυόμενο παράθυρο XY Table To Point Data (Εικ. 3.49) στην καρτέλα 

Parameters συμπληρώνουμε κατά τα γνωστά, στο πεδίο Input Table το αρχείο 

Earthquakes_2019-2020, στο πεδίο Output Feature Class το όνομα του 

γεωαναφερμένου αρχείου που θα δημιουργηθεί, στο πεδίο X Field το πεδίο από το 

οποίο θα αντληθούν οι συντεταγμένες X, στη συγκεκριμένη περίπτωση LON, στο πεδίο 

Y Field το πεδίο από το οποίο θα αντληθούν οι συντεταγμένες Y, στη συγκεκριμένη 

περίπτωση LAT, και στο πεδίο Coordinate System το προβολικό σύστημα, στην 
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προκειμένη περίπτωση GCS_WGS_1984 (Geographic Coordinate System > World > 

WGS 1984) (Εικ. 3.27). 

Για τον ίδιο σκοπό μπορούν να χρησιμοποιηθούν τα εργαλεία Tools της ομάδας 

εργαλείων Geoprocessing. Στο ομώνυμο αναδυόμενο παράθυρο, στην καρτέλα 

Toolboxes, ενεργοποιείται το εργαλείο Coordinate Table To Point (Defense Tools > 

Conversion > Coordinate Table To Point).  
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Εικ. 3.37: Το παράθυρο διαλόγου XY Table To Point, το οποίο συμπληρώνετε με παρόμοιο τρόπο. 
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Ενότητα 4 - Ανάλυση γεωγραφικών δεδομένων 
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4.2 Ανάλυση δεδομένων 

Η ανάλυση των γεωγραφικών δεδομένων αποτελεί το σημαντικότερο πλεονέκτημα 

των GIS σε σχέση με οποιοδήποτε άλλο εργαλείο χαρτογράφησης. Σε ένα GIS, για 

παράδειγμα, σε ένα επίπεδο πληροφορίας, μπορούμε να αναλύσουμε την περιγραφική 

πληροφορία που είναι αποθηκευμένη στον πίνακα περιγραφικών χαρακτηριστικών, τη 

γεωγραφική πληροφορία ή και τα δύο. Οι μέθοδοι που θα εφαρμόσουμε εξαρτώνται 

από τα δεδομένα μας, καθώς επίσης και από τη φύση και το στόχο της έρευνάς μας. 

Ακολούθως αναφέρονται τα βασικότερα εργαλεία που μπορούμε να 

χρησιμοποιήσουμε για μία πρώτη ανάλυση των δεδομένων μας. 

 

4.2.1 Εύρεση αντικειμένων (Locate)  

Η εύρεση αντικειμένων (Locate)  είναι η απλούστερη μέθοδος γεωγραφικής 

ανάλυσης. Μπορούμε να εντοπίσουμε και να επιλέξουμε ένα αντικείμενο με βάση 

κάποια περιγραφική πληροφορία του, που είναι αποθηκευμένη στη βάση δεδομένων 

του επιπέδου πληροφορίας. Για παράδειγμα, μπορούμε να εντοπίσουμε όλες τις 

ισοϋψείς καμπύλες που έχουν υψόμετρο 150 m. 

Για να γίνει αυτό, μεταβείτε στο μενού Map, στην καρτέλα Inquiry και στο εργαλείο 

Locate. Από τις επιλογές που σας δίνει, χρησιμοποιήστε το Search  (Εικ. 4.1). 

Ενεργοποιείται το ομώνυμο παράθυρο διαλόγου Locate. Θα επιλέξετε το εικονίδιο 

ακριβώς από το «Locate» και στη συνέχεια την επιλογή Provider Settings (Εικ. 4.2). 

Θα χρειαστεί να κάνετε αποεπιλογή των παρόχων Rivers, ArcGIS World Geocoding 

Service και XY provider, στους οποίους θα γίνει αναζήτηση των χαρακτηριστικών. 

Διαφορετικά, η αναζήτηση θα γίνει στο σύνολο των διαδικτυακών δεδομένων της 

ArcGIS. 
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Εικ. 4.1: Το εργαλείο Search θα το βρείτε ακολουθώντας το path: Map → Inquiry → Locate → Search. 

 

 

Εικ. 4.2: Από το παράθυρο διαλόγου του εργαλείου Locate, θα επιλέξετε την εντολή Options (κάτω από το «Locate») 

και στη συνέχεια, την επιλογή Provider Settings. 

 

Στη συνέχεια, θα αναδυθεί το ομώνυμο παράθυρο Provider Settings (Εικ. 4.3). 

Επιλέγετε το εικονίδιο Configure layer for Locate, όπου συμπληρώνετε το επίπεδο 

πληροφορίας για το οποίο θέλετε να κάνετε κάποια επιλογή (δηλαδή το Rivers) και 

πιέζετε ΟΚ (Εικ. 4.4). Ενεργοποιείται το παράθυρο διαλόγου Configure Layer for 

Locate - Fields Options, όπου συμπληρώνετε το πεδίο του επιπέδου πληροφορίας 



Γ. Σ. Π. – ArcGIS Pro – ΣΗΜΕΙΩΣΕΙΣ ΕΡΓΑΣΤΗΡΙΟΥ 

96 

 

Rivers από το οποίο θέλετε να επιλέξετε κάποιες οντότητες. Το πεδίο Alias Name 

δείχνει τα πεδία του συγκεκριμένου επιπέδου πληροφορίας. Αυτό που μας ενδιαφέρει 

για την άσκηση είναι η τάξη του υδρογραφικού δικτύου, δηλαδή το πεδίο Class. Στο 

πεδίο Class, που είναι και το μοναδικό πεδίο του επιπέδου πληροφορίας Rivers, και 

συγκεκριμένα στο πεδίο Search Mode, θα επιλέξετε τη μέθοδο επιλογής. Για την 

άσκησή σας, θα επιλέξετε τη μέθοδο Equals (Εικ. 4.5), έτσι ώστε να εντοπίσει το GIS 

όλους τους κλάδους υδρογραφικού δικτύου που η τάξη τους είναι ίση με την τιμή που 

θα καθορίσετε.  

 

 

Εικ. 4.3: Το παράθυρο διαλόγου Provider Settings, στο οποίο αποεπιλέγετε τα XY provider και ArcGIS World 

Geocoding Service. Στη συνέχεια, πιέζετε το εικονίδιο κάτω από το Provider Settings (Configure for Locate). 
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Εικ. 4.4: Αναδυόμενο παράθυρο έπειτα από την ενεργοποίηση της επιλογής Configure for Locate. Επιλέγετε το επίπεδο 
πληροφορίας στο οποίο θα γίνει η επιλογή οντοτήτων, δηλαδή το Rivers, και πιέζετε ΟΚ. 

 

 

Εικ. 4.5: Παράθυρο διαλόγου Configure Layer for Locate - Fields Options. Στο πεδίο Alias Name, θα μεταβείτε στο 
πεδίο της βάσης δεδομένων που θέλετε να κάνετε αναζήτηση, δηλαδή στο Class, που είναι και το μοναδικό πεδίο του 
επιπέδου πληροφορίας Rivers. Στο πεδίο Search Mode, επιλέγετε τη μέθοδο Equals. 

Στη συνέχεια, επιλέγετε την εντολή Save and return to provider Settings . Θα 

εμφανιστεί ένα προειδοποιητικό μήνυμα που σας προτρέπει να δώσετε στο πεδίο της 

βάσης δεδομένων μορφή ευρετηρίου. Η διαδικασία αυτή βελτιώνει την ταχύτητα 

αναζήτησης και είναι ιδιαίτερα χρήσιμη στις περιπτώσεις που το σύνολο των 

δεδομένων είναι μεγάλο. Έτσι, επιλέγετε Yes (Εικ. 4.6).  
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Εικ. 4.6: Προειδοποιητικό μήνυμα του λογισμικού, μήνυμα που σας προτρέπει να δώσετε στο πεδίο της βάσης 
δεδομένων μορφή ευρετηρίου. Eπιλέγετε Yes. 

 

Κάνοντας τα παραπάνω, επιστρέφετε αυτόματα στο χώρο Provider Settings. Στη 

συνέχεια, μέσω της επιλογής Back to Locate pane , επιστρέφετε στο χώρο της 

αναζήτησης. Στο πεδίο Search, θα γράψετε το χαρακτηριστικό που θέλετε να 

αναζητήσετε. Για τη συγκεκριμένη άσκηση, θέλουμε να εντοπίσουμε όλους τους 

κλάδους υδρογραφικού δικτύου τρίτης τάξεως. Έτσι, στο πεδίο Search θα γράψετε 3. 

Στη συνέχεια, το λογισμικό θα σας εμφανίσει μία λίστα με τις γεωγραφικές οντότητες 

των οποίων το πεδίο Class έχει την τιμή 3 (Εικ. 4.7).  

Κάνοντας δεξί κλικ σε μία από τις οντότητες, το λογισμικό θα σας εμφανίσει μερικές 

επιλογές (Εικ. 4.8), όπως Zoom to  για να μεγεθύνετε το χάρτη ώστε η οντότητα 

να καλύψει όλη την έκτασή του και Flash  για να τονιστεί στο χάρτη η οντότητα 

με διαφορετικό χρώμα από τις υπόλοιπες. 
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Εικ. 4.7: Αναζητώντας τους κλάδους 3ης τάξης στο επίπεδο πληροφορίας Rivers, εμφανίζονται με μορφή λίστας οι δύο 
αναγραφές με τη συγκεκριμένη τιμή. 

 

 

Εικ. 4.8: Κάνοντας δεξί κλικ σε μία από τις οντότητες της λίστας (βλ. Εικ. 4.7), το λογισμικό μάς δίνει μία σειρά από 
εντολές, όπως Zoom to για να μεγεθύνετε το χάρτη ώστε η οντότητα να καλύψει όλη την έκτασή του και Flash για να 
τονιστεί στο χάρτη η οντότητα με διαφορετικό χρώμα από τις υπόλοιπες. 
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4.2.2 Επιλογές (Querries)  

Ένα από τα σημαντικότερα χαρακτηριστικά των GIS είναι η δυνατότητα 

αναζητήσεων των οντοτήτων, τόσο βάσει των γεωγραφικών τους χαρακτηριστικών, 

όσο και βάσει της πληροφορίας που έχει καταχωρηθεί στη βάση δεδομένων του 

συστήματος. Μπορούμε, λ.χ., να επιλέξουμε το σύνολο των ισοϋψών των οποίων το 

υψόμετρο είναι πάνω από 100 m ή το σύνολο των πολυγώνων της γεωλογίας που 

αποτελούνται από ασβεστολίθους, μάρμαρα ή δολομίτες. Μπορούμε, όμως, να 

κάνουμε και πιο σύνθετες επιλογές, όπως: το σύνολο των ισοϋψών που έχουν υψόμετρο 

πάνω από 100 m και μήκος μεταξύ 100 και 1.000 km, το σύνολο των πολυγώνων της 

γεωλογίας που αποτελούνται από ασβεστολίθους, μάρμαρα ή δολομίτες και έχουν 

έκταση πάνω από 5 km2 κ.ά. 

Για να κάνουμε τέτοιες επιλογές, θα μεταβούμε στο μενού Map και στην ομάδα 

εργαλείων Selection. Εκεί, θα δείτε διάφορα εργαλεία. Τα κυριότερα είναι τα Select 

(βλ. υποκεφ. 2.3.4), το Select by Attributes, με το οποίο μπορούμε να επιλέξουμε 

γεωγραφικές οντότητες με βάση την περιγραφική τους πληροφορία, και το είτε βάσει 

της γεωγραφικής τους πληροφορίας Select by Location, με το οποίο μπορούμε να 

επιλέξουμε γεωγραφικές οντότητες με βάση τη γεωγραφική τους πληροφορία. 

Στα πλαίσια της εκπαίδευσής σας θα πραγματοποιηθεί αναζήτηση χαρακτηριστικών 

από το επίπεδο πληροφορίας Geology. Επιλέγοντας το εργαλείο Select by Attributes, 

ενεργοποιείται το ομώνυμο παράθυρο διαλόγου. Στο πεδίο Input Rows, ορίζουμε ως 

επίπεδο πληροφορίας το Geology, από το οποίο θα γίνει η επιλογή των 

χαρακτηριστικών, και στο πεδίο Selection type τον τύπο της επιλογής (Εικ. 4.9). Το 

λογισμικό παρέχει έξι τύπους επιλογών (Εικ. 4.9): 

▪ New Selection: Δημιουργία νέας επιλογής. 

▪ Add to the current selection: Προσθήκη μίας επιλογής σε μία ήδη υπάρχουσα. 

▪ Remove from the current selection: Αφαίρεση μίας επιλογής από μία 

υπάρχουσα. 

▪ Select subset from current selection: Επιλογή μέσα από τις ήδη επιλεγμένες 

οντότητες. 

▪ Switch the current selection: Αντιστροφή της επιλογής, κατά την οποίαν της 

οι εγγραφές που είναι επιλεγμένες αφαιρούνται από την τρέχουσα επιλογή όλες 

οι εγγραφές που δεν είναι επιλεγμένες προστίθενται στην τρέχουσα επιλογή. 
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▪ Clear the current selection: Αφαίρεση της τρέχουσας επιλογής. 

 

 

Εικ. 4.9: Διάφορες μέθοδοι επιλογής γεωγραφικών οντοτήτων βάσει της περιγραφικής πληροφορίας.  

 

Στα πλαίσια της εκπαίδευσής σας, θα χρησιμοποιήσετε την επιλογή New Selection 

και στη συνέχεια θα αποεπιλέξετε την εντολή SQL (Εικ. 4.10). Στο παράδειγμά μας, 

θέλουμε να επιλέξουμε τα πολύγωνα των οποίων η λιθολογία είναι είτε κροκαλοπαγή 

είτε ασβεστόλιθοι. Σημειώνεται ότι για το GIS, αυτές είναι δύο επιλογές που θα γίνουν 

ξεχωριστά. Έτσι, αρχικά θα επιλέξουμε τις οντότητες των οποίων η λιθολογία είναι 

κροκαλοπαγή. 
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Εικ. 4.10: Επιλέγετε την εντολή New expression και αποεπιλέγετε την εντολή SQL. Συμπληρώνετε το πεδίο Where 

ανάλογα με αυτό που επιθυμείτε να επιλέξετε, όπως περιγράφεται στα επόμενα βήματα. 

 

Στο πεδίο Where συμπληρώνετε μέσω του combo box Select a Field το πεδίο στο 

οποίο θα βασιστεί η επιλογή σας, από τη βάση δεδομένων του επιπέδου πληροφορίας 

Geology. Στα πλαίσια της άσκησης, θέλουμε να επιλέξουμε γεωγραφικές οντότητες με 

βάση τη λιθολογία τους, η οποία αντιστοιχεί στο πεδίο Name. Οπότε, επιλέγετε το πεδίο 

Name. Στο combo box που εμφανίζεται αμέσως δεξιά, έχετε διάφορες επιλογές, όπως 

is equal to, is not equal to, is greater than κ.ά. Στο συγκεκριμένο παράδειγμα θα 

επιλέξετε τη μέθοδο is equal to. Στη συνέχεια, από το επόμενο combo box θα επιλέξετε 

μια από τις τιμές του πεδίου Name. Στη συγκεκριμένη περίπτωση θα επιλεγεί η τιμή 

Κροκαλοπαγή (Εικ. 4.11).  

Τώρα, για να πραγματοποιήσουμε τη δεύτερη επιλογή, δηλαδή η λιθολογία να είναι 

ασβεστόλιθοι, θα επιλέξουμε την εντολή Add Clause, ώστε να προστεθεί ένα νέο πεδίο 

επιλογών. Το συμπληρώνουμε με τον ίδιο τρόπο, μόνο που στο τελευταίο combo box 

επιλέγουμε Ασβεστόλιθοι.  

Προσοχή: στο πρώτο combo box, το λογισμικό θα μας ζητήσει να επιλέξουμε And 

ή Or. Αυτό αφορά στη σχέση που θα έχουν μεταξύ τους οι δύο επιλογές. Επιλέγοντας 

And, ορίζουμε στο λογισμικό να μας εντοπίσει τις οντότητες των οποίων η λιθολογία 

είναι και κροκαλοπαγή και ασβεστόλιθοι. Όπως καταλαβαίνετε, δεν υπάρχει κανένα 
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τέτοιο πολύγωνο, οπότε η επιλογή μας δε θα έχει κάποιο αποτέλεσμα. Για το λόγο αυτό, 

θα επιλέξουμε Or (Εικ. 4.11). 

 

 

Εικ. 4.11Error! Unknown switch argument.: Επιλογή οντοτήτων βάσει της περιγραφικής πληροφορίας που 
περιέχουν. 

 

Στη συνέχεια, μπορείτε να ενεργοποιήσετε την επιλογή SQL ώστε να παρατηρήσετε 

την εντολή επιλογής σας στη γλώσσα αναζήτησης SQL (Εικ. 4.12).  

 

 

Εικ. 4.Error! Unknown switch argument.: Επιλογή γεωγραφικών οντοτήτων σε μορφή SQL. 
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Μετά τη σύνθεση της εντολής, και πριν την εφαρμογή της, ελέγχεται η εγκυρότητά 

της μέσω της επιλογής Verify the SQL expression is valid πατώντας το  (Εικ. 4.13) 

και ολοκληρώνεται επιλέγοντας το ΟΚ.  

 

 

Εικ. 4.1: Πατώντας την εντολή Verify (το πράσινο ✓ πάνω από το πεδίο Where), μπορείτε να επιβεβαιώσετε ότι έχετε 
ακολουθήσει σωστά τα παραπάνω βήματα. Θα σας εμφανίσει το μήνυμα: the SQL expression is valid. Αν δε σας το 
εμφανίσει, σημαίνει ότι έχετε κάνει κάποιο λάθος στα βήματα. 

 

Παρατηρήστε την περιοχή του χάρτη. Θα διαπιστώσετε ότι έχουν επιλεγεί 

επιφάνειες των οποίων η λιθολογία είναι κροκαλοπαγή και ασβεστόλιθοι (Εικ. 4.14). 

Αν ενεργοποιήσετε τον πίνακα περιγραφικών χαρακτηριστικών του επιπέδου 

πληροφορίας Geology (στο διαχειριστή επιπέδων πληροφορίας, δεξί κλικ στο επίπεδο 

πληροφορίας Geology και επιλογή της εντολής Attribute Table), στο κάτω τμήμα της 

βάσης δεδομένων υπάρχει η επιλογή Show Selected Records. Αν την επιλέξετε, θα 

απομονωθούν σε ξεχωριστό πίνακα οι εγγραφές των επιλεγμένων οντοτήτων (Εικ. 

4.15). 
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Εικ. 4.13: Αφότου ακολουθήσουμε τα παραπάνω βήματα, θα επιλεγούν οι γεωγραφικές οντότητες με βάση τα κριτήρια 
που θέσαμε τόσο στο χάρτη, όπως φαίνεται εδώ, όσο και στη βάση δεδομένων του πίνακα περιγραφικών 
χαρακτηριστικών (Εικ. 4.15). 

 

 

Εικ. 4.14: Αφότου ακολουθήσουμε τα παραπάνω βήματα, θα επιλεγούν οι γεωγραφικές οντότητες με βάση τα κριτήρια 
που θέσαμε τόσο στο χάρτη (Εικ. 4.14), όσο και στη βάση δεδομένων του πίνακα περιγραφικών χαρακτηριστικών. Αν 
επιλέξουμε την εντολή Show Selected Records στο κάτω τμήμα της βάσης δεδομένων, θα εμφανιστεί ένας πίνακας που 
θα περιέχει μόνο τις επιλεγμένες οντότητες, όπως φαίνεται εδώ. 

 

 

 



Γ. Σ. Π. – ArcGIS Pro – ΣΗΜΕΙΩΣΕΙΣ ΕΡΓΑΣΤΗΡΙΟΥ 

106 

 

Ανάλογα με τις ανάγκες της έρευνάς μας, μπορούμε να πραγματοποιήσουμε 

διάφορες αναζητήσεις από τη βάση δεδομένων, χρησιμοποιώντας διαφορετικούς 

κανόνες και τύπους επιλογών. Για παράδειγμα, με δεξί κλικ στο επίπεδο πληροφορίας 

Geology, επιλέγοντας την εντολή Selection → Zoom to Selection, γίνεται μεγέθυνση 

του χάρτη ώστε να φαίνονται όλες οι οντότητες που έχουν επιλεγεί (Εικ. 4.16). 

 

 

Εικ. 4.15: Από το διαχειριστή επιπέδων πληροφορίας, με δεξί κλικ στο επίπεδο πληροφορίας Geology, μέσω της 
εντολής Select → Zoom To Selection, ο χάρτης μεγεθύνεται (ή σμικρύνεται) έτσι ώστε οι επιλεγμένες οντότητες να 
καλύψουν όλη την έκτασή του. 
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4.3 Ετικέτες (Labels) 

Οι ετικέτες είναι ένα πολύ σημαντικό κομμάτι της χαρτογραφίας. Σχεδόν όλοι οι 

χάρτες έχουν ετικέτες. Το κείμενο συμβάλλει στη μεταφορά πληροφοριών που τα 

σύμβολα από μόνα τους δε μπορούν. Η προσεκτικά σχεδιασμένη τοποθέτηση των 

ετικετών προσθέτει τεράστια αξία, καθώς βοηθά τον αναγνώστη να διακρίνει γρήγορα 

ποιο είναι το χαρακτηριστικό που θέλει να μελετήσει. 

Στα πλαίσια της άσκησής σας, θα δημιουργήσουμε ετικέτες στο επίπεδο 

πληροφορίας Geology. Αφού επιλέξετε το συγκεκριμένο επίπεδο πληροφορίας από το 

διαχειριστή επιπέδων πληροφορίας, μεταβείτε στο μενού Labeling, που αποτελείται 

από τις ομάδες εργαλείων Layer, Label Class, Visibility Range, Text Symbol, Label 

Placement και Map (Εικ. 4.17).  

 

 

Εικ. 4.16: Στο μενού Labeling υπάρχει πληθώρα εργαλείων για την εμφάνιση και την επεξεργασία των ετικετών. 

Από την ομάδα εργαλείων Layer και το εργαλείο Label  ενεργοποιούνται οι 

ετικέτες του επιλεγμένου επιπέδου πληροφορίας (Εικ. 4.18). Οι ετικέτες εμφανίζονται 

με τη μορφή που καθορίζεται στην ομάδα εργαλείων Label Class (Εικ. 4.18).  
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Εικ. 4.17: Με επιλεγμένο το επίπεδο πληροφορίας Geology από το διαχειριστή επιπέδων πληροφορίας, μεταβείτε στο 
μενού Labeling.Μ ε το εργαλείο Label Class γίνεται η ενεργοποίηση των ετικετών για το επίπεδο πληροφορίας των 
γεωλογικών σχηματισμών. 

 

Εναλλακτικά, με δεξί κλικ στο επίπεδο πληροφορίας από το διαχειριστή επιπέδων 

πληροφορίας, επιλέγετε την εντολή Labeling Properties (Εικ. 4.19). Θα ενεργοποιηθεί 

το παράθυρο (Εικ. 4.20). Από αυτό το πεδίο επιλέγετε την καρτέλα Symbol (Εικ. 4.21). 

Εναλλακτικά, στο ίδιο το μενού Labeling, επιλέγετε την ομάδα εργαλείων Text Symbol 

(Εικ. 4.17). Και με τους δύο τρόπους, μπορείτε να καθορίσετε την εμφάνιση των 

ετικετών (γραμματοσειρά, μέγεθος γραμμάτων, χρώμα κ.ά.). Τέλος, στο μενού 

Labeling μεταβείτε στην ομάδα εργαλείων Label Placement (Εικ. 4.17). Εναλλακτικά, 

από το παράθυρο διαλόγου Label Class μεταβείτε στην καρτέλα Position (Εικ. 4.22). 

Με τους δύο αυτούς τρόπους, μπορείτε να καθορίσετε τη θέση των ετικετών. 
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Εικ. 4.18: Η ενεργοποίηση των ετικετών γίνεται από το διαχειριστή επιπέδων πληροφορίας με δεξί κλικ στο επίπεδο 
πληροφορίας. Από το παράθυρο που θα αναδυθεί (βλ. Εικ. 4.20), καθώς επίσης και από το μενού Labeling (Εικ. 4.17), 
μπορείτε να καθορίσετε τη μορφή και τη θέση των ετικετών. 
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Εικ. 4.19: Το παράθυρο διαλόγου Label Class, που εμφανίζεται αν κάνετε δεξί κλικ στο επίπεδο πληροφορίας Geology 

από το διαχειριστή επιπέδων πληροφορίας και επιλέξετε την εντολή Labeling Properties. 
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Εικ. 4.20: Στην καρτέλα Symbol του παραθύρου Label Class (βλ. Εικ. 4.20), μπορείτε να αλλάξετε την εμφάνιση των 
ετικετών. 
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Εικ. 4.21: Η θέση των ετικετών καθορίζεται από την καρτέλα Position του παραθύρου Label Class (βλ. Εικ. 4.20). 
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4.4 Τροποποίηση βάσης δεδομένων 

Τώρα θα δούμε πώς τροποποιούμε μία ήδη υπάρχουσα βάση δεδομένων, αυτήν την 

φορά στο επίπεδο πληροφορίας Rivers. Προκειμένου να προστεθεί ένα νέο πεδίο στη 

βάση δεδομένων, ενεργοποιήστε τον πίνακα περιγραφικών χαρακτηριστικών από το 

διαχειριστή επιπέδων πληροφορίας, με δεξί κλικ στο επίπεδο πληροφορίας και επιλογή 

της εντολής Attribute Table.  

Μέσω του εργαλείου Add Field, μπορείτε να προσθέσετε ένα νέο πεδίο. Στο πεδίο 

Field Name συμπληρώνετε το όνομα του πεδίου που θα δημιουργήσετε, που για τις 

ανάγκες της εκπαίδευσής σας θα είναι το Name. Το πεδίο Data Type θα το ορίσετε ως 

Text (για κάθε τύπο πεδίων που ορίζεται από το Data Type, βλ. υποκεφ. 3.3). Σο πεδίο 

Length συμπληρώνετε το μέγιστο πλήθος χαρακτήρων που θα δεχθεί το πεδίο (Εικ. 

4.23). Όταν έχετε ολοκληρώσει την προσθήκη του νέου πεδίου, επιλέγετε από το μενού 

Fields και την ομάδα εργαλείων Changes το εργαλείο Save   για να αποθηκευτούν 

οι αλλαγές. Εδώ θα πρέπει να είστε προσεκτικοί, καθώς το λογισμικό δε σας δίνει τη 

δυνατότητα να τροποποιήσετε το πεδίο που δημιουργήσατε αφότου πατήσετε το Save. 

Με τον ίδιο τρόπο τώρα θα προσθέσετε ένα πεδίο στη βάση δεδομένων του επιπέδου 

πληροφορίας Geology. Οπότε, θα επαναλάβετε την παραπάνω διαδικασία στο επίπεδο 

πληροφορίας Geology. Το νέο πεδίο αυτή τη φορά θα αφορά στην έκταση του κάθε 

σχηματισμού σε km2, οπότε το νέο πεδίο θα λέγεται Area_sqkm και ο τύπος του στο 

πεδίο Data Type θα είναι Double, καθώς η έκταση είναι δεκαδικός αριθμός (Εικ. 4.24). 

 

 

Εικ. 4.22: Προσθήκη πεδίου στον πίνακα περιγραφικών χαρακτηριστικών, με παρόμοιο τρόπο με τον αρχικό 
σχεδιασμό της βάσης δεδομένων (υποκεφ. 3.3). 
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Εικ. 4.23: Τροποποίηση πεδίου στον πίνακα περιγραφικών χαρακτηριστικών, με παρόμοιο τρόπο με τον αρχικό 
σχεδιασμό της βάσης δεδομένων (υποκεφ. 3.3). 

 

4.5 Ενημέρωση βάσης δεδομένων 

Ένα από τα μεγάλα πλεονεκτήματα των GIS είναι ότι μας επιτρέπουν να 

ενημερώσουμε τη βάση δεδομένων ενός επιπέδου πληροφορίας είτε με συγκεκριμένη 

τιμή, όπως για παράδειγμα, στην περίπτωση του υδρογραφικού δικτύου, το όνομα της 

υδρολογικής λεκάνης στην οποίαν ανήκει ο κάθε κλάδος, είτε με την τιμή ενός 

γεωγραφικού χαρακτηριστικού, όπως είναι το μήκος του κάθε κλάδου ή, αντίστοιχα 

για την περίπτωση της γεωλογίας, η περίμετρος και η έκταση του κάθε πολυγώνου. 

Σε κάθε περίπτωση, θα χρειαστεί να ενεργοποιήσουμε τον πίνακα περιγραφικών 

χαρακτηριστικών του επιπέδου πληροφορίας του οποίου τη βάση δεδομένων 

επιθυμούμε να τροποποιήσουμε. Έτσι, από το διαχειριστή επιπέδων πληροφορίας, 

κάνετε δεξί κλικ στο επίπεδο πληροφορίας Rivers και επιλέγετε την εντολή Attribute 

Table.  

Στη συγκεκριμένη άσκηση, θα ενημερώσουμε το πεδίο Name για όλους τους 

κλάδους του υδρογραφικού δικτύου με την τιμή "Υδρογραφικό δίκτυο". Επομένως, θα 

κάνετε δεξί κλικ πάνω στο πεδίο Name και θα επιλέξετε την εντολή Calculate Field 

 (Εικ. 4.25). Εναλλακτικά, αφού έχετε ανοίξει τον πίνακα περιγραφικών 

δεδομένων, μπορείτε να μεταβείτε στο μενού View και στην ομάδα εργαλείων Tools 

και να επιλέξετε το εργαλείο Calculate Field .  

Ακολούθως, θα εμφανιστεί το ομώνυμο παράθυρο διαλόγου Calculate Field (Εικ. 

4.26). Το πεδίο Input Table είναι συμπληρωμένο αυτόματα από το λογισμικό και 

αφορά στο πεδίο για το οποίο θα πραγματοποιηθεί η ενημέρωση της βάσης δεδομένων 

(Rivers). Στο πεδίο Field Name (Existing or New) συμπληρώνετε το πεδίο της βάσης 
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δεδομένων που θα γίνει ενημέρωση, που στη συγκεκριμένη περίπτωση θα είναι το 

Name. Στο πεδίο Expression Type θα επιλέξετε Arcade και στο πεδίο Name θα 

συμπληρώσετε το κείμενο με το οποίο θέλετε να ενημερώσετε το πεδίο, δηλαδή 

Υδρογραφικό δίκτυο,  αλλά μεταξύ εισαγωγικών "", ακριβώς όπως φαίνεται στην Εικ. 

4.27. Παρατηρήστε τον πίνακα περιγραφικών χαρακτηριστικών (Εικ. 4.28). 

 

 

Εικ. 4.24: Για την ενημέρωση ενός πεδίου, κάνετε δεξί στο πεδίο αυτό και επιλέγετε την εντολή Calculate Field. 
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Εικ. 4.25: Στο παράθυρο διαλόγου Calculate Field, συμπληρώνετε: στο πεδίο Input Table συμπληρώνετε το πεδίο που 
θέλετε να ενημερώσετε τη βάση δεδομένων του, δηλαδή το Rivers. Στο πεδίο Expression Type επιλέγετε Arcade. Στο 
πεδίο Expression επιλέγετε το πεδίο που θέλετε να ενημερώσετε, δηλαδή το Name. Στο πεδίο Name = θα γράψετε: 
"Υδρογραφικό δίκτυο", αλλά διατηρώντας τα εισαγωγικά, όπως φαίνεται στην Εικ. 4.27. 
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Εικ. 4.26: Τα πεδία του παραθύρου Calculate Field συμπληρωμένα. Για να γίνει η ενημέρωση, πιέζετε ΟΚ. 
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Εικ. 4.27: Μετά την ενημέρωση του πεδίου, θα δείτε ότι το πεδίο Name στη βάση δεδομένων έχει ενημερωθεί με την 
τιμή «Υδρογραφικό δίκτυο». 

 

Τώρα θα μάθουμε να ορίζουμε στο GIS να υπολογίζει γεωγραφικά στοιχεία σε ένα 

επίπεδο πληροφορίας. Συγκεκριμένα, θα υπολογίσουμε την έκταση κάθε πολυγώνου 

στο επίπεδο πληροφορίας Geology. Έτσι, επιλέγετε πάλι το Geology από το διαχειριστή 

επιπέδων πληροφορίας και κάνετε δεξί κλικ επιλέγοντας την εντολή Attribute Table 

για να ενεργοποιήσετε τον πίνακα περιγραφικών χαρακτηριστικών. Κάνετε πάλι δεξί 

κλικ στο πεδίο που πρόκειται να ενημερωθεί, δηλαδή το Area_sqkm, και αυτή τη φορά 

επιλέγετε την εντολή εργαλείο Calculate Geometry (Εικ. 4.29), ώστε να 

εμφανιστεί το ομώνυμο παράθυρο διαλόγου Calculate Geometry (Εικ. 4.30). 

Εναλλακτικά, αφότου έχετε ενεργοποιήσει τον πίνακα περιγραφικών 

χαρακτηριστικών, από το μενού View και την ομάδα εργαλείων Tools επιλέγετε το 

εργαλείο Calculate Geometry . 

Στο αναδυόμενο παράθυρο Calculate Geometry (Εικ. 4.30), συμπληρώνετε τα 

αντίστοιχα πεδία. Το πεδίο Input Table αφορά στο επίπεδο πληροφορίας του οποίου 

θέλουμε να ενημερώσουμε τη βάση δεδομένων (Geology) και είναι αυτόματα 

συμπληρωμένο από το λογισμικό. Από το χώρο Geometry Property, και συγκεκριμένα, 
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στο πρώτο πεδίο της ομάδας Field (Existing or New), θα καθορίσετε το πεδίο του 

πίνακα περιγραφικών χαρακτηριστικών που θα ενημερωθεί, δηλαδή το Area_sqkm.  

Στη συνέχεια, στο πρώτο πεδίο της ομάδας Property, θα καθορίσετε τη γεωγραφική 

ιδιότητα με την οποία θα συμπληρωθεί το πεδίο Area_sqkm. Πατώντας πάνω στο 

combo box, θα σας εμφανίσει μία σειρά από επιλογές, με πιο βασικές την έκταση (Area) 

και την περίμετρο (Perimeter length). Για να υπολογίσει το λογισμικό την έκταση, θα 

επιλέξετε το Area (Εικ. 4.31). Λαμβάνοντας υπόψη τις διαφορετικές προβολές, πρέπει 

να αναφέρουμε ότι τροποποιώντας το προβολικό σύστημα θα τροποποιηθούν 

αντίστοιχα οι τιμές των γεωγραφικών χαρακτηριστικών (της έκτασης, της περιμέτρου 

κ.ά.). 

 

 

Εικ. 4.28: Για να υπολογίσετε γεωγραφικά χαρακτηριστικά σε ένα πεδίο (έκταση, μήκος κ.ά.), κάνετε δεξί κλικ στο 
πεδίο από τον πίνακα περιγραφικών χαρακτηριστικών και επιλέγετε την εντολή Calculate Geometry. 
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Εικ. 4.29: Το παράθυρο διαλόγου Calculate Geometry. Συμπληρώνετε ως εξής: στο πεδίο Input Table συμπληρώνετε 
το πεδίο που θέλετε να ενημερώσετε τη βάση δεδομένων του, δηλαδή το Geology. Στο πεδίο Geometry Attributes → 

Field (Existing or New) επιλέγετε το πεδίο που θέλετε να συμπληρώσετε, δηλαδή το Area_sqkm (βλ. και Εικ. 4.31). 
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Εικ. 4.30: Σε συνέχεια της Εικ. 4.30, στο πεδίο Geometry Attributes → Property επιλέγετε μία από τις επιλογές που 
σας δίνει το λογισμικό. Εμείς θέλουμε να υπολογίσουμε έκταση, οπότε θα επιλέξετε Area (βλ. και Εικ. 4.32). 

 

Εν συνεχεία, στο πεδίο Area Unit που εμφανίζεται θα επιλέξετε τις μονάδες 

μέτρησης της έκτασης. Αν πατήσετε στο combo box του πεδίου, το λογισμικό σάς δίνει 

διάφορες επιλογές, όπως τετραγωνικά χιλιόμετρα, τετραγωνικά μέτρα, εκτάρια κ.ά. 

Εμείς θα επιλέξουμε τα τετραγωνικά χιλιόμετρα (Square Kilometers) (Εικ. 4.32). 

Ακολούθως, στο πεδίο Coordinate System, θα επιλέξουμε από το combo box το 

προβολικό σύστημα του επιπέδου πληροφορίας Geology (Εικ. 4.33), δηλαδή το 

Greek_Grid, και επιλέγετε ΟΚ. Παρατηρήστε τη βάση δεδομένων (Εικ. 4.34). 
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Εικ. 4.31: Σε συνέχεια της Εικ. 4.31, στο πεδίο Area Unit που εμφανίζεται επιλέγουμε τη μονάδα μέτρησης που θα έχει 
η έκταση, δηλαδή Square Kilometers (βλ. και Εικ. 4.33). 
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Εικ. 4.32 Σε συνέχεια της Εικ. 4.32, στο πεδίο Coordinate System επιλέγουμε το προβολικό σύστημα, το οποίο είναι 
το ίδιο με αυτό του επιπέδου πληροφορία, δηλαδή αυτό του Geology (Greek_Grid). Τέλος, πιέζουμε ΟΚ. 
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Εικ. 4.33: Αφότου κάνουμε τα παραπάνω βήματα, η βάση δεδομένων του επιπέδου πληροφορίας Geology έχει 
ενημερωθεί με την έκταση του κάθε πολυγώνου σε km2. 

 

Ακολουθώντας παρόμοια διαδικασία, μπορείτε να υπολογίσετε και το μήκος των 

κλάδων του υδρογραφικού δικτύου. Επομένως, θα προσθέσετε το πεδίο Length_m στη 

βάση δεδομένων του επιπέδου πληροφορίας Rivers. Το μήκος είναι δεκαδικός αριθμός, 

επομένως στο πεδίο Data Type θα επιλέξετε την επιλογή Double. Θα κάνετε πάλι δεξί 

κλικ στο πεδίο Length_m και θα επιλέξετε Calculate Geometry .  

Στο αναδυόμενο παράθυρο Calculate Geometry συμπληρώνετε τα πεδία με τον ίδιο 

τρόπο (Εικ. 4.35): στο πεδίο Input Features συμπληρώνετε το επίπεδο πληροφορίας 

Rivers. Στο πεδίο Geometry Property, στην ομάδα Field (Existing or New) 

συμπληρώνετε το πεδίο Length_m και στην Property το Length. Στο πεδίο Length 

Units, δεδομένου ότι θέλουμε να υπολογίσουμε το μήκος σε μέτρα, θα επιλέξετε  

Meters (Εικ. 4.35). Στο πεδίο Coordinate System θα επιλέξετε το προβολικό σύστημα 

του επιπέδου πληροφορίας Rivers (Εικ. 4.35), δηλαδή Greek_Grid, και επιλέγετε ΟΚ. 

Παρατηρήστε τη βάση δεδομένων (Εικ. 4.36). 
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Εικ. 4.34: Μέσω του Calculate Geometry θα υπολογίσετε και το μήκος των κλάδων του υδρογραφικού δικτύου για το 
πεδίο Length_m στον πίνακα περιγραφικών χαρακτηριστικών του επιπέδου πληροφορίας Rivers. Η συμπλήρωση των 
πεδίων θα γίνει όπως βλέπετε εδώ. 

 

 

Εικ. 4.35: Η βάση δεδομένων του επιπέδου πληροφορίας Rivers έχει πλέον ενημερωθεί με το μήκος κάθε κλάδου σε 
μέτρα. 
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4.6 Εξαγωγή βάσης δεδομένων 

Ο πίνακας περιγραφικών χαρακτηριστικών μπορεί να αποθηκευτεί σε κάποια άλλη 

μορφή ώστε να χρησιμοποιηθεί από λογισμικό διαφορετικό του GIS, π.χ. Excel. Αυτό 

μπορείτε να το κάνετε πατώντας το menu της βάσης δεδομένων  και αναζητώντας 

την εντολή Export  (Εικ. 4.37). Στο αναδυόμενο παράθυρο Export Table (Εικ. 

4.38) και στην καρτέλα Parameters, συμπληρώνετε το πεδίο Input Rows με το όνομα 

του επιπέδου πληροφορίας από το οποίο θα γίνει εξαγωγή του πίνακα περιγραφικών 

χαρακτηριστικών, που για την άσκησή σας θα είναι το Geology. Στο πεδίο Output Table 

επιλέγετε το φάκελο στον οποίον θα αποθηκευτεί η βάση δεδομένων. Στο πεδίο Name 

συμπληρώνετε το όνομα του αρχείου που θα δημιουργηθεί, π.χ. Geology_Table (Εικ. 

4.39). Στην ενότητα Fields και στο πεδίο Output Fields, επιλέγετε τα πεδία της βάσης 

δεδομένων τα οποία θα εξαχθούν, στην προκειμένη περίπτωση Name και Area_sqkm 

(Εικ. 4.39). 

 

 

Εικ. 4.36: Από τον πίνακα περιγραφικών χαρακτηριστικών, στο menu της βάσης δεδομένων, μέσω της εντολής Export 

πραγματοποιείται η εξαγωγή του πίνακα σε μορφή .gdb. 
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Εικ. 4.37: Το παράθυρο διαλόγου Export Table, μέσω του οποίου μπορείτε να εξαγάγετε τη βάση δεδομένων σας. 
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Εικ. 4.38: Στο παράθυρο Export Table, καθορίζετε τα πεδία Input Rows, Output Location, Output Name και Fields 

πριν την εξαγωγή του πίνακα περιγραφικών χαρακτηριστικών και πιέζετε ΟΚ. 
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4.7 Θεματική χαρτογραφία 

Η θεματική χαρτογραφία αναφέρεται στη συνδυαστική ανάλυση των χωρικών και 

περιγραφικών δεδομένων. Είναι η διαδικασία μέσω της οποίας γίνεται η γεωγραφική 

κατανομή μιας περιγραφικής πληροφορίας που είναι καταχωρημένη στη βάση 

δεδομένων. Υπάρχουν πολλές διαφορετικές μέθοδοι για τη γεωγραφική κατανομή μιας 

ή παραπάνω περιγραφικής πληροφορίας, μερικές από τις οποίες θα αναφερθούν σε 

αυτό το υποκεφάλαιο. 

Για παράδειγμα, ο πίνακας περιγραφικών χαρακτηριστικών μπορεί να περιέχει τα 

ονόματα των γεωλογικών σχηματισμών και να δημιουργήσετε ένα θεματικό χάρτη με 

μεμονωμένες τιμές ώστε κάθε γεωλογικός σχηματισμός να αναπαρίσταται με 

διαφορετικό τρόπο (καφέ οι σχιστόλιθοι, κίτρινα τα αλλούβια κ.ά.). Κατά τη 

δημιουργία του θεματικού χάρτη, μπορείτε να καθορίσετε τις παραμέτρους των 

συμβόλων, όπως το είδος, το μέγεθός τους ή το χρώμα τους.  

Στα πλαίσια της άσκησης, θα δημιουργήσουμε ένα θεματικό χάρτη με τα επίπεδα 

πληροφορίας Geology και Rivers. Ας ξεκινήσουμε με το Geology. Για να 

δημιουργήσετε ένα θεματικό χάρτη, από το διαχειριστή επιπέδων πληροφορίας κάνετε 

δεξί κλικ στο επίπεδο πληροφορίας Geology και επιλέγετε την εντολή Symbology 

(Εικ. 4.40). Εναλλακτικά, μπορείτε να ενεργοποιήσετε το εργαλείο Symbology 

 έχοντας επιλεγμένο το επίπεδο πληροφορίας από το διαχειριστή επιπέδων 

πληροφορίας και μεταβαίνοντας στο μενού Feature και στην ομάδα εργαλείων 

Drawing Layer (Εικ. 4.41). 
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Εικ. 4.40: Με δεξί κλικ στο επίπεδο πληροφορίας επιλέγεται η εντολή Symbology ώστε να ενεργοποιηθεί το ομώνυμο 

παράθυρο διαλόγου. 

 

 

Εικ. 4.41: Το εργαλείο Symbology βρίσκεται στο μενού Appearance της ομάδας εργαλείων Drawing. 

 

Στο ομώνυμο αναδυόμενο παράθυρο Symbology, μεταβαίνετε στην καρτέλα 

Primary Symbology (Εικ. 4.42), όπου θα δείτε διάφορες μεθόδους θεματικής 

χαρτογραφίας. Από το combo box, μπορείτε να επιλέξετε μία από τις ακόλουθες 

μεθόδους: 
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Εικ. 4.42: Το παράθυρο διαλόγου Symbology ανοίγει αυτόματα στην καρτέλα Primary symbology. Από το combo box 

υπάρχει πληθώρα επιλογών θεματικής χαρτογραφίας (Symbolize your layer using one symbol, Symbolize your layer 

by category, Symbolize your layer by quantity και Symbolize your layer using symbol attributes). 

 

▪ Symbolize your layer using one symbol: Η μέθοδος αυτή (συμβολισμός 

χωρικών στοιχείων με ένα ενιαίο σύμβολο) εμφανίζει με το ίδιο σύμβολο τις 

οντότητες του θεματικού επιπέδου, ασχέτως των πληροφοριών τους στον 

πίνακα περιγραφικών χαρακτηριστικών: 
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Εργαλείο 

Σημειακό 
επίπεδο 
πληροφορίας 

Γραμμικό 
επίπεδο 
πληροφορίας 

Πολυγωνικό 
επίπεδο 
πληροφορίας 

Single 

Symbol (ενιαία 
αποτύπωση για 

όλες τις τιμές 
της βάσης 

δεδομένων) 

   

 

▪ Symbolize your layer by category: Η μέθοδος αυτή (συμβολισμός δεδομένων 

με κατηγοριοποίηση ως προς μία τιμή) εμφανίζει με διαφορετικό τρόπο τις 

επιμέρους οντότητες, ανάλογα με την πληροφορία που περιέχεται στον πίνακα 

περιγραφικών χαρακτηριστικών, σε ένα πεδίο που θα επιλέξετε εσείς (π.χ. 

μήκος, λιθολογία κ.ά.): 

 

Εργαλείο 

Σημειακό 

επίπεδο 
πληροφορίας 

Γραμμικό 

επίπεδο 
πληροφορίας 

Πολυγωνικό 

επίπεδο 
πληροφορίας 

Unique Values 

(μοναδικές τιμές 
ενός πεδίου της 

βάσης δεδομένων) 
   

 

▪ Symbolize your layer by quantity: Η μέθοδος αυτή (ποσοτικοποίηση) 

εφαρμόζεται μόνο σε αριθμητικά πεδία. Χρησιμοποιεί διαφορετικά σύμβολα 

για να αποτυπώσει τη μεταβολή στην αριθμητική τιμή ενός πεδίου (π.χ. σε ένα 

σημειακό επίπεδο πληροφορίας που δείχνει τριγωνομετρικά σημεία, κουκίδες 

με αυξανόμενο μέγεθος ανάλογα με το υψόμετρό τους κ.ά.). Τα GIS παρέχουν 

τις ακόλουθες δυνατότητες: 
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Εργαλείο 
Σημειακό επίπεδο 

πληροφορίας 

Γραμμικό επίπεδο 
πληροφορίας 

Πολυγωνικό 
επίπεδο 

πληροφορίας 

Graduated Colors 

(διαβαθμισμένα χρώματα, όπου 
η κάθε απόχρωση αντιστοιχεί 

σε μια τιμή) 

   

Bivariate Colors (συμβολισμός 

διμεταβλητών χρωμάτων όπου 

δείχνει την ποσοτική σχέση 
μεταξύ δύο μεταβλητών σε ένα 

επίπεδο χαρακτηριστικών) 

   

Unclassed Colors (συμβολισμός 

χρωμάτων χωρίς ταξινόμηση)    

Graduated Symbols 

(διαβαθμισμένα σύμβολα, το 

μέγεθος των οποίων 
αντιπροσωπεύει τις σχετικές 

τιμές) 

   

Proportional Symbols 

(αναλογικά σύμβολα, το 
μέγεθος των οποίων δείχνει τις 

ακριβείς τιμές) 
   

Dot Density (πυκνότητα 
κουκίδων, οι οποίες 

αντιπροσωπεύουν τιμές) 

- - 
 

Charts 
   

 

Το εργαλείο Charts δημιουργεί γραφήματα σε κάθε οντότητα ανάλογα με τις 

πληροφορίες του πίνακα περιγραφικών χαρακτηριστικών και εφαρμόζεται μόνο σε 

αριθμητικά πεδία. 
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▪ Symbolize your layer using symbol attributes: Η μέθοδος αυτή (μέσω 

χαρακτηριστικού συμβόλου) εφαρμόζεται σε δεδομένα που ήδη απεικονίζονται 

ως σύμβολα με σκοπό την προσαρμογή τους για καλύτερη οπτικοποίηση. 

 

Εργαλείο 

Σημειακό 
επίπεδο 

πληροφορίας 

Γραμμικό 
επίπεδο 

πληροφορίας 

Πολυγωνικό 
επίπεδο 

πληροφορίας 

Dictionary 

(Λεξικό)    

 

Το εργαλείο Dictionary χρησιμοποιείται για να συμβολίσει επίπεδα πληροφορίας 

χρησιμοποιώντας ένα λεξικό συμβόλων διαμορφωμένο με πολλαπλές ιδιότητες. Αυτή 

η προσέγγιση χρησιμοποιείται όταν οι προδιαγραφές συμβόλων οδηγούν σε πολλές 

μεταθέσεις συμβόλων που δεν ενδείκνυνται για το συμβολισμό μοναδικών τιμών. 

Επιπλέον, ο συμβολισμός των χαρακτηριστικών στο επίπεδο πληροφορίας βασίζεται 

σε ένα ή περισσότερα χαρακτηριστικά που συνδέονται με ένα λεξικό κανόνων για την 

εμφάνιση του συμβόλου. Μπορούν να δημιουργηθούν προσαρμοσμένα λεξικά και να 

χρησιμοποιηθούν για το χειρισμό πρόσθετων προδιαγραφών συμβόλων.  

Στη συγκεκριμένη περίπτωση θέλουμε να αποτυπώσουμε τη γεωλογία με τέτοιον 

τρόπο, ώστε κάθε γεωλογικός σχηματισμός να έχει διαφορετικό χρώμα. Στην καρτέλα 

Primary symbology επιλέγετε τη μέθοδο Symbolize your layer by category και 

επιλέγετε το εργαλείο Unique values , έτσι ώστε κάθε σχηματισμός να 

εμφανίζεται με διαφορετικό τρόπο. Στο πεδίο Field 1 επιλέγεται το πεδίο Name, βάσει 

του οποίου θα γίνει ο θεματικός χάρτης. Στο πεδίο Color scheme επιλέγετε τη 

χρωματική παλέτα στην οποία θα βασίζεται ο συμβολισμός. Μέσω της εντολής Add all 

Values  εισάγονται όλες οι διαφορετικές τιμές που υπάρχουν στον πίνακα 

περιγραφικών χαρακτηριστικών (Εικ. 4.43). Πατώντας στο σύμβολο του κάθε 

σχηματισμού, μπορείτε να το τροποποιήσετε (π.χ. να του αλλάξετε το χρώμα) ή και να 

το καθορίσετε από την αρχή.  
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Προσοχή: το λογισμικό από μόνο του δεν μπορεί να δημιουργήσει έναν θεματικό 

χάρτη αν προηγουμένως εμείς δεν έχουμε φροντίσει έτσι ώστε ο πίνακας περιγραφικών 

χαρακτηριστικών να είναι σωστά δομημένος και ενημερωμένος. Για παράδειγμα, αν 

σε μερικές οντότητες το πεδίο της γεωλογίας (Name) είναι συμπληρωμένο ως 

«ασβεστόλιθος», σε κάποια άλλα ως «Ασβεστόλιθος» και σε μερικά ως 

«Ασβεστόλιθοι», το λογισμικό θα τις εκλάβει ως διαφορετικούς σχηματισμούς και θα 

τις απεικονίσει με διαφορετικό σύμβολο. 

 

 

Εικ. 4.39: Δημιουργία θεματικού χάρτη χρησιμοποιώντας τη μέθοδο Unique Values για το επίπεδο πληροφορίας των 
γεωλογικών σχηματισμών. Στο πεδίο Field 1 επιλέγουμε Name. Επιλέγοντας Add all Values, εμφανίζονται όλοι οι 
σχηματισμοί. Με αυτόν τον τρόπο, κάθε διαφορετικός σχηματισμός απεικονίζεται με διαφορετικό σύμβολο (π.χ. 
διαφορετικό χρώμα). Μπορούμε πατώντας στο σύμβολο ενός σχηματισμού να το αλλάξουμε (π.χ. να του αλλάξουμε 
χρώμα). 

 

Στη συνέχεια, θα δημιουργήσουμε ένα θεματικό χάρτη με εύρη τιμών, με βάση το 

μήκος των κλάδων του υδρογραφικού δικτύου. Επομένως, θα ακολουθήσετε παρόμοια 

διαδικασία για το επίπεδο πληροφορίας Rivers. Ως μέθοδο θεματικής χαρτογραφίας θα 

επιλέξετε τη Symbolize your layer by quantity και συγκεκριμένα το εργαλείο 

Graduated Colors .  

Στο πεδίο Field επιλέγετε το Length_m, βάσει του οποίου θα γίνει ο θεματικός 

χάρτης. Στο πεδίο Color scheme επιλέγετε την απόχρωση που εκφράζει καλύτερα τις 

πληροφορίες στο χάρτη (π.χ., την κλίμακα του μπλε, εφόσον αναφερόμαστε σε 

υδρογραφικό δίκτυο). Η ομαδοποίηση των τιμών που περιέχονται στο πεδίο Length_m 

του πίνακα περιγραφικών χαρακτηριστικών γίνεται από το πεδίο Method και Classes. 
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Στο πεδίο Method επιλέγετε τη μέθοδο που θα γίνει η ομαδοποίηση των τιμών. Στη 

συγκεκριμένη περίπτωση, για να δημιουργηθούν ίσα εύρη τιμών από το combo box, 

επιλέγετε Equal Interval και στο πεδίο Classes καθορίζετε τον αριθμό των ευρών 

τιμών, που στα πλαίσια της άσκησης θα είναι τέσσερα (Εικ. 4.44). 

 

 

Εικ. 4.40: Δημιουργία θεματικού χάρτη χρησιμοποιώντας τη μέθοδο Graduated Colors για το επίπεδο πληροφορίας 
Rivers. Στο πεδίο Στο πεδίο Field 1 επιλέγουμε Length_m. Επιλέγοντας Add all Values, εμφανίζονται όλες οι τάξεις 
του υδρογραφικού δικτύου. Με αυτόν τον τρόπο, κάθε διαφορετικής τάξεως κλάδος απεικονίζεται με διαφορετικό 
χρώμα. Μπορούμε πατώντας στο σύμβολο μιας τάξης να το αλλάξουμε (π.χ. να του αλλάξουμε χρώμα ή πάχος 
γραμμής). 

4.8 Προετοιμασία χάρτη για εκτύπωση 

Ο τελικός χάρτης που θα δημιουργηθεί πρέπει να πρέπει να πληροί συγκεκριμένες 

προϋποθέσεις, όπως να έχει κλίμακα, σύστημα αναφοράς, υπόμνημα, καθώς και 

διάφορα στοιχεία, όπως τίτλο, βορρά και πρόσθετες διευκρινίσεις (πνευματικά 

δικαιώματα, πηγές προέλευσης δεδομένων, σχόλια, φωτογραφίες, τους δημιουργούς 

κ.ά.).  

Για να προετοιμάσετε ένα Project σας σε μορφή χάρτη, θα μεταβείτε στο μενού 

Insert, στην ομάδα εργαλείων Project και θα επιλέξετε το εργαλείο New Layout  

(Εικ. 4.45).  
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Εικ. 4.41: Το εργαλείο New Layout βρίσκεται στο μενού Insert. Επιλέγοντας το εργαλείο αυτό, ενεργοποιείται το 
combo box με τις διαθέσιμες επιλογές. Μπορείτε π.χ. να επιλέξετε το μέγεθος του χάρτη σας, όπως Α4, Α5 κ.ά., καθώς 
επίσης και τον προσανατολισμό του (οριζόντιος ή κατακόρυφος). Επιλέγοντας Custom page size… έχετε την επιλογή 
να καθορίσετε εξ ολοκλήρου αυτά τα χαρακτηριστικά. 

 

Το συγκεκριμένο εργαλείο επιλέγεται ώστε να καθοριστεί το μέγεθος του χάρτη σε 

περίπτωση εκτύπωσης. Στα πλαίσια της άσκησης επιλέγετε από την ομάδα ISO – 

Portrait το μέγεθος Α4. Στη συνέχεια, στο χώρο της χαρτοσύνθεσης ενεργοποιείται 

νέο παράθυρο με όνομα Layout. Στο μενού Insert και στην ομάδα εργαλείων Map 

Frames, επιλέγετε το θεματικό χάρτη που δημιουργήσατε πριν στο παράθυρο του 

χάρτη (Εικ. 4.46). 
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Εικ. 4.42: Για να εμφανιστεί η περιοχή του χάρτη, μεταβαίνετε στο μενού Insert και στην ομάδα εργαλείων Map 

Frames και επιλέγετε το θεματικό χάρτη που δημιουργήσατε πριν στο παράθυρο του χάρτη (το όνομα του χάρτη έχει 
ως όνομα την κλίμακα του χάρτη). 

Στη συνεχεία, με το εργαλείο Select  (που ενεργοποιείται αυτόματα), 

σχεδιάζετε την περιοχή όπου θα εμφανιστεί ο χάρτης εντός των ορίων του Layout (Εικ. 

4.47). Αν ο χάρτης δεν είναι εστιασμένος σωστά (Εικ. 4.47), μπορείτε να 

χρησιμοποιήσετε στο μενού Map Frame και στην ομάδα εργαλείων Map το εργαλείο 

Activate  (Εικ. 4.48 και 4.49), έτσι ώστε να αλλάξει η κλίμακα και η θέση των 

γεωγραφικών δεδομένων στο πλαίσιο του χάρτη. Στη συνέχεια, στο νέο μενού, Layout 

επιλέγετε το Close Activation . 

 

Εικ. 4.43: Επιλέγοντας Layout (βλ. Εικ. 4.46), επιλέγουμε την περιοχή στο παράθυρο Layout όπου θα εμφανιστεί ο 
θεματικός χάρτης. Στη συγκεκριμένη περίπτωση, ο χάρτης δεν είναι εστιασμένος σωστά. 

 

 

Εικ. 4.44: Αν ο χάρτης δεν είναι εστιασμένος σωστά (Εικ. 4.47), μεταβαίνετε στο μενού Map Frame και στην ομάδα 
εργαλείων Map και χρησιμοποιείτε το εργαλείο Activate. Μεταβάλλετε τη θέση και την κλίμακα του χάρτη έτσι ώστε 
να απεικονιστεί αυτό που θέλετε σωστά (για λεπτομέρειες, βλ. υποκεφ. 2.1). 
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Εικ. 4.45: Πλέον, ο χάρτης είναι εστιασμένος με τέτοιον τρόπο ώστε να είναι ορατό το σύνολο της πληροφορίας για 
την περιοχή μελέτης. 

 

Από το μενού Insert, εισάγονται στην περιοχή του χάρτη ο βορράς 

(προσανατολισμός), η κλίμακα και το υπόμνημα. Ο βορράς εισάγεται από την ομάδα 

εργαλείων Map Surrounds με το εργαλείο North Arrow , η κλίμακα εισάγεται από 

την ομάδα εργαλείων Map Surrounds με το εργαλείο Scale Bar  και το υπόμνημα 

εισάγεται από την ομάδα εργαλείων Map Surrounds με το εργαλείο Legend .  

Για τα εργαλεία North Arrow και Scale Bar από το combo box, επιλέγετε το 

επιθυμητό σύμβολο βορρά (Εικ. 4.50) και την επιθυμητή κλίμακα (Εικ. 4.51). Με την 

επιλογή ενός από τα εργαλεία αυτά, θα χρειαστεί να ορίσετε την περιοχή στην οποία 

θα σχεδιαστούν, όπως κάνατε και στο Layout (Εικ. 4.52). Ένας χάρτης πρέπει 

οπωσδήποτε να περιέχει υπόμνημα, το οποίο θα επεξηγεί όλα εκείνα τα σύμβολα, 

χρώματα κ.ά. που εμφανίζονται σε αυτόν, έτσι ώστε να είναι σαφές στον αναγνώστη τι 

σημαίνει το κάθε σύμβολο του χάρτη.  
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Εικ. 4.46: Από το combo box του εργαλείου North Arrow επιλέγετε το σύμβολο του προσανατολισμού του χάρτη που 
επιθυμείτε. 

  

 

Εικ. 4.47: Από το combo box του εργαλείου Scale Bar επιλέγετε το σύμβολο της κλίμακας που επιθυμείτε. 
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Εικ. 4.48: Επιλέγοντας το εργαλείο Legend ορίζετε τα όρια του υπομνήματος στο παράθυρο του Layout. 

 

Επιλέγοντας κάθε στοιχείο αναδύεται το παράθυρο διαλόγου Element North Arrow 

(Εικ. 4.53), Element Scale Bar (Εικ. 4.54) και Element Legend (Εικ. 4.55) για το βορρά, 

την κλίμακα και το υπόμνημα αντίστοιχα, ώστε να γίνει μορφοποίησή τους (μέγεθος, 

χρώμα, φόντο κ.ά.). Εναλλακτικά, εμφανίζεται το παράθυρο διαλόγου Format North 

Arrow, Format Scale Bar και Format Legend με δεξί κλικ στο εκάστοτε στοιχείο από 

το διαχειριστή επιπέδων πληροφορίας και επιλέγοντας την εντολή Properties.  
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Εικ. 4.49: Το παράθυρο διαλόγου του εργαλείου North Arrow, μέσα από το οποίο μπορείτε να καθορίσετε τα 
χαρακτηριστικά του, όπως σύμβολο, χρώμα, μέγεθος, φόντο κ.ά. 
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Εικ. 4.50: Το παράθυρο διαλόγου του εργαλείου Scale Bar, μέσα από το οποίο μπορείτε να καθορίσετε τα 
χαρακτηριστικά του, όπως σύμβολο, χρώμα, μέγεθος, φόντο κ.ά. 
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Εικ. 4.51: Το παράθυρο διαλόγου του εργαλείου Legend, μέσα από το οποίο μπορείτε να καθορίσετε τα χαρακτηριστικά 
του, όπως σύμβολο, χρώμα, μέγεθος, φόντο κ.ά. 
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Επιπλέον, είναι απαραίτητο ο τελικός χάρτης να περιέχει έναν κάνναβο 

συντεταγμένων (Grid). Για να γίνει αυτό, στο μενού Insert και στην ομάδα εργαλείων 

Map Frames, και έχοντας επιλεγμένο το Map Frame στο διαχειριστή επιπέδων 

πληροφορίας, επιλέγετε το εργαλείο Grid  (Εικ. 4.56). Από το combo box του 

εργαλείου Grid (Εικ. 4.57) επιλέγετε Graticule Grid (κάνναβος γεωγραφικών 

συντεταγμένων).  

 

  

Εικ. 4.52: Το εργαλείο Grid εντοπίζεται στο μενού Insert, στην ομάδα εργαλείων Map Frames. 

 

 

Εικ. 4.53: Από το εργαλείο Grid επιλέγετε τη μορφή του καννάβου συντεταγμένων. 

 

Στο αναδυόμενο παράθυρο Element Map Grid ορίζετε τα διάφορα χαρακτηριστικά 

του Grid, όπως το διάστημα του καννάβου, καθώς και τη μορφή απεικόνισής του στο 

χάρτη (Εικ. 4.58).  
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Εικ. 4.54: Παράθυρο διαλόγου του εργαλείου Map Frame. Εδώ συμπληρώνετε τα διάφορα χαρακτηριστικά του Grid, 
όπως το διάστημα του καννάβου, καθώς και τη μορφή απεικόνισής του στο χάρτη.  
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Αφού ολοκληρωθεί η μορφοποίηση του χάρτη (Εικ. 4.59), μπορείτε να τον 

αποθηκεύσετε υπό μορφή εικόνας (JPEG, TIFF κ.ά.). Στο μενού Share, επιλέγετε το 

εργαλείο Export Layout  ώστε να ενεργοποιηθεί το ομώνυμο παράθυρο διαλόγου 

Export Layout (Εικ. 4.60). Στο πεδίο File Type επιλέγετε το είδος του αρχείου που θα 

εξαχθεί (συνήθως JPG ή TIFF). Στο πεδίο Name ορίζετε το όνομα με το οποίο θα 

αποθηκευτεί το αρχείο και το φάκελο στον οποίον θα αποθηκευτεί. Στο πεδίο Quality 

επιλέγετε την ποιότητα του αρχείου που θα εξαχθεί και στο πεδίο Resolution ορίζετε 

την ανάλυση της εικόνας που θα δημιουργηθεί (π.χ. 300 DPI) (Εικ. 4.60). 

 

 

Εικ. 4.55: Μετά την τοποθέτηση βορρά, κλίμακας, υπομνήματος και καννάβου ο χάρτης είναι έτοιμος για εκτύπωση ή 
για αποθήκευση σε μορφή εικόνας. 
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Εικ. 4.56: Το παράθυρο διαλόγου Export Layout, μέσα από το οποίο μπορείτε να εξαγάγετε το χάρτη σας σαν εικόνα. 
Στο πεδίο File Type επιλέγετε το είδος του αρχείου που θα εξαχθεί (συνήθως JPG ή TIFF). Στο πεδίο Name ορίζετε 
το όνομα με το οποίο θα αποθηκευτεί το αρχείο και το φάκελο στον οποίον θα αποθηκευτεί. Στο πεδίο Quality επιλέγετε 
την ποιότητα του αρχείου που θα εξαχθεί και στο πεδίο Resolution ορίζετε την ανάλυση της εικόνας που θα 
δημιουργηθεί (π.χ. 300 DPI). 
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4.9 Ζώνες επιρροής (Buffer) 
Περιβάλλουσες ζώνες ή ζώνες επιρροής (buffers) είναι επιφάνειες (πολύγωνα) που 

περικλείουν ένα επίπεδο πληροφορίας και τα όριά τους απέχουν συγκεκριμένη 

απόσταση από αυτό, την οποίαν καθορίζουμε εμείς κατά περίπτωση. Για παράδειγμα, 

μπορούμε να δημιουργήσετε ζώνες επιρροής των οποίων τα όρια θα απέχουν απόσταση 

3 km από κάθε κλάδο υδρογραφικού δικτύου. 

Οι ζώνες επιρροής μπορεί να περιβάλλουν μια γραμμή, μια επιφάνεια ή ακόμη και 

ένα σημείο. Όσο μεγαλύτερος είναι ο βαθμός επιρροής του, τόσο μεγαλύτερο είναι το 

buffer. Τα buffer χρησιμοποιούνται συχνά σε μοντέλα κινδύνου, όπως για παράδειγμα 

κατολισθητικού, όπου, για ορισμένες παραμέτρους που επηρεάζουν τον κατολισθητικό 

κίνδυνο δημιουργούνται ζώνες επιρροής. Ένα άλλο χαρακτηριστικό παράδειγμα 

αφορά στη σεισμολογία. Μπορούμε έτσι να δημιουργήσουμε διάφορα Buffers γύρω 

από μία σεισμική εστία, όπου όσο μειώνεται η απόσταση από την εστία, δηλαδή το 

buffer, τόσο μεγαλύτερες ζημιές αναμένουμε λόγω του σεισμού. 

Υπάρχουν διάφοροι τρόποι για να δημιουργηθούν ζώνες επιρροής. Εμείς θα 

δημιουργήσουμε ζώνες επιρροής για το υδρογραφικό δίκτυο. Ο πιο απλός είναι να 

μεταβείτε στο μενού Analysis στην ομάδα εργαλείων Geoprocessing και να επιλέξετε 

το εργαλείο Buffer  . Εναλλακτικά, μπορείτε να το ενεργοποιήσετε 

ακολουθώντας τη διαδρομή (Toolboxes → Analysis Tools → Proximity → Buffer). 

Μετά την ενεργοποίηση του εργαλείου, στο ομώνυμο αναδυόμενο παράθυρο, στην 

καρτέλα Parameters, συμπληρώνετε τα πεδία (Εικ. 4.61): 

▪ Input Features: Επιλέγετε το επίπεδο πληροφορίας βάσει του οποίου θα 

δημιουργηθούν οι ζώνες επιρροής (Rivers). 

▪ Output Feature Class: Επιλέγετε το όνομα του αρχείου που θα δημιουργηθεί 

και το φάκελο στον οποίον θα αποθηκευτεί το αρχείο. 

▪ Distance [value of field]: Επιλέγετε την απόσταση που θα έχουν οι ζώνες 

επιρροής από τους κλάδους του υδρογραφικού δικτύου. Για την άσκησή σας, 

θα συμπληρώσετε 20 meters. 

▪ Side Type: Καθορίζετε αν θα δημιουργηθεί ζώνη δεξιά, αριστερά ή και από τις 

δύο πλευρές της κάθε οντότητας. Στα πλαίσια της εκπαίδευσής, σας επιλέγετε 

και από τις δύο πλευρές, δηλαδή Full.  
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▪ End Type: Καθορίζετε το σχήμα που θα έχουν οι ζώνες επιρροής που θα 

δημιουργηθούν γύρω από κάθε κλάδο, δηλαδή κυκλικό (Round) ή τετράγωνο 

(Flat). Στα πλαίσια της εκπαίδευσής σας επιλέγετε Round.  

▪ Method: Επιλέγετε μεταξύ προβολής στο επίπεδο (Planar) και γεωδαιτικής 

(Geodetic). Στα πλαίσια της εκπαίδευσής σας επιλέγετε Planar. 

▪ Dissolve Type: Επιλέγετε τον τύπο μεταξύ των No Dissolve, Dissolve all output 

features into a single feature και Dissolve features using the listed fields' unique 

values or combination of values. Στα πλαίσια της εκπαίδευσής σας επιλέγετε 

No Dissolve. Η διαφορά ανάμεσα στις δύο πρώτες μεθόδους φαίνεται στον 

παρακάτω πίνακα: 

 

Μέθοδος 

ζωνών 
επιρροής 

Σημειακό 

επίπεδο 
πληροφορίας 

Γραμμικό 

επίπεδο 
πληροφορίας 

Πολυγωνικό 

επίπεδο 
πληροφορίας 

 

   

No 

Dissolve    

Dissolve 

all output 

features 

into a 

single 

feature 

   

 

Στη συνέχεια, μεταβαίνετε στην καρτέλα Environments και συμπληρώνεται το πεδίο 

Output Coordinate System με το προβολικό σύστημα το οποίο θα έχουν οι ζώνες 

επιρροής (δηλαδή Greek_Grid) (Εικ. 4.62). Στη συνέχεια πιέζετε την εντολή Run, ώστε 

να ολοκληρωθεί η διαδικασία. 
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Εικ. 4.57: Στο παράθυρο διαλόγου Buffer, συμπληρώνονται τα πεδία ώστε να δημιουργηθούν οι ζώνες επιρροής, όπως 
περιγράφηκε προηγουμένως. 
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Εικ. 4.58: Στο παράθυρο διαλόγου Buffer, μεταβαίνοντας στην καρτέλα Environments, συμπληρώνετε το πεδίο Output 

Coordinate System με το προβολικό σύστημα που θα έχουν οι ζώνες επιρροής που θα δημιουργηθούν, δηλαδή 
Greek_Grid. Στη συνέχεια πιέζετε την εντολή Run. 
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Αφότου ολοκληρωθεί η διαδικασία αυτή, δημιουργείται ένα νέο πολυγωνικό 

επίπεδο πληροφορίας που περιέχει τις ζώνες επιρροής γύρω από τις οντότητες του 

χάρτη, με τα χαρακτηριστικά που καθορίστηκαν κατά τη δημιουργία τους. Η βάση 

δεδομένων του νέου αυτού επιπέδου πληροφορίας περιλαμβάνει νέα πεδία 

ενημερωμένα με πληροφορίες σχετικές με τις ζώνες επιρροής (Εικ. 4.63). 

 

 

Εικ. 4.59: Μετά τη δημιουργία των ζωνών επιρροής έχει δημιουργηθεί μεταξύ άλλων μία νέα στήλη στον πίνακα 
περιγραφικών χαρακτηριστικών του επιπέδου πληροφορίας Rivers με την απόσταση που ορίστηκε κατά τη δημιουργία 
τους. 
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4.10 Στατιστική επεξεργασία 

Η στατιστική επεξεργασία λαμβάνει χώρα μέσω του μενού Data και της ομάδας 

εργαλείων Visualize, με το εργαλείο Create Chart  (Εικ. 4.64). Από το combo 

box (Εικ. 4.64) του εργαλείου Create Chart μπορείτε να επιλέξετε ανάμεσα σε διάφορα 

διαγράμματα, όπως το γράφημα στηλών ή ράβδων Bar Chart , γραμμικό γράφημα 

Line Chart , γράφημα διασποράς Scatter Plot , Scatter Plot Matrix , 

γραφική παράσταση πιθανότητας QQ Plot (Quantile – Quantile Plot) , 

ιστόγραμμα Histogram , θηκόγραμμα Box Plot , Data Clock , Calendar 

Heat Chart και Profile Graph . Εναλλακτικά, με δεξί κλικ στο επίπεδο 

πληροφορίας από το διαχειριστή επιπέδων πληροφορίας, επιλέγετε την εντολή Create 

Chart. 

 

 

Εικ. 4.60: Το εργαλείο Create Chart βρίσκεται στο μενού Data στην ομάδα εργαλείων Visualize. Στο combo box του 

εργαλείου υπάρχουν οι επιλογές διαγραμμάτων Bar Chart, Line Chart, Scatter Plot, Scatter Plot Matrix, QQ Plot, 

Histogram, Box Plot, Data Clock, Calendar Heat Chart και Profile Graph. Από τα εικονίδιά τους μπορείτε να 
καταλάβετε το είδος τους. Για την άσκησή σας, θα επιλέξετε το ιστόγραμμα (Histogram). 
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Στα πλαίσια της εκπαίδευσής σας επιλέγετε για το επίπεδο πληροφορίας Rivers το 

ιστόγραμμα (Histogram), ώστε να ενεργοποιηθεί το παράθυρο διαλόγου Chart 

Properties – Rivers (Εικ. 4.65). Στην καρτέλα Data, στο πεδίο Number, συμπληρώνετε 

το πεδίο Length_m του πίνακα περιγραφικών χαρακτηριστικών και στο πεδίο With 

transformation επιλέγετε None. Ταυτόχρονα, έχει ενεργοποιηθεί το παράθυρο Rivers – 

Distribution of Length_m στο οποίο δημιουργείται το γράφημα (Εικ. 4.66). 

Μεταβαίνοντας στην καρτέλα General, καθορίζετε τον τίτλο του γραφήματος, του 

υπομνήματος και των αξόνων. Τέλος, η αποθήκευση του γραφήματος γίνεται μέσω της 

εντολής Export Chart . 
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Εικ. 4.61: Το παράθυρο διαλόγου Chart Properties. Από το παράθυρο αυτό γίνεται η διαχείριση των δεδομένων, των 
αξόνων και όλων των στοιχείων του διαγράμματος. 
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Εικ. 4.62: Κατά τη δημιουργία του διαγράμματος ενεργοποιείται το παράθυρο Rivers – Distribution of Length_m στο 
οποίο εμφανίζονται οι αλλαγές που γίνονται στο παράθυρο Chart Properties. 
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Ενότητα 5 – Ανάλυση τριμεταβλητών δεδομένων   
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5.1 Εισαγωγή 

Μέσω των GIS υπάρχει η δυνατότητα για ανάλυση τριμεταβλητών δεδομένων. Οι 

δύο μεταβλητές είναι οι γεωγραφικές συντεταγμένες που καθορίζουν τη θέση κάθε 

οντότητας στο χάρτη. Η τρίτη μεταβλητή είναι αποθηκευμένη στη βάση δεδομένων και 

αφορά σε μια περιγραφική πληροφορία (υψόμετρο, κάποια κλιματική παράμετρο, έναν 

παράγοντα μόλυνσης κ.ά.).  

Ανάλογα με το είδος της τρίτης μεταβλητής και τη γεωγραφική κατανομή των 

πρωτογενών δεδομένων, επιλέγεται η κατάλληλη μέθοδος προσομοίωσης. Ο 

συνηθέστερος χάρτης απεικόνισης τριών μεταβλητών είναι ο χάρτης ψηφιακού 

μοντέλου αναγλύφου (Digital Elevation Model – DEM). Εκεί, η τρίτη μεταβλητή είναι 

το υψόμετρο ή το βάθος. Παρακάτω θα αναφερθούν τα επιμέρους βήματα ανάλυσης 

τριμεταβλητών δεδομένων, τα οποία είναι όμοια ανεξάρτητα από τη φύση της τρίτης 

μεταβλητής. Συγκεκριμένα, θα δημιουργήσουμε ένα ψηφιακό μοντέλο αναγλύφου 

(Digital Elevation Model – DEM) 

Τα αρχεία που προκύπτουν από τη δημιουργία και ανάλυση τριμεταβλητών 

δεδομένων ονομάζονται raster grid και έχουν αποθηκευμένη την πληροφορία τους σε 

εικονοστοιχεία (pixel). Προκύπτουν από την προσομοίωση των αρχικών δεδομένων, 

έτσι ώστε να υπολογιστούν οι τιμές της τρίτης μεταβλητής σε όλη την έκταση του 

χάρτη, ακόμη και στα σημεία που δεν υπήρχαν αρχικά δεδομένα. Για παράδειγμα, το 

ψηφιακό μοντέλο αναγλύφου δημιουργείται με τη βοήθεια των ισοϋψών καμπυλών. 

Αυτές περιέχουν την πληροφορία του υψομέτρου κατά μήκος τους, αλλά μεταξύ τους 

δεν υπάρχει πληροφορία. Το λογισμικό αξιοποιεί διάφορες μαθηματικές σχέσεις ώστε 

να υπολογίσει με προσέγγιση τα υψόμετρα σε όλα τα σημεία ανάμεσα σε δύο 

διαδοχικές ισοϋψείς με βάση τα υψόμετρά τους. 
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5.2 Ψηφιακό Μοντέλο αναγλύφου 

Για τη δημιουργία του ψηφιακού μοντέλου αναγλύφου θα χρησιμοποιηθεί το 

εργαλείο Topo to Raster. Το συγκεκριμένο εργαλείο βρίσκεται στο μενού Analysis και 

στην ομάδα εργαλείων Geoprocessing. Επιλέγετε τα εργαλεία Tools  και 

ακολουθείτε τη διαδρομή Spatial Analyst Tools → Interpolation → Topo to Raster. Στο 

ομώνυμο αναδυόμενο παράθυρο Topo to Raster (Εικ. 5.1) και στην καρτέλα 

Parameters, από το πεδίο Input feature data επιλέγετε τα επίπεδα πληροφορίας που θα 

χρησιμοποιηθούν για τη δημιουργία του ψηφιακού μοντέλου αναγλύφου. 

Θα συμπεριληφθούν όλα εκείνα τα επίπεδα πληροφορίας που μπορεί να δώσουν 

άμεση ή έμμεση πληροφορία για το ανάγλυφο της περιοχής μελέτης, με στόχο την πιο 

ρεαλιστική διαμόρφωση της μορφής του φυσικού γήινου αναγλύφου. Έτσι, αρχικά, 

μέσω του πεδίου Feature layer εισάγετε το πεδίο των ισοϋψών (Contours_50m). Το 

πεδίο Field  το συμπληρώνετε με το όνομα του πεδίου του επιπέδου πληροφορίας των 

ισοϋψών που περιέχει την πληροφορία του υψομέτρου, δηλαδή το ALTITUDE_M. 

Μέσω του πεδίου Type καθορίζετε τον τύπο του επιπέδου πληροφορίας σε σχέση με το 

DEM, στην προκειμένη περίπτωση Contour (Εικ. 5.2). 
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Εικ. 5.1: Το αναδυόμενο παράθυρο εργαλείου Topo to Raster. Συμπληρώνετε στα πεδία Input feature data και 
συγκεκριμένα στο Feature Layer το επίπεδο των ισοϋψών (Contours_50m). Στο πεδίο Field συμπληρώνετε το πεδίο 
του επιπέδου πληροφορίας των ισοϋψών που περιέχει την πληροφορία του υψομέτρου, δηλαδή το ALTITUDE_M. 

Μέσω του πεδίου Type καθορίζετε τον τύπο του επιπέδου πληροφορίας σε σχέση με το DEM, στην προκειμένη 
περίπτωση Contour (βλ. Εικ. 5.2). 
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Εικ. 5.2: Εισαγωγή των ισοϋψών καμπυλών ως επιπέδου πληροφορίας στο οποίο θα βασιστεί το ψηφιακό μοντέλο 
αναγλύφου. 
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Για την προσθήκη νέων επιπέδων πληροφορίας, επιλέγετε την εντολή Add 

another ώστε να εμφανιστεί o χώρος προσθήκης επιπέδου πληροφορίας. Μετά τις 

ισοϋψείς, θα προσθέσουμε με τον ίδιο τρόπο τα υψομετρικά και τριγωνομετρικά 

σημεία (Altitude_points), ο τύπος των οποίων (Type) θα είναι Point elevation. Θα 

προσθέσουμε επίσης το όριο της περιοχής μελέτης Study_area (Type: Boundary) έτσι 

ώστε το DEM να πάρει το σχήμα της και το υδρογραφικό δίκτυο Rivers (Type: Stream), 

καθώς η ροή του επηρεάζει τη μορφολογία της. Ανάλογα με τα δεδομένα μας, 

μπορούμε να προσθέσουμε και άλλα επίπεδα πληροφορίας, όπως λίμνες (Type: Lake), 

βαθυμετρικά σημεία (Type: Point elevation), ισοβαθείς καμπύλες (Type: Contours), 

κρημνούς (Type: Cliff), τοπογραφικά βυθίσματα (Type: Sink) και ακτογραμμή (Type: 

Coast). Επιπλέον, μπορούμε να αποκλείσουμε ένα επίπεδο πληροφορίας από τη 

διαδικασία (Exclusion).  

Για κάθε ένα από αυτά θα πρέπει να οριστεί το πεδίο Field, από το οποίο θα αντληθεί 

η πληροφορία καθώς και ο τύπος του επιπέδου πληροφορίας (Type). Για τα υψομετρικά 

σημεία (Altitude_points) ο τύπος του επιπέδου πληροφορίας θα είναι Point Elevation 

(Εικ. 5.3) και η πληροφορία θα αντληθεί από το πεδίο ALTITUDE_M (Εικ. 5.3). Για 

τις ισοϋψείς καμπύλες Contours 50m ο τύπος του επιπέδου πληροφορίας θα είναι 

Contour (Εικ. 5.3) και η πληροφορία θα αντληθεί από το πεδίο ALTITUDE_M (Εικ. 

5.3). Για το υδρογραφικό δίκτυο (Rivers) ο τύπος του επιπέδου πληροφορίας θα είναι 

Stream (Εικ. 5.3) και το πεδίο Field δε δέχεται πληροφορία (αυτόματη 

απενεργοποίηση). Τέλος, για τα όρια της περιοχής μελέτης Study_Area ο τύπος του 

επιπέδου πληροφορίας θα είναι Boundary (Εικ. 5.3) και το πεδίο Field δε δέχεται 

πληροφορία (αυτόματη απενεργοποίηση) (Εικ. 5.3). 

Στο πεδίο Output surface raster ορίζετε τη θέση στην οποία θα αποθηκευτεί το 

αρχείο που θα δημιουργηθεί, καθώς και το όνομά του (Εικ. 5.3). Το πεδίο Output cell 

size είναι ήδη συμπληρωμένο με το μέγεθος της κυψελίδας του τρισδιάστατου 

μοντέλου που θα δημιουργηθεί, αλλά μπορείτε να το τροποποιήσετε και χειροκίνητα 

(Εικ. 5.3). Μεταβαίνοντας στην καρτέλα Environments, επιλέγετε από το πεδίο Output 

Coordinate System το σύστημα συντεταγμένων που θα έχει το ψηφιακό μοντέλο 

αναγλύφου, δηλαδή το Greek_Grid (Εικ. 5.4). Στη συνέχεια με την επιλογή της εντολής 

Run, δημιουργείται το ψηφιακό μοντέλο αναγλύφου (Εικ. 5.5). 
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Εικ. 5.3:Δημιουργία ψηφιακού μοντέλου αναγλύφου (DEM) με τη χρήση διαφόρων επιπέδων πληροφορίας. Στο 
παράδειγμα αυτό έχουμε εισαγάγει τις ισοϋψείς, το υδρογραφικό δίκτυο, τα τριγωνομετρικά σημεία και τα όρια της 
περιοχής μελέτης,. Ανάλογα με τα δεδομένα μας, θα μπορούσαμε να εισαγάγουμε και λίμνες, κρημνούς, τοπογραφικά 
βυθίσματα, ισοβαθείς καμπύλες και ακτογραμμή. Σε κάθε περίπτωση, πρέπει (μέσω του πεδίου Type) να καθορίσουμε 
το είδος του εκάστοτε επιπέδου πληροφορίας από μία σειρά επιλογών όπως Altitude points, Contour, Stream, 

Boundary κ.ά. Στο πεδίο Output surface raster συμπληρώνουμε τη θέση στην οποία θα αποθηκευτεί το DEM, καθώς 
και το όνομά του. Στο πεδίο Output cell size είναι αυτόματα συμπληρωμένο το μέγεθος των κυψελίδων, αλλά μπορείτε 
να το τροποποιήσετε χειροκίνητα. 
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Εικ. 5.4: Αφότου ολοκληρώσετε τα προηγούμενα βήματα (βλ. Εικ. 5.3), μεταβαίνετε στην καρτέλα Environments και 
στο πεδίο Output Coordinate Systems όπου καθορίζετε το προβολικό σύστημα του αρχείου που θα δημιουργηθεί το 
Greek_Grid. Κάνετε κλικ στην εντολή Run για να ολοκληρωθεί η διαδικασία. 
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Εικ. 5.5: Το ψηφιακό μοντέλο αναγλύφου (DEM) που δημιουργήθηκε. Οι τιμές των υψομέτρων ομαδοποιήθηκαν σε 9 
εύρη τιμών, όπως φαίνεται στο διαχειριστή επιπέδων πληροφορίας, αλλά αυτό μπορεί να τροποποιηθεί. 

 

Ο καθορισμός του τρόπου απεικόνισης του ψηφιακού μοντέλου αναγλύφου γίνεται 

μέσω του διαχειριστή επιπέδων πληροφορίας με δεξί κλικ στο επίπεδο πληροφορίας 

του DEM και επιλογή της εντολής Symbology . Στο ομώνυμο παράθυρο 

διαλόγου Symbology, στο πεδίο Primary Symbology, επιλέγετε ως μέθοδος θεματικής 

χαρτογραφίας τη μέθοδο με εύρη τιμών (Classify). Στο πεδίο Method ορίζετε τη μέθοδο 

με βάση την οποία θα γίνει ο συμβολισμός. 

Το λογισμικό σάς δίνει τη δυνατότητα επιλογής μεταξύ διαφόρων μεθόδων, όπως:  

▪ Απόκλιση τιμών από τους μέσους των άλλων τάξεων τιμών (Natural Breaks 

(Jenks)) , σύμφωνα με την οποίαν οι τάξεις που δημιουργούνται 

βασίζονται σε φυσικές ομαδοποιήσεις που εξαρτώνται από τα δεδομένα.  

▪ Ίσου πλήθους παρατηρήσεις ανά εύρος τιμών (Quantile) , όπου κάθε 

τάξη περιέχει έναν ίσο αριθμό χαρακτηριστικών – γραμμικά κατανεμημένα 

δεδομένα.  
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▪ Ίσου εύρους (Equal interval) , για τη δημιουργία τάξεων ίσου 

διαστήματος. 

▪ Προκαθορισμένο διάστημα (Defined interval) , για καθορισμό του 

μεγέθους των τάξεων ώστε να οριστεί μια σειρά κατηγοριών με το ίδιο εύρος 

τιμών. 

▪ Eπιλογή ερευνητή (Manual interval) , για χειροκίνητη δημιουργία 

τάξεων. 

▪ Γεωμετρικό διάστημα (Geometrical interval) , για τη δημιουργία 

γεωμετρικών τάξεων. 

▪ Τυπικών αποκλίσεων από το μέσο (Standard deviation) , για τη 

δημιουργία τάξεων με βάση την τυπική απόκλιση.  

Στα πλαίσια της άσκησης επιλέγετε τη μέθοδο Natural Breaks (Jenks) . Στο 

πεδίο Classes ορίζετε τον αριθμό των κλάσεων που θα δημιουργηθούν. Στα πλαίσια 

της άσκησης θα δημιουργήσετε 7 κλάσεις. Στο πεδίο Color scheme επιλέγετε μία 

αντιπροσωπευτική χρωματική παλέτα (προτείνεται η Elevation #3) (Εικ. 5.6). 
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Εικ. 5.6: Θεματικός υψομετρικός χάρτης όπως προκύπτει από το DEM, επιλέγοντας 7 εύρη τιμών, ο χωρισμός των 
οποίων έγινε με τη μέθοδο Natural Breaks (Jenks) (για το συμβολισμό των επιπέδων πληροφορίας, βλ. υποκεφ. 4.7). 
Η χρωματική παλέτα που επιλέχθηκε εδώ είναι η Elevation #3. 

 

5.3 Χάρτης κλίσεων (Slope) 
Το λογισμικό έχει τη δυνατότητα να υπολογίζει τις κλίσεις της περιοχής βάσει του 

ψηφιακού μοντέλου αναγλύφου. Πρακτικά, υπολογίζει για κάθε κελί (cell) τη 

μεταβολή της τιμής του υψομέτρου συναρτήσει των τιμών των γειτονικών κελιών.  

Για τη δημιουργία χάρτη κλίσεων θα χρησιμοποιήσετε το εργαλείο Slope, το οποίο 

θα βρείτε στο μενού Analysis και στην ομάδα εργαλείων Geoprocessing, επιλέγοντας 

τα εργαλεία Tools και ακολουθώντας τη διαδρομή: Tools → Toolboxes → Spatial 

Analyst Tools → Surface → Slope. Στο ομώνυμο παράθυρο διαλόγου Slope (Εικ. 5.7), 

στο πεδίο Input raster καθορίζετε το ψηφιδωτό αρχείο από το οποίο θα αντληθεί η 

πληροφορία, που στη συγκεκριμένη περίπτωση είναι το ψηφιακό μοντέλο αναγλύφου 

που δημιουργήσατε (Εικ. 5.8). Στη συνέχεια, στο πεδίο Output raster καθορίζετε το 

χώρο στον οποίον θα αποθηκευτεί το νέο αρχείο που θα προκύψει (Εικ. 5.8). Στο πεδίο 

Output measurement καθορίζετε τις μονάδες μέτρησης της κλίσης, που μπορεί να είναι 

μοίρες (degree) ή ποσοστό % (percent rise) (Εικ. 5.8). Για τις ανάγκες της άσκησης, 

θα επιλέξετε μοίρες. Μόλις ολοκληρώσετε αυτά τα βήματα, πιέστε την εντολή Run. 

Παρατηρήστε το παράθυρο του χάρτη (Εικ. 5.9). 
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Εικ. 5.7: Το παράθυρο διαλόγου του εργαλείου Slope, το οποίο ενεργοποιείται αν επιλέξετε το εργαλείο Slope, το οποίο 
θα βρείτε ακολουθώντας τη διαδρομή: Analysis → Geoprocessing → Tools → Toolboxes → Spatial Analyst Tools 

→ Surface. Συμπληρώνετε τα πεδία ως εξής: στο πεδίο Input raster καθορίζετε το ψηφιδωτό αρχείο από το οποίο θα 
αντληθεί η πληροφορία, δηλαδή το DEM που δημιουργήσατε. Στο πεδίο Output raster καθορίζετε το χώρο στον οποίον 
θα αποθηκευτεί το νέο αρχείο που θα προκύψει. Στο πεδίο Output measurement καθορίζετε τις μονάδες μέτρησης της 
κλίσης, δηλαδή μοίρες (degree). 
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Εικ. 5.8: Αφότου συμπληρώσετε τα πεδία του παραθύρου Slope (βλ. Εικ. 5.7), πιέζετε Run ώστε να εκτελεστεί το 
εργαλείο. 
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Εικ. 5.9: Χάρτης μορφολογικών κλίσεων βασισμένος στο DEM. Οι τιμές της κλίσης έχουν χωριστεί σε 7 εύρη τιμών 
με τη μέθοδο Natural Breaks (Jenks) (βλ. υποκεφ. 5.2). 

 

5.4 Χάρτης προσανατολισμού κλίσεων (Aspect) 

Ο χάρτης προσανατολισμού κλίσεων ή αζιμούθιο (aspect) δημιουργείται από το 

συνδυασμό ενός οριζόντιου και ενός κατακόρυφου φίλτρου που εφαρμόζεται 

απευθείας στο ψηφιακό μοντέλο αναγλύφου. Με αυτό το εργαλείο καθορίζεται το 

αζιμούθιο (η θέση του ήλιου σε σχέση με την περιοχή μελέτης), το σχετικό ύψος του 

στον ορίζοντα και ο παράγοντας Ζ factor. Το εργαλείο ουσιαστικά υπολογίζει τη 

διεύθυνση των πρανών. Οι τιμές που προκύπτουν με την εφαρμογή του είναι ο 

προσανατολισμός της κεκλιμένης επιφάνειας εκφρασμένος σε μοίρες.  

Για τη δημιουργία χάρτη προσανατολισμού κλίσεων θα χρησιμοποιήσετε το 

εργαλείο Aspect (Analysis → Geoprocessing → Tools → Toolboxes → Spatial Analyst 

Tools → Surface → Aspect). Στο ομώνυμο παράθυρο διαλόγου Aspect (Εικ. 5.10), στο 

πεδίο Input raster καθορίζετε το ψηφιδωτό αρχείο από το οποίο θα αντληθεί η 

πληροφορία, που στη συγκεκριμένη περίπτωση είναι το ψηφιακό μοντέλο αναγλύφου 

που δημιουργήσατε (Εικ. 5.11). Στη συνέχεια, στο πεδίο Output raster καθορίζετε το 

χώρο στον οποίον θα αποθηκευτεί το νέο αρχείο που θα προκύψει (Εικ. 5.11). Μόλις 

ολοκληρώσετε αυτά τα βήματα, πιέστε την εντολή Run. Παρατηρήστε το παράθυρο 

του χάρτη (Εικ. 5.12). 
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Εικ. 5.10: Το παράθυρο διαλόγου του εργαλείου Aspect, το οποίο ενεργοποιείται αν επιλέξετε το εργαλείο Aspect, το 

οποίο θα βρείτε ακολουθώντας τη διαδρομή: Analysis → Geoprocessing → Tools → Toolboxes → Spatial Analyst 

Tools → Surface. Συμπληρώνετε τα πεδία ως εξής: στο πεδίο Input raster καθορίζετε το ψηφιδωτό αρχείο από το 
οποίο θα αντληθεί η πληροφορία, δηλαδή το DEM που δημιουργήσατε. Στο πεδίο Output raster καθορίζετε το χώρο 
στον οποίον θα αποθηκευτεί το νέο αρχείο που θα προκύψει. 
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Εικ. 5.11: Αφότου συμπληρώσετε τα πεδία του παραθύρου Aspect (βλ. Εικ. 5.11), πιέζετε Run ώστε να εκτελεστεί το 
εργαλείο. 

 

 

Εικ. 5.12: Χάρτης προσανατολισμού κλίσεων. Οι τιμές αντιστοιχούν στη φορά κλίσης της επιφάνειας σε σχέση με το 
βορρά. Όπως φαίνεται και στο υπόμνημα, οι τιμές χωρίστηκαν σε 10 εύρη τιμών με βάση τη μέθοδο «επιλογή 
ερευνητή» (Manual interval). 
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5.5 Χάρτης σκίασης (Hillshade) 
Με το εργαλείο αυτό είναι δυνατή η σκίαση της επιφάνειας με σκοπό την 

παρουσίαση της υψομετρικής πληροφορίας η οποία λαμβάνεται από το DEM.  

Για τη δημιουργία χάρτη σκίασης με καθορισμένη τη θέση της φωτεινής πηγής, θα 

χρησιμοποιήσετε το εργαλείο Hillshade (Analysis → Geoprocessing → Tools → 

Toolboxes → Spatial Analyst Tools → Surface → Hillshade). Στο ομώνυμο παράθυρο 

διαλόγου Hillshade (Εικ. 5.13), στο πεδίο Input raster καθορίζετε το ψηφιδωτό αρχείο 

από το οποίο θα αντληθεί η πληροφορία, που στη συγκεκριμένη περίπτωση είναι το 

ψηφιακό μοντέλο αναγλύφου που δημιουργήσατε (Εικ. 5.14). Στη συνέχεια, στο πεδίο 

Output raster καθορίζετε το χώρο στον οποίον θα αποθηκευτεί το νέο αρχείο που θα 

προκύψει (Εικ. 5.14). Η θέση της φωτεινής πηγής, καθώς επίσης και το υψόμετρο της 

φωτεινής πηγής, είναι ήδη συμπληρωμένα στα πεδία Azimuth και Altitude αντίστοιχα 

και μπορούν να αλλαχθούν προαιρετικά (Εικ. 5.14). Προτείνεται ωστόσο για την 

άσκησή σας να μην τα τροποποιήσετε. Μόλις ολοκληρώσετε αυτά τα βήματα, πιέστε 

την εντολή Run. Παρατηρήστε το παράθυρο του χάρτη (Εικ. 5.15). 
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Εικ. 5.13: Το παράθυρο διαλόγου του εργαλείου Hillshade, το οποίο ενεργοποιείται αν επιλέξετε το εργαλείο 

Hillshade, το οποίο θα βρείτε ακολουθώντας τη διαδρομή: Analysis → Geoprocessing → Tools → Toolboxes → 

Spatial Analyst Tools → Surface. Συμπληρώνετε τα πεδία ως εξής: στο πεδίο Input raster καθορίζετε το ψηφιδωτό 
αρχείο από το οποίο θα αντληθεί η πληροφορία, δηλαδή το DEM που δημιουργήσατε. Στο πεδίο Output raster 
καθορίζετε το χώρο στον οποίον θα αποθηκευτεί το νέο αρχείο που θα προκύψει. Η θέση της φωτεινής πηγής, καθώς 
επίσης και το υψόμετρο της φωτεινής πηγής, είναι ήδη συμπληρωμένα στα πεδία Azimuth και Altitude αντίστοιχα. 
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Εικ. 5.14: Αφότου συμπληρώσετε τα πεδία του παραθύρου Hillshade (βλ. Εικ. 5.13), πιέζετε Run ώστε να εκτελεστεί 
το εργαλείο. 

 

 

Εικ. 5.15: Χάρτης σκίασης ή σκιασμένου αναγλύφου. Όπως φαίνεται και στο υπόμνημα, οι τιμές δε χωρίστηκαν σε 
εύρη, αλλά συμβολίστηκαν με τη μέθοδο Strech. 
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5.6 Δημιουργία ισομεγεθών καμπυλών (Contour) 

Χρησιμοποιώντας το raster grid αρχείο (DEM) που προέκυψε από την 

προσομοίωση των αρχικών δεδομένων, μπορείτε να δημιουργήσετε ένα vector επίπεδο 

πληροφορίας που αφορά στις ισομεγέθεις καμπύλες της τρίτης μεταβλητής (εν 

προκειμένω, στις ισοϋψείς). 

Στη συγκεκριμένη άσκηση, το raster grid αρχείο είναι το DEM και η τρίτη 

μεταβλητή αφορά στο υψόμετρο. Κατά συνέπεια, μπορούν να δημιουργηθούν ισοϋψείς 

καμπύλες με ισοδιάσταση που θα ορίσει ο χρήστης. Σε αυτό το σημείο θα πρέπει να 

γίνει σαφές ότι η ανάλυση του DEM (που εξαρτάται από την κλίμακα των αρχικών 

δεδομένων) καθορίζει την ισοδιάσταση που θα επιλεγεί. Για παράδειγμα, παρότι 

τεχνικά είναι εφικτό να δημιουργηθεί ένα DEM από δεδομένα κλίμακας 1:50.000 και 

εν συνεχεία να παραχθούν ισοϋψείς καμπύλες που αντιστοιχούν σε τοπογραφικό 

διάγραμμα 1:5.000, το αποτέλεσμα δε θα έχει την απαραίτητη ακρίβεια και κατά 

συνέπεια δε συνιστάται. 

Για τη δημιουργία χάρτη ισομεγεθών καμπυλών, η μεθοδολογία είναι η ίδια 

ανεξαρτήτως της τρίτης μεταβλητής. Από το μενού Analysis και την ομάδα εργαλείων 

Geoprocessing επιλέγετε τα εργαλεία Tools  και χρησιμοποιείτε τα εργαλεία 

Contour (Tools → Toolboxes → Spatial Analyst Tools → Surface → Contour). Στο 

ομώνυμο παράθυρο διαλόγου Contour (Εικ. 5.16), στο πεδίο Input raster καθορίζετε 

το ψηφιδωτό αρχείο από το οποίο θα αντληθεί η πληροφορία, που στη συγκεκριμένη 

περίπτωση είναι το ψηφιακό μοντέλο αναγλύφου που δημιουργήσατε (Εικ. 5.17). Στη 

συνέχεια, στο πεδίο Output raster καθορίζετε το χώρο στον οποίον θα αποθηκευτεί το 

νέο αρχείο που θα προκύψει (Εικ. 5.17).  

Στο πεδίο Contour interval καθορίζετε την ισοδιάσταση των ισοϋψών καμπυλών 

που θα δημιουργηθούν (Εικ. 5.17). Για τις ανάγκες της άσκησης, η ισοδιάσταση θα 

είναι τα 150 m (Εικ. 5.17). Μόλις ολοκληρώσετε αυτά τα βήματα, πιέστε την εντολή 

Run. Παρατηρήστε το παράθυρο του χάρτη (Εικ. 5.15). Παρατηρήστε το παράθυρο του 

χάρτη και το διαχειριστή επιπέδων πληροφορίας (Εικ. 5.18). 
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Εικ. 5.16: Το παράθυρο διαλόγου του εργαλείου Contour, το οποίο ενεργοποιείται αν επιλέξετε το εργαλείο Contour, 

το οποίο θα βρείτε ακολουθώντας τη διαδρομή: Analysis → Geoprocessing → Tools → Toolboxes → Spatial Analyst 

Tools → Contour. Συμπληρώνετε τα πεδία ως εξής: στο πεδίο Input raster καθορίζετε το ψηφιδωτό αρχείο από το 
οποίο θα αντληθεί η πληροφορία, δηλαδή το DEM που δημιουργήσατε. Στο πεδίο Output raster καθορίζετε το χώρο 
στον οποίον θα αποθηκευτεί το νέο αρχείο που θα προκύψει. Στο πεδίο Contour interval επιλέγετε την επιθυμητή 
ισοδιάσταση (σε μέτρα), δηλαδή 150. 
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Εικ. 5.17: Αφότου συμπληρώσετε τα πεδία του παραθύρου Contour (βλ. Εικ. 5.13), πιέζετε Run ώστε να εκτελεστεί το 
εργαλείο. 

. 

 

Εικ. 5.18: Οι ισοϋψείς καμπύλες με ισοδιάσταση 100 m που προέκυψαν από το raster grid επίπεδο πληροφορίας του 
DEM είναι πλέον ορατές στο χάρτη και στο διαχειριστή επιπέδων πληροφορίας. 
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